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Alliance/MFG Users Guide 

 
 

Welcome to Alliance/MFG 
Alliance/MFG™ is a complete manufacturing management software system specifically designed 
for growing manufacturers. It has everything you need to run your company, including Bill of 
Materials, Material Requirements Planning, Shop Floor Control, Inventory Control, Sales Orders, 
and Purchase Orders, Forecasting, Capacity Requirements Planning, and Reporting, in a single 
package. Alliance/MFG doesn't just store your manufacturing information, it helps you act on it. 

Alliance/MFG maintains dynamic information about your products, customers and suppliers, 
employees, manufacturing process, your shipments and your invoices—all the data you need to 
track your transactions and provide detailed reports on every aspect of your operation. 
Alliance/MFG is designed by manufacturers for manufacturers. The software is easy to install and 
easy to learn. It can help shorten your production times, reduce your inventory, cut your material 
costs, and help you manufacture products more efficiently—all of which can improve your bottom 
line. 

Alliance/MFG is a totally integrated manufacturing information system where data is entered only 
once. The information can then be retrieved throughout the system at every point where it is 
referenced.  

Using the Alliance/MFG Help System 

The Alliance/MFG Help program offers you three ways to look up topics. The left window pane 
contains four tabs that can be displayed or collapsed. The Contents Tab is the default Help File 
tab, it contains all of the Chapters and Topics. Once you choose a topic to display, you can read 
through the topic on screen, follow hyperlinks to related topics, and print the topic. You can also 
use the Index Tab or the Search Tab to locate and review topics.  

NOTE: 

This Help document contains images from both Alliance/MFG Versions 6.X and 7.X. 
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Contents Tab 

The Contents Tab in the left window pane contains a list of topics organized similarly to the way 
the Alliance/MFG User Guide Table of Contents is organized. Click the plus signs next to the 
topics to display related topics underneath. Double-click a topic to display the topic in the right 
window pane. 

Index Tab 

The Index Tab displays a list of keywords in alphabetical order. You can scan through the list, or 
type in a keyword to find it in the list. Double-click on a list item or click Display to display the topic 
in the right window pane. Click the Back arrow to return to your original topic. 

Search Tab 

In the Search Tab, you can find every occurrence of a word in the entire help file. Type in a word 
or short phrase and click List Topics to display all topics containing the word or phrase (exactly as 
typed). Select a topic and double-click or click Display to display the topic in the right window 
pane. All occurrences of the word or phrase will be highlighted in the text. 

Glossary Tab 

In the Glossary Tab, you can find definitions for manufacturing terms used in the Alliance Help 
System. The Glossary Tab displays a list of keywords in alphabetical order. Click on a keyword to 
display the definition in the bottom window pane. Additionally, throughout the Help System text 
you will find glossary terms underlined the first time they appear in a Topic. Click on that 
occurrence to expand the text and display the definition. Click again to close the expansion. 
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Implementation and Training Resources 

The success of your Alliance/MFG-based manufacturing operation depends on the quality of your 
training and your initial implementation plan. Alliance Manufacturing Software offers several 
resources to help you plan a successful implementation and train your employees. If you have not 
already conducted some level of implementation or staff training; you should investigate these 
options before installing or operating Alliance/MFG. At a minimum, refer to your Alliance/MFG 
Technical Reference for information about creating an Implementation Plan. 

Implementation 

On-Site Training and Implementation 

We come to your site to satisfy your training and implementation needs. Our qualified instructor 
meets with your project team to train your staff on the full implementation of the software using 
your manufacturing process. 

Contact Alliance Customer Management at (800) 490-2520 Ext. 3 for information about On-Site 
programs. 

Training 

Training Seminars - Three and four day workshops focus on the manufacturing planning 
process and Alliance/MFG. These workshops are led by a team of trained specialists who have 
expertise in computer-based manufacturing planning. 

TeleTraining™ - A cost effective training session that connects you by phone and Internet to our 
Professional Services Department. Our MRP specialists review the concepts of MRP and how 
they apply to Alliance/MFG and your company. Training on customizing Alliance reports for your 
company is also available. 

TeleConsulting™ - Similar to TeleTraining, except you guide the session to review areas of 
concern to you. 

Contact Alliance Customer Management at (800) 490-2520 Ext. 3 for information about any of 
these programs. 
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Contacting Alliance 
Contacting Alliance Customer Management 

The success of your Alliance/MFG-based manufacturing operation depends on the quality of your 
training and your initial implementation plan. Alliance manufacturing software offers several 
resources to help you plan a successful implementation and train your employees.  

Alliance Customer Management is available to help you with issues outside the program; for 
example, if you wish to renew your Annual Support Agreement, schedule training, add more 
license user seats, or find out what other products and services are available to support your 
organization. 

Customer Management is available during regular business hours, 8:00 A.M. to 5:00 P.M., 
Central Time, except public holidays. You can contact Alliance Customer Management by phone, 
fax, or email: 

Exact Alliance Customer Management USA 

Phone: Toll Free (800) 490-2520 Ext 3 

FAX: (937) 913-3068 (Attention: Account Management) 

Email: service@exactsoftware.com

Contacting Alliance Technical Support 

Does your Company Qualify for Technical Support? 

Technical Support for your Alliance/MFG products is provided on an annual contract basis, which 
entitles you to unlimited technical support incidents. You must have a current Annual Support 
Agreement to qualify for Alliance Technical Support. 

Faxes, email, and telephone calls will normally be answered by a member of the Alliance 
Technical Support team within 2-4 hours of receipt. Technical Support incidents will normally be 
answered in the order they were received, however, some more complex incidents might take 
longer to research and/or resolve. Occasionally technical support may request that you email a 
file, download a file, or allow us to remotely connect to your computer.  If your IT infrastructure 
does not allow us to use these tools there may be additionally support charges to cover the extra 
time needed. 

Who Should Contact Alliance? 

We recommend that you assign a single person from your site to be the primary contact with 
Alliance Technical Support. This person should have full SUPERVISOR rights to access all 
program functions, fields, and reports. They should be familiar with basic Windows features such 
as copying, finding and moving files, and possess a solid understanding of how your company 
uses Alliance/MFG. 

What Is An Incident? 

Incident 

Customer’s original inquiry or report of problems in the operation of the Software, including all 
follow-up communications which are initiated by Alliance/MFG in an attempt to resolve the inquiry 
or reported problems in the Software. 
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Initiation 

Alliance/MFG shall Initiate an Incident upon receiving any inquiry or problem report from 
Customer by assigning an Incident Tracking Number for reference purposes.  

Resolution  

An incident shall be deemed to be resolved and Alliance/MFG shall close an incident when the 
Customer’s original inquiry has been answered in a reasonably complete and comprehensible 
manner. An Incident shall be deemed resolved and shall be closed when Alliance/MFG: 

(a) confirms to Customer that the particular functional aspect of the Software which gave rise to 
the incident is designed as part of the Software 

(b) determines that Customer is requesting that Alliance/MFG introduce a new behavior, a 
variation on an existing behavior, or a change in the capacity or performance of the Software 

(c) provides Customer a Workaround 

d) provides Customer an Update or other patch to the Software that corrects the Software error 
(sometimes referred to as a “fix”) 

(e) is unable, following exercise of commercially reasonable efforts, to verify the existence of any 
problem or error in the Software that may have given rise to the Incident.  

Limitation on Scope and Purpose  

Limitation on Scope and Purpose of Technical Support 

Technical Support services provided under an Agreement are intended to support and improve 
the Customer’s understanding of the Software’s operation, and is not intended to provide 
consulting services to Customer, to improve Customer’s administrative or other business 
operating practices, or to write custom management reports for Customer’s use. Alliance/MFG 
technical support staff shall have reasonable discretion for determining whether an inquiry poses 
a valid Incident for which technical support is required or instead represents a request for 
consultation, implementation, or training services which more properly should be supported with 
fee-for-service consulting services from Alliance/MFG or a third party.  

Help Us Help You 

To get the fastest, most efficient service when contacting Alliance Technical Support either by 
phone, fax, or e-mail, please provide the following information: 

1. Your name, company name, and phone, fax, or e-mail return address 

2. If you have already been in contact with Alliance Technical Support regarding this 
particular problem, provide the incident number you were given 

3. Product name and version number 

4. The operating system on which the product is installed (for example, Windows 98 SE) 

5. A complete description of the problem, including any steps that will reproduce it 

6. Exact wording of any error messages you received when you experienced the problem 

7. A complete description of any steps you have already taken to resolve the problem 

8. A short summary of any other communication you have had with Alliance Technical 
Support regarding the problem 
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Exact Alliance USA Technical Support 

Exact Alliance USA Technical Support is available to customers Monday through Friday between 
the hours of 7:00 A.M. and 4:30 P.M., Pacific Time, excluding public holidays. You can contact 
Technical Support by phone, fax, or email. 

Exact Alliance Software USA Technical Support  

By Phone: Toll Free (800) 349-0249 

By FAX: (937) 913-3068 (Attention Technical Support) 

By email: support@alliancemfg.com

Web: http://www.alliancemfg.com

 

Exact Alliance (UK) Technical Support 

Exact Manufacturing Systems 

7 Westleigh Business Park, 

Blaby, Leicestershire. LE8 4EZ 

Tel: +44 (0)116 2784888 

Support Tel: +44 (0)1162784499 

Fax: +44 (0)1162784666 

Support Fax: +44 (0)1162774169 

Web: http://www.alliancemfg.com
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Annual Support Agreement 
Support Services Provided Under an Annual Support Agreement 

Support Services for your Exact Alliance product are provided on an annual contract basis, which 
entitles you to unlimited technical support incidents and any maintenance updates within the 
Exact Alliance product series. A support incident is defined as a question or limited set of 
questions directly related to one specific issue. Unlimited technical support can be requested by 
telephone, fax, e-mail or via the Exact Alliance Customer Portal at a cost of 16% of the current 
retail value of your software purchase. Technical Support can assist you with technical issues and 
defects within Alliance/MFG related to installation, bug reports and problems encountered during 
day-to-day operation of the software. Technical Support does NOT provide training sessions, use 
of product and implementation instructions, custom programming support, API support, or custom 
report writing services. (These services can be purchased from the Alliance Customer 
Management Department by phone at 800-490-2520 x 3). 

Exact Alliance will, within an appropriate time period, use reasonable commercial efforts to 
correct or provide a usable work around solution for any reproducible material error in the 
software. Exact Alliance reserves the right to require that you update to the current release to 
facilitate the diagnosis and resolution of the reported error in the event that the error is corrected 
in the current release. 

Alliance Technical Support 

Alliance Technical Support is available Monday through Friday (excluding holidays), from 7:00 
A.M. to 4:30 P.M., Pacific Time. You can reach Alliance Technical Support via fax at (937) 913-
3068 (Attention: Technical Support), e-mail at support@alliancemfg.com, or Toll Free at (800) 
349-0249. In the event that your call is not answered in person, it will be routed to voice mail and 
you will be contacted in the order your call was received. Occasionally technical support may 
request that you email a file, download a file, or allow us to remotely connect to your computer.  If 
your IT infrastructure does not allow us to use these tools there may be additionally support 
charges to cover the extra time needed. The Exact Alliance customer portal is normally available 
24/7. Contact the Alliance Customer Management Department by phone at 800-490-2520 x 3, to 
request a password.  

Maintenance Releases 

Maintenance Releases (software updates), contain defect corrections and optionally, major or 
minor product enhancements. Maintenance Releases are available to all Exact Alliance 
customers with current Annual Support Agreements. A Readme file and revised user 
documentation is normally included on the CD in Adobe PDF format. 

Custom Reports and External Utilities 

Free custom reports and external utilities are periodically made available for download from the 
Alliance Customer Portal. Free custom reports, custom views and external utilities are periodically 
made available for Alliance Customers. Free reports, views and external utilities distributed by 
Exact Alliance may cease to execute without a current Annual Support Agreement. In addition, 
Exact Alliance reserves the right to change, withdraw, disable or remove any and all custom 
reports and/or external utilities at its discretion and is under no obligation to maintain, upgrade or 
support these reports and utilities which are not part of the commercial product.  All such custom 
reports and external utilities are owned by Exact Alliance and provided to you at your own risk. 
External utilities (e.g. CRU & EIS) distributed by Exact Alliance may cease to execute without a 
current Annual Support Agreement. 
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Customer Portal 

The Exact Alliance Customer Portal is located at https://customers.exact.nl 

In addition to technical support services, you can access current Technical Bulletins and FAQ's, 
review free training sessions, download applicable software hotfixes, download free custom 
reports, review online training classes and content, read news items and participate in periodic 
customer forums on the Customer Portal area of our Website. You will need a password to 
access the customer portal. 

Term of Agreement 

An Annual Support Agreement continues in effect for 365 days. 
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Microsoft SQL Installations 
Program Installation 

Alliance/MFG installs quickly from the CD provided with your package. Complete instructions are 
presented in the Getting Started Booklet. Pre-Installation steps will ensure no other system 
elements are affected when you install the program. See Chapter 1: Installation, Preparing your 
Data for Migration, Check Data for Rules Violation and How Migration Integrates Data in 
Alliance/MFG. 

MSDE, Microsoft SQL 2000, Microsoft SQL 2005, and Microsoft SQL 
Express 

Recommended Minimum System Requirements 

For minimum acceptable system performance you should use the following: 

Windows XP Professional or Vista with latest Service Pack 

Workstations: 1 GHz Pentium Processor, 1 GB RAM, 500 Mb HDD space 

Servers: 600 MHz Pentium Processor, 512 Mb RAM, approximately 1 GB for data 

MS SQL Server Hard Disk Space 1 GB plus additional space for data 

Minimum System Requirements 

To take advantage of Alliance Technical Support services you must equip your computers as 
shown below: 

Microsoft Windows 2000 or XP Pro with latest Service Pack (Home and ME versions are NOT 
supported) 

Workstations: 600 MHz Pentium or compatible processor, 512 Mb RAM, 500 Mb HDD space 

Servers: 600 MHz Pentium or compatible processor, 512 Mb RAM, approximately 1 GB for data 

MS SQL Server Hard Disk Space 1 GB plus additional space for data 

Microsoft SQL Server 2000, SQL Server 2005 (if you are installing the Microsoft SQL Server 
Database for Alliance/MFG) 

New Installations 

If you are a new Alliance customer using the Access database option, review the System 
Overview section for information about the Alliance program, user interface and using the various 
toolbar, sidebar and menu elements. Also see the Getting Started Booklet.  

2.5.3 or StartMRP 1.5.3 Customer Upgrades 

If you are an existing Alliance 2.5.3 or StartMRP 1.5.3 user you will need to migrate your existing 
data to Access. 

If you are an existing Alliance/MFG 2.5.3 or StartMRP user and intend to use a Microsoft SQL 
database option you will need to migrate your existing data to Access, open that Access 
database in Alliance/MFG 7.2 and then migrate it to SQL.  

The steps you will follow to migrate your data are listed under Upgrade Installations below. 

9 



Alliance/MFG User Guide 

Upgrade Installations 

Data Migration from Alliance/MFG 2.5.3 or StartMRP 1.5.3 

Follow the Alliance/MFG installation instructions in the Getting Started Booklet. Once the program 
is installed, you can migrate your existing data. 

What you will need: 

Alliance Migration Utility (included on the Alliance/MFG CD) 

This process uses the DBF to MDB Migration Utility included on the Alliance/MFG CD to convert 
data from the version 2.5.3 proprietary database to a Microsoft Access database. If you intend to 
use a SQL database you still need to convert your existing data to Access first, open that Access 
database in Alliance/MFG 7.2 and then migrate it to SQL.  The steps you will follow to migrate 
your data are listed below. 

Prepare your Existing Data for Migration 

1. Complete your current month or accounting period 

If you use an Alliance Accounting link, you should perform the following additional steps: 

2. Run the accounting link. 

3. Correct any errors. 

4. Post all transactions. 

5. Close your accounting period. 

6. Backup your 1.5.3 or 2.5.3 database. 

Rebuild your Company Database 

Before migrating your existing 1.5.3 or 2.5.3 database to Alliance/MFG, it’s a good idea to get it 
into the best shape possible by first performing a Rebuild and then backing up the data. This will 
ensure that all data is properly indexed. This is performed within Alliance from the 
File>Database>Rebuild menu. 

Note: 

The Alliance/MFG Technical Reference contains additional information about how data is 
migrated and stored in Alliance/MFG. This information is not required, but may be 
helpful if you encounter multiple errors during the migration, or to review your 
current database for possible conflicts before you attempt migration.  

To rebuild your current database: 

1. Login to your existing Alliance/MFG 2.5.3 or StartMRP 1.5.3 program. 

2. Select File>Database>Rebuild. 

3. If you receive any error messages during the rebuild, please contact Alliance 
Technical Support before proceeding. 
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Back Up Your Rebuilt Database 

Before migrating the data, it is important to back up your database so that if any problems occur 
during the migration, you will have a current database to restore, if necessary. 

To backup your database: 

1. From the main menu, select File>Backup. 

2. If you receive any error messages during backup, please contact Alliance Technical 
Support before proceeding. 

Note: 

AllianceMFG will not migrate, nor will it have any access to or overwrite any custom 
reports or batch files in your old system. 

Install the DBF to MDB Migration Utility 

Once Alliance/MFG has been installed, you can install the DBF to MDB Migration Utility. This 
utility will migrate your existing database to the new Access database. 

Install the Migration Utility 

1. Insert the Alliance/MFG CD into your CD ROM drive. (If you have “Auto Insertion” 
enabled in your Windows CD properties, the Alliance/MFG installation program will 
begin. The Alliance/MFG install browser will be displayed. Click on Install Products 
and then select the DBF to MDB Migration button. 

2. This will install the software and drivers necessary to run the MDB Migration Utility on 
your computer. 

Rename and relocate the Blank Migration Database installed by the Utility 

The Migration Utility will copy a blank Migration database to your computer. 

The database will normally be installed in: C:/ProgramFiles/Alliance/MFG/MigrationUtility 

1. Navigate to the migration database location and select the Blank.mdb 

2. Copy the Blank.mdb to the location on a your computer you want your data to reside. 
If you plan to install your company database on a network, we suggest you migrate 
your data first and then move the database to your network. 

3. Rename the Blank.mdb to a suitable name for your company database. 

Migrate the Existing Data to the Blank Access Database 

After you have renamed and relocated the blank Access Migration database and brought your 
existing data up to date, you are ready to use the Migration Utility to migrate data from your 
existing 2.5.3 or 1.5.3 database. 

To migrate the data: 

First Close Alliance/MFG. 

Navigate to the Alliance Group via the Windows Start menu and select Migration Utility from the 
submenu options. 
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1. The AllianceMFG Data Migration Utility dialog box opens. 

2. Within this dialog box, you will point the utility to two files, one from the Directory of 
dbf Files (the old database), and one from the Destination Database (the new 
database). 

3. Click the ellipsis button (. . .) next to the Directory of DBF Files , and navigate to the 
directory where the existing database you wish to migrate resides. 

4. Select the .dbf file, all tables in the database selected will be migrated. 

5. Click Open. 

6. The path to the directory is added in the Directory of DBF Files box. 

7. Click the ellipsis button next to the Destination Database box and navigate to the file 
where your new blank database resides. 

8. Select the new database file and click Open. 

9. The path and file name are added to the Destination Database box. 

10. Click Migrate Data. The system will warn you that doing this will delete (overwrite) all 
existing data in the new database. 

11. If this is OK, click Yes to continue. 

The utility will begin copying tables and converting files. Errors written to the screen as dialogs 
during the migration are also written to a .log file in the same directory as the Migration Utility. 
This file will be helpful if you need to make corrections to the data or provide information to 
Alliance Technical Support. If the migration fails, it will help us to determine where the process 
failed. 

When finished, the system reports: The Migration was completed successfully, click OK. 

Click Done. 

Login to the new database 

1. Start Alliance/MFG  

2. Select File>Database>Login. The Alliance Data Connection dialog box opens 

3. Choose Add Access Connection. 

4. The Add Data Connection dialog box opens. 

5. Type the name of your new database in the Data Source Name field. 

6. Click the Data Source Path hyperlink and navigate to the new blank database. 

7. Select the new database and click Add. The new database is now added to the list of 
available databases in the Alliance Data Connection dialog box. 

8. Login to the new Access database. You will be asked to convert your newly migrated 
database structure to the latest version, click OK. 
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If the Migration Process Fails 

The Alliance/MFG Technical Reference contains additional information about how data is 
migrated and stored in Alliance/MFG. See Chapter 1: Installation, Preparing your Data for 
Migration, Check Data for Rules Violation and How Migration Integrates Data in Alliance/MFG . 

Installing the Microsoft SQL Express Database for Alliance/MFG 

What you will need: 

Alliance/MFG Installation CD 2 

See the recommended Workstation/Server hardware and OS software requirements listed 
previously. 

Microsoft SQL Express Setup 

1. Insert the SQL Express for Alliance/MFG CD into your CD-ROM drive. 

2. If Auto Start doesn't start the install, go to Step 3; otherwise, proceed to Step 5. 

3. Select Start>Run>Browse and select your CD-ROM drive. 

4. Locate Setup.exe on the CD and double click this file. 

5. Click OK on the Run dialog box.  

6. This will launch the Setup Program (Unattended Mode) 

The first thing setup will do is check the minimum system requirements of the target machine. 
First the OS will be tested and if that fails the following message will be displayed: 

Setup has determined that the minimum version of the Operating System or service pack is not 
present on this computer.  

The minimum versions are as follows:  

    Windows 2000 Service Pack 4 

    Windows Server 2003 Service Pack 1 

    Windows XP Pro Service Pack 2 

    Windows Vista  

Please upgrade, or use the windows update feature to get the latest service pack for 
your system and run this setup again.  

Setup will now abort. 

Next the setup will test the Windows Installer Service version and if that fails the following 
message will be displayed: 

Setup has determined that the minimum version of the Windows Installer Service 3.1 
is not present on this computer.  

Setup can launch the update for you now. Do you wish to continue? Yes or No 

If you answer No Setup will abort. 
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If you answer Yes Setup will download and install the latest Windows Installer Service 
and you will asked to re-boot  your computer when it completes. 

Next the setup will detect whether or not the .NET Framework 2.0 is installed. If it is not the 
user will see the following message: 

Setup does not detect the Microsoft .NET Framework 2.0 on this computer.  

Setup cannot continue until it is installed.  

Please use the Windows Update functionality to obtain this setup.  

Setup will now abort. 

If all of the above requirements are met, you will receive the following message: 

Setup will now configure the installation program for SQL Express. 

Follow the on screen installations instructions. 

1. Alliance/MFG requires SQL authentication as opposed to Windows Authentication 
this requires a strong system administrator (SA) password.  

2. This instance of SQL Express (MFGEXPRESS) will be installed with the default user 
name “sa” and setup will prompt you for a strong password. You will be asked to 
verify that password, if they do not match, you will be asked to try again.  

3. SQL Express will now be installed on your machine. 

Installing the Microsoft SQL Server Database for Alliance/MFG 

What you will need: 

Microsoft SQL Server 2000 or SQL Server 2005 (installed on your server) 

Alliance/MFG Installation CD 

Microsoft SQL Server Setup 

Setting up your SQL Server should be performed by your IT Professional or a Certified SQL 
Server installer. 

Databases created using the Alliance File>Create Database option or the Alliance SQL Database 
Setup utility use SQL Server’s default collation setting. Alliance has tested the application under 
the “SQL_Latin1_General_CP1_CI_AS” collation setting and recommends using this collation. 
However we understand that in foreign countries this is not the best choice. Therefore when 
choosing a different collation setting, if your language supports a case-insensitive collation, 
choose that as your default setting when installing SQL Server. 

If you have already chosen a different collation for the default collation when you installed SQL 
server, run the MDB to SQL Migration utility to create a SQL database as usual (see the following 
section). Then using the tools provided by Microsoft SQL Server, create another blank database 
using a case-insensitive collation such as the one recommended above. Then using Microsoft 
SQL Server’s Import/Export Utility move all the structure and data from the database created by 
the MDB to SQL Migration utility to the one created with the proper collation. 
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Installing the MDB to SQL Migration Utility 

1. On a Windows workstation/server that has Alliance/MFG Version 7 installed, Exit 
from and close Alliance/MFG. 

2. Insert the Alliance/MFG CD into your CD ROM drive. The Alliance/MFG install 
browser will be displayed. Click on Install Products and then the MDB to SQL 
Migration button. 

3. This will execute the Installer for the Access to SQL Migration Utility which will also 
create your SQL database and migrate your existing Access data to it. 

4. From your Windows Start Menu Alliance Group locate the MDB to SQL Migration 
Utility and launch it. Within this dialog box, you will point the utility to the MS SQL 
Server that will host the new database, and also which type of database to create 
and last whether or not to migrate your existing data (optional). 

5. Click the MS SQL Server drop down list box, and navigate to the server where the 
database will reside. 

6. Next enter a unique name for the new database in the New database name box. If 
you use an existing name the utility will prompt to overwrite that database. 

7. Supply the SQL Server Administrator Name in the Admin ID box and the Password 
(this is not the Alliance/MFG Login “SUPERVISOR” and password.) 

8. Next, select the type of database you wish to create (Blank, Default or Other). If you 
choose Blank or Default the source path and file name will be defaulted for you. If 
you wish to migrate your existing Alliance/MFG Access data, choose Other. If you 
choose Other the ellipsis button will be enabled. Navigate to the Alliance/MFG 
Version 7.2 source MDB database via the Open dialog box. Click Open, the path to 
the directory will be entered into the Source MDB box. 

 

SQL Installations and Firewalls 

The Windows Firewall may hide SQL Express instances so they won’t show up in drop down lists 
(e.g. when adding a connection, backing up a database, etc). Other Firewalls may cause the 
same problem. 

If you encounter this you have three options: 

1. If you don’t need a Firewall (e.g. local network only) then disable your server’s 
Firewall 

2. Open UDP Port 1434 if you use something other than the Windows Firewall 

3. If you use the Windows Firewall you can follow the steps in section 4.1 of 
http://msdn.microsoft.com/vstudio/express/support/sqlreadme/:  

Click Start, click Control Panel, and then click Network Connections.  

From the navigation bar on the left, click Change Windows Firewall settings.  
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On the Exceptions tab, in the Programs and Services box, you will probably see that SQL 
Server is listed, but not selected as an exception. If you select the check box, Windows will 
open the 1433 port to let in TCP requests. Alternatively, if you do not see SQL Server listed, 
do the following: 

1. Click Add Program. 

2. Click Browse. 

3. Navigate to drive:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\BINN 

4. Add the file sqlservr.exe to the list of exceptions 
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The Alliance/MFG User Interface 
When you start the program, Alliance/MFG opens in a window on your display screen and the 
Alliance/MFG system menu displays across the top. 

You can minimize it (reduce the window to an icon on your Windows Task Bar), or maximize it 
(restore it to full screen size) like any other Windows program. Your Windows Start button and 
Task Bar will continue to display at the bottom of your computer screen so you can open other 
programs and send and receive email just as you can while using other Windows programs. 

Select functions from the main system menu to display them in the body of the screen. We 
recommend that you maximize Alliance/MFG after it opens. This will provide an adequate area for 
viewing and maintaining data. The system will remember how you exited Alliance/MFG and 
reopen in that mode. 

Alliance/MFG uses standard Microsoft Windows hot keys and short cuts that let you quickly edit, 
copy, and paste data, scroll through data lists, and move through the system using either the 
mouse or keyboard strokes. You can also drill down through the system screens to access 
related data. 

See the sections Alliance System Overview and Navigating Alliance/MFG for complete details on 
menu functions and selections, sidebar and toolbar options and screen/window types.  

NOTE: 

This Help document contains images from both Alliance/MFG Versions 6.X and 7.X. 
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Alliance/MFG System Overview 
Functional Overview 

This section describes the general use of Alliance/MFG and briefly outlines the various functional 
areas of the system. Use this section to familiarize yourself with the basics of Alliance/MFG, 
including background information, system design and methodology, and how the various 
elements of the system interact. 

Alliance/MFG is a Microsoft Windows-based application that is dependable, and very easy to use. 
If you are familiar with basic Windows operation, you will quickly master the program. 

Alliance/MFG maintains dynamic information about your products, customers and suppliers, 
employees, manufacturing process, your shipments and your invoices—all the data you need to 
track your transactions and provide detailed reports on every aspect of your manufacturing 
operation. 

Alliance/MFG fits into the tight schedule of busy, growing companies. Alliance/MFG is designed 
by manufacturers for manufacturers. The software is easy to install and easy to learn. 
Alliance/MFG, when properly used, will streamline the overall efficiency of your entire 
manufacturing process. 

In the Navigating the System section, you will find a description of the menu structure; toolbar, 
sidebar and detailed information about how to navigate through the system. It explains how to 
open and use various lists, grids, forms, queries, transactions, and dialog boxes; and how to use 
the View and Edit features to drill-down through related data in the system.  

NOTE: 

This Help document contains images from both Alliance/MFG Versions 6.X and 7.X. 

The following sections briefly summarize the functional areas you will access to set up and 
operate your Alliance/MFG system. 

The Alliance/MFG Main Menu Functions 

FILE 

All the elements you need to enter and maintain your company-specific information is found 
under the File menu. From the File Menu option, you can login to your databases, set up and 
maintain your company name and address information, establish security settings, set default 
values and maintain codes you need to operate your system. 

See Database for information about importing data, creating and setting up your company 
databases. 

See Company for complete information about setting up your company, employees, calendar 
and default code information. 

See Codes for complete information about setting up your standardized and default code 
information. 

PRODUCTS 

In Alliance/MFG your products are maintained in the Part Master, which is the foundation for your 
Bill of Materials (Product Structure). All features relating to the Part Master are found under the 
Products menu. 
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The Part Master is a comprehensive table of parts—components, subassemblies, and 
assemblies—all of which form relationships that apply to the manufacture of your finished 
product. Descriptions, revision numbers, documents, and ECNs are just some of the details 
stored in the database. From this detailed part information, you can create multilevel product 
structures and preview or print detailed reports such as a Costed Bill of Materials, a Part Master 
List, a Component Where-Used report, or an Indented Multi-level BOM. 

The Indented Bill of Materials Report “explodes” a product structure, showing the manufactured 
part and all of the pieces (components) needed to make it, through all levels of production. The 
“Where Used” Report tracks any component or assembly and where it is used throughout all 
product structures. 

See Setting up your Products for detailed information on creating your part master, BOM's, part 
cross-reference, part documents and drawings. 

DEMAND 

The Alliance/MFG system is designed around the concept of “supply and demand”— customer 
orders and forecasts are the Independent Demand that, through Material Requirements Planning, 
drives the action of purchasing or manufacturing the supply. Using Demand, you will maintain 
thorough and up-to-date information on your company’s customers. Easily enter minimal quoting 
information, if awarded, convert the quote to a sales order. The Easy Entry Sales Order function 
simplifies and shortens the process of taking complex customer orders; select entries from codes 
tables linked to order forms to streamline data entry and minimize error. Easily enter and edit 
information about pricing, shipping, alternate currency, discount options, and taxes. 

With Alliance/MFG’s Forecast module, you can anticipate the potential effect of different levels of 
production demand on the company’s operations to push the manufacturing process beyond the 
scope of its actual sales orders. 

Use the Job Tracking feature to apply a unique job number to track related sales order, purchase 
order, and work order costs through the system. 

See Working with Demand, for details about setting up your customers, creating quotes and 
sales orders and shipping customer orders. 

SUPPLY 

The supply-side of the Alliance/MFG system contains information about your company’s suppliers 
and OEMs. It is where you create and maintain purchase orders for your suppliers when their 
products are required for your manufacturing process. If in-house assemblies are required, MRP 
planned orders generate the requests to have these items made. The information that initiates 
supply-side activity is generated as a result of running the Material Requirements Planning 
function, which looks at existing orders and inventory, then flags requirements, potential 
shortages, and suggests reschedules for out-of-phase orders. 

See Working with Supply, for information about creating and receiving purchase orders, and 
creating, kitting, and completing work orders, serialized completions and backflushing. 
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MATERIAL REQUIREMENTS PLANNING 

The Material Requirements Planning (MRP) module is your company’s automated “master 
planner.” Its primary function is to regularly examine the total demand for products and then 
decide what items need to be bought or made, and when, to meet that demand. MRP reviews 
every item of information input into the system, analyzes the data, calculates, and disseminates 
the information into action reports. When status of the manufacturing process is requested, 
MRP’s powerful computation function reports exactly what your company needs to do to meet the 
demands placed on it. 

All you need to do to initiate this system-wide, complex process is check a few parameters and 
click Calculate. The results are then sorted and reported in whatever way you request, either on 
screen or in print. 

See Material Requirements Planning for information on what you need to build and buy to meet 
your customer’s needs. 

INVENTORY CONTROL 

The Part Maintenance function manages your inventory. It stores comprehensive information 
about parts including stock levels, labor, and costing. Costing fields include material, labor, 
burden, subcontract, setup, and total unit cost. You can maintain both standard and pending 
costs. 

This inventory information also provides MRP with the precise ordering rules and necessary 
information to calculate the requirements plan. For example, you can establish the scrap factor 
for a part, which influences ordering quantities; and you can keep information relating to optimum 
order quantities, how much safety stock to keep on hand, the lead times for products, and normal 
shelf life. 

With Alliance/MFG’s ABC Analysis tool, you can prioritize the relative importance of a particular 
part by assigning ABC codes. ABC calculation parameters include YTD usage dollars, on-hand 
dollars, and unit cost. 

Through the Transactions feature, Alliance/MFG tracks all inventory movement, including serial 
and lot numbers. On the demand side, Transactions document exactly what items are being 
shipped to the customer and from where the inventory items are taken. Transactions also include 
shipments returned from a customer and to what stock location they are returned. 

You can perform Miscellaneous Issues, Miscellaneous Receipts, and Relocate inventory through 
the Transactions menu. 

Transactions on the supply side include Purchase Order Receipts, Work Order Completions, 
Backflushing, Kitting, Dekitting, and Returns to Vendor. 

The Shortages function gives you the ability to add, edit, or delete shortages, and you can use 
Relocate to move inventory between locations. 

See Inventory Control for information on part maintenance, transactions and inventory control. 
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CAPACITY REQUIREMENTS PLANNING 

While the MRP feature reports what you need to make and buy within a specific time frame, 
Alliance/MFG’s Capacity Requirements Planning (CRP) feature tells you if your manufacturing 
capacity is actually able to produce what you need within that time frame. 

To use CRP effectively, you must identify and describe your company’s work centers and assign 
each center a capacity. You can also divide work centers into groups or shifts and define capacity 
separately. In addition, labor routers that describe—in terms of function and time —each 
operation performed during the manufacturing process can be entered into the system. 

Running CRP generates reports in either table or graph format that accurately show the daily load 
of a given work center over time. The graph displays exactly how far each center is under or over 
capacity. 

See Capacity Requirements Planning to establish work centers, routings, and capacity 
planning. 

SHOP FLOOR CONTROL 

Alliance/MFG’s Shop Floor Control module provides a complete, up-to-date picture of your 
manufacturing operation. Within this feature, the Work-in-Process function displays the current 
status of all released work orders. Actual material, labor, and scrap costs are tracked to help you 
maintain an up-to-the-minute financial analysis of your manufacturing process. 

With Alliance/MFG’s Labor Distribution feature, you can maintain the labor charged to a work 
order or job. Reports provide efficiency and effectiveness data, by employee. 

See Shop Floor Control to monitor WIP, labor effectiveness and efficiency 

HELP 

You can access Alliance/MFG Help files, link to our Web site, or send email to Alliance Technical 
Support from the Help menu. 

REPORTS 

Alliance/MFG offers a wide variety of pre-formatted, standard reports. These reports are 
accessible from each function menu. You can query reports from Alliance/MFG predefined 
queries on each report menu or create your own custom queries. For detailed information about 
creating custom queries for Alliance/MFG standard reports, see the Alliance/MFG Technical 
Reference, Chapter 5: Reports & Queries. 
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Navigating Alliance/MFG 
Starting the Program 

Once you have installed Alliance/MFG and have familiarized yourself with the implementation 
process outlined in the Getting Started or Technical Reference Manuals, you are ready to start 
the application. An icon will be set up in the Programs section accessed from the Start Menu on 
your Windows desktop. 

To start the program: 

1. Click the AllianceMFG icon on your desktop, or select 
Start>Programs>Alliance>AllianceMFG. 

2. The Program window appears. 

 

If the sample Pen Database has been installed with your system, the application will open 
normally and display the Alliance Data Connection dialog box. Use the name “SUPERVISOR”; no 
password is required. You can click Login to begin working with the Pen Database or add a new 
database. The initial login process will take a few moments. 
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If no database has been installed and you are running Alliance/MFG for the first time, the Alliance 
Data Connection dialog box will display an empty list. You must add the database prior to Login. 

To add a database: 

1. From the Alliance Data Connection dialog box, click Add Access Connection or Add SQL 
Connection to open the Add Data Connection dialog box. 

2. For Access enter the Data Source name and path of the existing database. 

3. For SQL enter the Data Source, User ID, Password, Server and Database (this function 
should be performed by your Database Administrator). 

4. Click Add. The database is added to the drop-down list on the Alliance Data Connection 
dialog box. 

5. Select the database from the list. 

6. If this is a new, blank, or default database, enter the User Name (SUPERVISOR) and leave 
the password blank. 

7. If this is an active database, login with your User ID and password. 

8. Click Login. After a moment, you will be able to add data and access information from all 
system menus for the database you added. If the system requests you to update your 
database to the current version, click OK, this will ensure your data is in the current format. 
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Displaying Alliance/MFG 

When you start the program, Alliance/MFG opens in a window on your display screen and the 
Alliance/MFG Main Menu displays across the top. 

 

You can minimize it (reduce the window to an icon on your Windows Task Bar), or maximize it 
(restore it to full screen size) like any other Windows program. We recommend that you maximize 
Alliance/MFG after it opens. This will provide an adequate area for viewing and maintaining data. 
Your Windows Start button and Task Bar will continue to display at the bottom of your computer 
screen so you can open other programs and send and receive email, or use Alt+Tab to switch 
between other Windows programs. 
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Menu Structure 

The Main Menu appears on the top of window when the application is opened. You will select the 
primary functions used to run the program from this menu. 

 

Primary Functions 

File Includes Database, Company, Codes, Print, and Exit. 

Edit Includes First, Previous, Next, Last, Copy Rec, Paste Rec, New Copy, New, Save, Delete, 
Query and   Refresh . 

Products Includes Part Master, Documents, Engineering Change Notice, GUI BOM, Product 
Structure, Part Cross-Reference, and Reports. 

Demand Includes Customers, Forecasts, Invoices, Credit Memos, Job Master, Sales Orders, 
Quotations, Blanket Orders, Ship a Customer Order, Return a Customer Order, and Reports. 

Supply Includes Purchase Orders, Suppliers, Work Orders, Work Order Release Manager, 
Kitting, De-Kitting, Receive a Purchase Order, Return a Purchase Order, Complete a Work Order, 
Serialize Work Order Completions, Backflush Work Order Completions and Reports. 

MRP Includes Calculate MRP, MRP Action Parts, and Reports. 

Inventory Includes Part Maintenance, Inventory Summary, Inventory Details, SN/Lot Tracking, 
Cost Maintenance, Cost Rollup, Transaction History, Shortages, Negative Inventory, Physical 
Inventory, ABC Analysis, Update Standard Cost, and Reports. 

CRP Includes Work Centers, Labor Routers, Calculate CRP, Work Center Loads, Update Labor 
Standards, and Reports. 

Shop Includes Labor Distribution, Work in Process, and Reports. 

Favorites Includes Configure Favorites, Add Current Screen to Favorites and Related Links. 
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Window Choose how you want windows to display on your desktop: Tiled horizontally, vertically, 
or cascade. 

Help Includes Help, Technical Support, Customer Portal, and About Alliance/MFG. 

Submenu Functions 

Most submenus contain New, Edit, and a list of predefined queries. The queries available depend 
on the function you select. The File, Edit, Favorites, Windows and Help submenus have specific 
function related options. 

New - Displays a blank data entry form. 

Edit - Displays the data entry form for the record entered in the query dialog box. (Must be an 
exact match; wild cards are not permitted.) 

Predefined Queries - Displays a data view (list) of all records matching the query criteria. (Wild 
cards are permitted.) 

MDI Logo 

You may display your companies logo inside the Alliance/MFG MDI frame. Copy a bitmap to the 
Alliance>MFG>System folder. Delete or rename the existing Alliance “Background.bmp”, then 
save your company bitmap as “Background.bmp”. 

 

Toolbar Buttons 

There are ten (10) toolbar buttons used by Alliance/MFG windows, the button functions are 
described below. The toolbar buttons are dynamically available based on usability, the active 
window (window with focus) and the action taken by the user in that window. The more frequently 
used buttons have a text description to the right. If you position your mouse cursor over a toolbar 
button a Tool Tip describing the button function will appear. 

 

Toolbar Button Functions 

First - Move to the first record 

Previous - Move to the previous record 

Next - Move to the next record 
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Last - Move to the last record 

New Copy - Copy the selected record and create a new record include associated detail records 
(Header A record containing common, constant, or identifying information for a group of records which follows. & 
Detail) 

New - Displays a blank data entry form 

Save - Saves any valid change(s) made to a record(s) 

Delete - Deletes the selected record, record integrity is verified and a warning message may be 
displayed  

Query - Displays a query form with the last query executed (if any) 

Refresh - Refreshes the data in either a view or edit form 

Sidebar 

The Alliance/MFG Sidebar contains two sections; Favorites and Related Links. The Favorites 
section contains links to your Favorite edit, view and report screens, this section will save you 
additional time and keystrokes if you perform repetitive tasks. The Related Links sections display 
dynamic links to associated data based on the active or highlighted record in the current window. 
The links will display as hyperlinks when selected and if clicked will execute a pre-defined query 
with the current record’s data as the parameter(s). These links will save you time and keystrokes 
when you need to access related data (display the Receipts or Returns for the highlighted PO in 
the view screen). Unlike the queries from the Main Menu you are not required to fill in the query 
parameter(s), the parameter is supplied by the screen you have open and/or the record selected.  
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Sidebar Sections 

Favorites - Displays a list of your Favorite screens. You must configure this section by adding 
your favorite and often used screens (see below). 

Related Links - Displays dynamic links to associated data based on the active or highlighted 
record in the current window. 

View Links - Displays pre-defined links to associated views. The list of links is 
dynamically created each time a different window is opened or record selected. You 
may view or drill down to related data by clicking on a link. 

Edit Links - Displays pre-defined links to associated edit screens. The list of links is 
dynamically created each time a different window is opened or record selected. You 
may edit and change related data via these links. 

Report Links- Displays pre-defined links to associated reports. The list of links is 
dynamically created each time a different window is opened or record selected. 

Sidebar sections can be expanded or collapsed as desired, just click on the double arrow in the 
top right title bar of each section. Hiding the sidebar allows more of the main application working 
area to be accessible. You can choose to display or hide either section of the sidebar by clicking 
the Auto Hide Stick Pen icon on the top right side of the Sidebar. Additionally you can drag and 
drop the sidebar sections anywhere within the Alliance MDI or drop them on your desktop if you 
prefer. If you right click the Auto Hide Stick Pen it will display the available sidebar position 
options. 

Both sidebar sections docked. 
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Drag Favorites section to the right side of Alliance/MFG, collapse Related Links section. 

 

Move both sections out of Alliance/MFG to your desktop. When you close and then reopen 
Alliance/MFG the sidebar will display where you last positioned it. 
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When you hide a sidebar section, a Related Links or Favorites tab is enabled on the top left side 
of the main Alliance/MFG window (MDI), holding the mouse cursor over this button will allow you 
to access the Related Links and Favorites sections via a slide out window.  

 

Configuring the Favorites Section 

You can create a list of your Favorites to appear in the Sidebar every time you open 
Alliance/MFG. You can add Alliance/MFG views and reports and additionally, add external 
documents, spreadsheets, custom views and custom reports to your Favorites.  

Adding internal items to your Favorites 

For internal items you must first open and display the view or report to add it to your Favorites. If 
you use the Part Master on a daily basis, open it with your most frequently used query. Click on 
the Favorites menu and then Add that Part Master view to your favorites.  
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The Add Current Screen to Favorites dialog box will immediately display.  

 

You may rename the screen if you like. Click OK, your Favorites section will now be displayed in 
the sidebar.  
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You may create as many Favorite Links as you need to be efficient. When you are finished, use 
the configuration tool to configure your Favorites section. Click on Favorites>Configure Favorites 

 

Highlight the favorites selection you wish to configure, you may then rename a selection, modify 
the query, move a selection up or down within the favorites section, or delete a selection fron the 
favorites.  
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To prefill a query parameter(s) with frequently used value(s), click on the drop down query list and 
select the desired query. To display only "your" open purchase orders, query by Buyer Code. 

 

Next, enter the Default Query Values and Click OK.  
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You may display and verify the results by either clicking the Preview button or clicking the 
favorite’s selection in the sidebar.  

Adding External items to your Favorites 

Click on Configure Favorites option on the Favorites menu. Click the New button on the 
Alliance/MFG Toolbar. The Add New Link window is displayed. 

 

Click either the Custom View, External File or Separator radio button. To add a Custom View, 
click the drop down arrow and highlight any custom view you have created or downloaded and 
saved (Free Custom Views are available for downloading from the Alliance Customer Portal). To 
add an External file to your favorites, click the ellipse button and navigate to a document or file 
that can be opened with a double click event.  

 

Click the Open button. The path will be displayed in the Add New Link window.  
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Click the OK button to add the external document, custom view or separator bar to your 
Favorites. You can change the Description if needed. If you added a separator bar to separate 
items in your favorites you can drag and drop items to reorganize how they are displayed. 

 

You can either highlight and Preview the item you just added or click OK to return to Alliance. 
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Using the Sidebar Related Links Sections 

The Related Links sections display dynamic links to associated data based on the active or 
highlighted record in the current window. The links will display as hyperlinks when selected and if 
clicked will execute a pre-defined query with the current record’s data as the parameter(s). These 
links will save you time and keystrokes when you need to access related data (display the 
Receipts or Returns for the highlighted PO in the view screen). Unlike the queries from the Main 
Menu you are not required to fill in the query parameter(s), the parameter is supplied by the 
screen you have open and/or the record selected.  

Using the Sidebar with Related Views Section 

 

To view the labor router for a the part B-01, simply click on the Labor Routers View hyperlink in 
the sidebar. The desired view screen will be displayed for the highlighted record. 
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Using the Report Links Sidebar Section 

Simply click on the desired related report in the sidebar. The report will be displayed for the 
highlighted record. If you had selected the Report Indented BOM report link for part BPP-100 
from the sidebar a predefined query would have been executed with the part number parameter 
filled in. 

 

Drilling Down 

This feature allows you to move from one element of the system to another element via its table 
relationships, and optionally return to where you started without having to use the main menu 
functions and submenu queries. You can drill down from any data view form or data entry form to 
any related information linked to data in the form. You drill down by using the Related Links 
Sidebar. When you drill down through various tables from a data entry form, you can return along 
the same path as you close the various windows and tables. 

Data Views, Data Entry, and Transaction Forms 

Alliance/MFG is set up and operated using four basic window formats: Data Views, Data Entry 
Forms, Transaction Forms, and various dialog boxes. The windows contain various buttons, scroll 
bars, drop-down lists, date calendars, dialog boxes, and other elements familiar to you if you 
have used Windows programs. The system also generates messages that warn you about invalid 
or missing data, or prompt you for more information. The basic elements shown in the Alliance 
Window Types section operate the same way throughout the Alliance/MFG system. Use the Data 
Views such as the Part Master View to browse or view data in a system table and “drill down” to 
related data; use Data Entry forms to add, edit, or maintain records; use Transaction forms to 
ship, receive, kit, and perform other tasks that move material from one location to another. 

The Alliance Window Types section provide examples of each format and describe the basic 
controls used to view, select, enter, move, or delete data in the system.  
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Alliance/MFG Window Types 
Alliance/MFG is set up and operated using four basic window formats: Data Views, Data Entry 
forms, Transaction forms, and various dialog boxes. The windows contain various buttons, scroll 
bars, drop-down lists, date calendars, dialog boxes, and other elements familiar to you if you 
have used Windows programs. The system also generates messages that warn you about errors 
or missing data, or prompt you for more information. 

The basic elements discussed operate the same way throughout the Alliance/MFG system. Use 
the Data Views such as the Part Master View to browse or view data in a system table and “drill 
down” to related data; use Data Entry forms to add, edit, or maintain records; use Transaction 
forms to ship, receive, kit, and perform other tasks that move material from one location to 
another. 

Data Views 

Viewing and Browsing Data 

When you select a function from the Alliance/MFG Main Menu, and then select a from the 
submenu, the system presents a list of data in a window called a View. Most View Grids have the 
ability to sort, group, filter and calculate simple summary functions on any of the Columns of data 
in that View. Additionally view data can be printed and exported directly from the view.  

Select Products>Part Master>All to see a sample of a Data View showing all records in the Part 
Master. 
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You can scroll up and down and from side to side using the scroll bars on the Data View window 
to bring all items into view. You can also press Ctrl+Page Up or Ctrl+Page Down on your 
keyboard to quickly go to the top or the bottom of the list. You can select and drag a column 
(Caption) to the left or right. A Red Arrowhead indicates where the column will relocate to when 
the mouse is released. You can select and drag column widths to re-size your display, a Bold 
Dark Line indicates where the column size will be when the mouse is released; and you can re-
size the entire window to view all columns. These changes will be saved by the system. From the 
Data View, you can select an item and click Edit or double-click the item to open the related Data 
Entry form. 

Sorting Data Views 

Changing the way data is sorted can help you locate what you need quickly. With a Data View 
open, click on the column that contains the field you wish to sort. The data will sort alternately in 
ascending or descending order, each time you click the column header. An Up or Down arrow 
appears, and the data in the list is sorted in ascending or descending order. Below is a Part 
master view sorted by Description. 

 

You may sort views by more than one column by holding down the Shift key. Below is the Part 
Cross Reference view sorted by Part Number and supplier leadtime. 
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Printing a Data View 

In the top right of the data view window (below the Minimize, Maximize, Close buttons) there are 
three (3) buttons; Printer, Filter and Group. Arrange the data in the view the way you want to see 
it and then click on the Printer button. The Print Preview window will be displayed with your 
selected data view. You may have to adjust the page setup and other printing parameters 
(margins default to one (1) inch). 
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Filtering Data Views 

With large databases, you may want to use the Find/Filter tools to quickly locate data. The 
Find/Filter tools provide a quick way to find a range of data that begin or end with the same 
letters, words, numbers, revision, and so on. To filter a data view, click on the Filter button 
(Funnel icon) or CTRL + F to toggle the Filter Row. A filter row will be inserted as the top row of 
the view. You may apply a filter on any column or on multiple columns. Each column contains a 
Function button, a Text box, a Drop Down List box and a Clear Filter button. 

NOTE: 

Focus will be given to the Filter Row when it is first displayed.  If a column has focus then 
the cell in the Filter Row for that column will be given focus, otherwise the first 
column will be given focus.  

If you type in a “read-only” cell while the Filter Row is hidden, then the Filter Row will 
automatically be displayed, and the text will be entered into the Filter cell matching 
that column. 
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Filter by Column Data Value 

To find or filter by part number, simply click in the part number filter row, a text box and drop 
down list box are now available, either use the down arrow to select a part number or start typing 
a value in the text box. You may also create custom filters by clicking on (Custom). 
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Using the Function Filter 

We will attempt to find all parts with Descriptions containing the word "Red". Click on the Function 
button in the left side of the column header for "Description ".  

 

This will display the filter criteria for that column. In the drop down box click on "Contains", this will 
activate a filter text box in the Description column header.  

 

Simply begin typing the filter text (Red) beginning with the letters "Re" in the field to filter the view. 
The view will now only display part master records with descriptions containing the letters "Re".  
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This is an incremental filter, it we continue to type letters (add the letter "d") in the filter text box 
and the view will be reduced to only those parts containing the word "Red". 

 

We could further reduce the view to display only "Red" parts with Rev "A" by filtering on the 
column "Rev".  
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To clear the filter criteria click on the [no filter] button in the right side of the column header or to 
clear all column filters, click on the [no filter] button in the left column header above the row 
number. 

Grouping Data Views 

You may want to use the Grouping tool to better categorize and display data. The Grouping tool 
provides a quick way to display groups of data that you would have to perform and input multiple 
queries to see the same results. To group a data view, click on the Group button (Cubes icon) or - 
CTRL + G to toggle the Group Section. A Group header section will be inserted above the column 
headers in the view. The message “Drag a column header here to group by that column.” will be 
displayed. 
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To group the Part Cross Reference - All, data view by Supplier, drag the column header Supplier 
ID to the grouping section. A Red Arrowhead indicates where to drop the column when the 
mouse is released. The Part Cross Reference is now displayed grouped by Supplier ID. 

 

Each group and the number of records in each group is displayed. To view the data in a group, 
click on the + button (expand).  
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To display only "Approved" sources you may either add a filter to the view or add a subgroup by 
that column header. Drag the column header Approved Source to the group section of the view. 
The view will now display two groups for each supplier; Approved and Non-Approved parts. 

 

Grouping and Filtering Data Views 

To display only "Approved Sources" you could have added a filter to the Grouped view above 
instead of the subgroup. Click on the Filter button to add the filter row to the top of the view. Click 
on the filter button in the "Approved Source" column header. Then click in the True/False filter 
box. 
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Only Approved Source parts for each supplier will be displayed. 

Summarizing Data Views 

To review the average cost variance for each person performing cycle counts in the stockrooms, 
click on the Inventory>Physical Inventory>Edit/Review Counts>Current Counts. Click the Group 
icon and move the "Counter" field to the view header.  
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Next click on the Summary Icon in the View header, the Summary icon will be added to each 
column in the view. 

 

Click the summary button in the column header that you want to summarize (Cost Variance in the 
example). 
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The following summary functions are available:  - Average - Count - Maximum - Minimum  - Sum.  

To view the average cost variance by counter we check the Average box. We now see the 
summary line for each counter added to the counter group and the average cost variance for 
each counter displayed. Hold your mouse pointer over the Average to display the actual un-
rounded figure. 

 

To Export Data from a View 

Select the Export icon on the top of the view window, the following Export Options window is 
displayed. 
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Click on the Drop Down List Box to choose the export format. You are also presented with a list of 
all of the columns in the view. The check boxes indicate which columns will be exported. Un-
check if you do not want the column exported. 
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Click Ok, wait while the data is exported. The exported data will be displayed in the format 
indicated.  

 

NOTE: 

If you selected Clipboard, open the document you want to enter the data in and select 
Edit>Paste.  
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View Screen Buttons 

Icons on the top of the view window give you options for working with the data.  

 

Group  Click on this button or use CTRL + G to activate the column Grouping section of the 
view window. 

 

Filter Click on this button or use CTRL + F to insert a Filter row at the top of each column in 
the view. 

 

Summary  Click on this button to activate the Summary feature of the view window. 

 

Export  Click on this button to activate the Export feature of the view window. 

Print  After you have sorted, grouped or filtered a view you may print the view by clicking the 
Print button. 

Edit  Select an item and click Edit to open a data entry form for the item. 

Close Click Close to close the data view. 

NOTE: 

On Data Views, the double-click event always activates the highlighted (default) button, 
normally the Edit button. For custom views contact Account Management. 

53 



Alliance/MFG User Guide 

Data Entry Forms 

All information is entered into the system via data entry forms. Whether you are working with 
products, customers, suppliers, sales orders, or other information, you will find a data entry form 
associated with the function you’re using. Fields available on data entry forms differ, depending 
on the record and table you are maintaining. When you select an item from a data view or 
execute an Edit query from the menu, a data entry form opens. 

Maintaining and Adding Data 

As with data views, you can use the sidebar to “drill down” through data related to the item. For 
more detailed information about specific data entry forms, see the section related to the function 
of interest. There are two (2) Easy Entry forms in the system; one (1) each for Sales Orders and 
Purchase Orders, see the section related to each function for additional information on these 
forms. 

Key fields are normally displayed at the top of the form. If the record contains many fields, the 
form may display related fields on separate tabs. 

Data Entry Form Buttons 

Buttons on the bottom of the edit form give you various options for working with the data. Default 
options are active depending on which data edit form you open. Each button is briefly described 
below. 

Links Click Links (Links button is enabled only if sidebar is hidden) to view the Related Views, 
Related Edit Screens and Related Reports tabs. 

OK Click OK to save any changes and close the data edit form. 

Close Click Close to close the data form (if changes were made and not saved a warning will be 
displayed). 
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Key Fields 

Every record in a table must contain unique data in key fields. When entering a new record, if a 
key field is left blank, an “invalid” icon will appear next to the field. When you place the cursor 
over the icon, an error message will be displayed “Field cannot be empty” (Key fields are always 
required). Once valid data is entered, the invalid icon changes to a check mark, and if all other 
required information has been entered, the record can be saved. 

Validated Fields 

Many fields on the data entry forms are validated to ensure system integrity. The system will 
accept only valid data in these fields. An invalid icon appears next to the field and continues to 
display until you enter valid data. You will be unable to save a record until all validated fields 
contain valid data. 

Invalid Red X icon. Indicates a field contains invalid information. 

Green Check icon. Indicates a field has been changed. 

Hyperlink Stock UOM  Click to select data from a table. 

Optional Fields 

All remaining fields are optional and may remain blank, if entered some may require validation 
(Codes). Any information you enter in optional fields will appear in windows and can print on 
reports. Optional data can also be sorted in views and some will be transferrable to accounting 
packages. 
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Saving a Record 

When you click OK in a data entry form, your entry is saved, the record is added to the database, 
and the edit form closes. When you click the Save button on the Toolbar or use the Control + S 
keys, the record is saved and you can continue to work with the data entry form, entering optional 
information, selecting various tabs, or “drilling down” through various related tables Standardized 
information sets that uniformly describe and categorize data fields. For example, a stockroom table contains a list of 
stockrooms along with several fields of information that convey information about each stockroom. The type of information 
held is standard for each stockroom. . 

Canceling an Entry 

Click Close before you click OK or Save to exit a data entry form without saving your entries. You 
will receive a warning message. 

Detail Records 

Some records (sales orders and purchase orders, for example) contain multiple detail records as 
line items. Line item One item on a customer order or purchase order, regardless of quantity. details are usually 
added in data entry forms via the Lines detail tab. From here you can review or edit any existing 
lines, delete lines or add new ones. 

 

NOTE: 

New line entries and line changes are saved when you return to and save the header. 

Transaction Forms 

Transaction Forms provide the means to record the movement of parts and materials in and out 
of inventory and between locations. For example, you will use these forms when you ship and 
receive materials, kit and complete work orders, etc. These forms have multiple tabs for recording 
and viewing information pertaining to transactions. 
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Transaction PO Receipt - PO Detail Tab 

 

PO Receipt - Receipts Tab 

 

After a line is selected and received a transaction edit form is displayed. You may add additional 
information about the transaction here.  

57 



Alliance/MFG User Guide 

 

You may also drill down to record additional data concerning the transaction such as transaction 
information/text or you may also click on the SN/Lot Information button to record additional 
SN/Lot data, such as notes, expiration date, warranty date, maintenance date, etc. 

 

All data entered on a transaction form (shipping a sales order or receiving a purchase order) is 
also recorded in the Transaction Log. Alliance/MFG has twelve (12) transaction types. Detailed 
information about using each transaction type can be found in the help topics that describe each 
function (Demand, Supply, etc.) and also in the Inventory Control>Transactions section. 
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Other Controls and Functions 

This section describes other types of controls and functions found within Alliance/MFG. 

Date Calendars 

You’ll find drop-down calendar boxes on every window and dialog box in the system where dates 
must be entered or changed. 

TIP 

Use the date check box to indicate the date is active. Clear the check box to disable the date. 

You can highlight and edit a date here, or . . . click the down arrow to access a 
drop down calendar box. 

 

To change dates in a calendar box 

1. Click the down arrow on a date box to open a calendar box. 

2. Click the left or right arrows to scroll to the appropriate month. 

3. The calendar defaults to “today’s” date; you can select a different date. 

The system will prompt you to enter both start and stop dates if required. If the date you enter has 
already passed, a caution icon will appear. If the date is still appropriate, you may go ahead and 
enter it. 

NOTE: 

The system will use 12 hour or 24 hour time keeping, depending on your windows 
regional settings. 

Hyperlinks 

On Edit Forms you can enter data directly into fields; or if the field is linked to a table, you can 
click the hyperlink to access and select data. When a field is linked to a table via a hyperlink, the 
field title is underlined. You can also place the cursor in a hyperlink field and press F3 to open the 
linked View. Right click the Hyperlink to open a drop-down list of predefined queries, or left-click 
to use the default query. 

Hyperlinks
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Submenu options 

The system also provides a number of ways to access and enter data from a main menu function 
using submenu options. After selecting a function, select a menu item and then a submenu 
option. Supply>Work Orders> 
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Basic Queries 

New 

When you select New from a submenu, a blank data entry form opens for the item selected. 

Edit 

When you select Edit from a submenu, you will be prompted for the value of the record you wish 
to edit (Part Number, SO Number, Supplier ID, etc.). 

All 

All will display all table records in a data view. This may be slow if the table is large. Try to narrow 
your search by using the predefined queries. 

Predefined Queries 

With large databases, you can limit your query to a specific range of data. Depending on the 
menu item selected, a number of predefined queries will be available on the submenu. For 
example, to query sales orders by customer id, enter a Customer ID in the field and click Apply to 
view all sales orders for the customer ID selected. An asterisk icon next to the field indicates that 
you can use wild cards to locate a range of data. 

 

Click on the down arrow to display a drop down list of available queries. 

 

Using Wild Cards 

If you don’t know the exact information you need for a query, you can substitute wild cards for the 
unknowns, or to query a range of data. When an asterisk icon appears on a query window, hold 
the cursor over the icon to display valid wild cards. (Examples shown inside quote marks should 
be used without the quote marks.) 

* Matches any number of characters. It can be used as the first or last character in the character 
string. You can use "wh*" to find: what, white, and why. 

? Matches any single alphabetic character. "B?ll" for example, would find ball, bell, and bill. 
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[ ] Matches any character within the brackets. For example, "B[a,e]ll" finds ball and bell but not 
bill. 

- Matches any one of a range of characters. You must specify the range in ascending order (A to 
Z, not Z to A). For example, "b[a-c]d" finds bad, bbd, and bcd, but not bmd. 

! Matches any character not in the brackets. For example, "b[!ae]ll" finds bill and bull but not bell. 

Custom Queries 

Alliance/MFG predefined queries were created by experienced manufacturing and materials 
planners, and at the requests and expressed needs of our customers. However, if you don’t find a 
query that meets your needs, you can create your own. See the Technical Reference, Chapter 5: 
Reports & Queries, for information about creating custom queries. 
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Alliance/MFG Process Flow 
Manufacturing Process Flow 

The Alliance/MFG process flow chart below briefly summarizes the steps to enter an order and 
follow it through planning, purchasing components, manufacturing, and finally shipping.  It 
assumes a basic bill of materials. 

Part A - Make Part 

Part B - Buy Part 

Part C - Buy Part 

Part D - Buy Part 

From here you can reference the User Guide Chapters that discuss the various operations in 
each step. 

Alliance/MFG PROCESS FLOW 

STEP 1    Create and enter Part Master, Bills of Material and Inventory data for all of the 
parts. See Products, Part Master; and Inventory, Part Maintenance. 

STEP 2     Enter demand on your system; in this case, a Customer Sales Order for part A. 
See Demand, Customers, Entering Sales Orders. 

STEP 3     Run MRP that will recommend POs for buy parts B, C, and D, and a WO for 
make part A.  Accept the suggestions and place the orders. See Material Requirements 
Planning, Scheduling POs & WOs from MRP. 

STEP 4     Receive the material on the Purchase Orders, which will update your inventory 
quantities for buy parts B, C, and D. See Supply, Receiving Purchase Orders. 

STEP 5     Release the Work Order for make part A to the shop floor using the Kitting 
function. This will update the quantities in stock for buy parts B, C, and D. See Supply, 
Releasing & Kitting Work Orders. 

STEP 6     As the Work Order moves through the shop floor, direct labor can be applied to 
the work order through the Labor Distribution function. See Shop Floor Control, Labor 
Distribution. 

STEP 7     When all work has been completed, complete the work order through the WO 
Completions function. This will update your inventory quantity for the final assembly , part 
A. See Supply, Work Order Completions. 

STEP 8     Finally use the Shipping function, send the finished goods to your customer, 
and update the quantity of make part A you have in stock. See Demand, Shipments and 
Returns. 
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System Implementation 
Create an Implementation Plan 

This section describes how to set up and customize Alliance/MFG to perform according to your 
company’s specific set of operating parameters. It is important to establish an implementation 
plan before you begin creating your company and entering data. If you have not yet created an 
Implementation Plan, see the Alliance/MFG Technical Reference, Implementing the System, or 
see your Alliance/MFG Getting Started booklet for additional resources to help you put together 
your plan.  

NOTE: 

Descriptions and procedures presented in this section assume familiarity with 
Alliance/MFG’s Data View List and Data Entry forms, hyperlinks, and other system 
elements. These elements are discussed in detail in the section on Navigating 
Alliance/MFG. We recommend that you read the section on Navigating 
Alliance/MFG and understand the elements before beginning any procedures 
described in this section. 
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File Menu functions 
The File menu gives you access to the features you’ll use to create and access your company 
database. From here, you’ll define your company preferences for elements such as sales order, 
purchase order, and work order number formats, date formats; and define your company codes 
tables such as department numbers, region codes, tax codes, and so on. The options on the File 
menu include the following functions. 

Database - Select Database to log in and log out of databases in the system, set up security 
access for database users, create new databases, perform database utilities and import and 
export data to the system. 

Company - Select Company to set up your company name and address information, holiday 
calendar, employee files, and define your company preferences. 

Codes - Select Codes to set up all your company codes tables. (With a few exceptions noted in 
the appropriate sections, codes must be set up to facilitate setting up most other system 
functions.) 

Print - Select Print to preview or print a selected Alliance report. From the Print option you may 
also select a different printer. 

Exit - Select Exit to exit Alliance/MFG, all open windows will be closed. If data changes have 
been made and not saved, you will be warned. 

All except Exit are described in detail in the following sections. 
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Database 
A database is a collection of information associated with a specific entity, such as your company. 
Your manufacturing database will contain all the information about your company’s products and 
product structures; customers, suppliers, and employees, and your inventory. Alliance/MFG 
supports multiple databases, each with a unique name (identifier) and unique information. The 
number of databases you maintain will depend on your company organization and its products. 
For example, if your company has different business segments with different customers and 
suppliers, you could create a second database for that segment. 

To learn how to work with the system, you can first login to the sample Pen database that was 
supplied with your system. After you are familiar with how customers, suppliers, parts and other 
elements are added and managed in the system, you can create your own database using one of 
the start-up options described in the following section. (See Creating a New Database, later in 
this section, and be sure to review database information in your Alliance/MFG Technical 
Reference.) 

Choosing a Database 

The Alliance/MFG system offers one ready-to-use sample database (the Pen database) and two 
templates for creating your own databases. If you have already migrated your existing data you 
can also select that database to login to. 

PEN Database 

The Pen database contains sample company data that you can use to experiment with the 
system and familiarize yourself with its features. It represents a ball point pen manufacture and 
has sample sales orders, forecasts, purchase orders and inventory. You can add, edit, and delete 
data; perform transactions within this database, and practice working with MRP without fear of 
altering your own vital company information. 

Default Database 

The default database contains data commonly used in many of the codes tables, such as units of 
measure, shipping methods, and terms. You can use this database as a shortcut to help you set 
up your codes tables more quickly than if you were to start from a blank database. You can log in 
to this database, review the tables, and if the data is similar enough to require minor editing, you 
can save time by starting here. 

Blank Database 

The blank database template contains no data. You enter all the necessary information into all 
data tables. If the default database would require too much editing to fit your company’s 
parameters, this is the place to start. 

NOTE: 

After you create either type of database, or migrate your data you must add the database 
through the Alliance Data Connection dialog box, prior to logging in. 

Database Menu Options 

Once you start Alliance/MFG and the main menu appears on your screen, you must log in to the 
database you want to work with from the Alliance Data Connection dialog box. If you installed the 
Pen database, it will appear in the Alliance Data Connection field when you select Login. 
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Login 

To login to a database: 

1. Select File>Database>Login. The Alliance Data Connection dialog box opens. 

2. Select a database from the drop-down list. 

3. Click Login. After a moment, the Alliance Data Connection dialog box closes and you can 
access the database from all the system menu options. This may take a while as the 
system loads. All system users must login. The number of concurrent users is controlled 
by the system license. 

 

Logout 

Click Logout to exit this database, this does not close the application. Choose a valid database 
and login to resume. 

Security 

Access to functions, tables, and even specific fields on forms in the system can be enabled or 
disabled for individual users. If as a user you find that some menu items are dimmed, or that 
“padlock” icons appear next to fields on a data entry form or other dialog box, it means that you 
have not been given full access to those features. 

Supervisor rights give you full access to all system elements. You can assign limited rights to 
different employees as necessary; the system can add or limit employee access to specific 
features, reports, and even specific fields on a window. Security allows None, Read Only, and 
Read/Write privileges. 
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System security access is usually controlled by the System Administrator or Supervisor. For more 
information about assigning access to individuals, see the Alliance/MFG Technical Reference. 

Change MSDE Password 

If you are using MSDE you may want to periodically change the server’s password. The 
password should be known by your System Administrator and/or a Supervisor. It is important to 
remember the password and to make sure that it can be accessed even during personnel 
changes. If you loose or forget your password Alliance may not be able to help you access your 
data. 

NOTE: 

The MSDE instructions described here are for MSDE Databases only. Microsoft SQL 
Server 2000, SQL Server 2005 and SQL Express all come with there own 
Administration Tools. 

Create a New Database 

Databases are usually created by a System Administrator or Supervisor. Detailed information 
about creating a new database is presented in the Alliance/MFG Technical Reference. To create 
a new database you must first select the format, Blank or Default, then the database type, Access 
or MSDE/SQL Server. 

To create a new Access database, you must give it a file name and supply the path to it. You can 
use the Database Path hyperlink to drill down and insure path accuracy. 

To create a new MSDE/SQL Server database, click on the MSDE/SQL Server tab, enter the 
Server Admin Name, Password, the Server Name and the Database name. 

Once it’s created, it will be available to add to and select from the Alliance Data Connection 
dialog box. 
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Compact MDB Database 

It is important to maintain your database in its most compact form. Database management is 
usually performed by a System Administrator or Supervisor. Detailed information about database 
maintenance is presented in the Alliance/MFG Technical Reference. 

Backup Database 

Backing up is important to ensure the safety of your data. You should backup often and on a 
regular basis. Backups are usually created by a System Administrator or Supervisor on a daily 
basis and a copy may be taken off site weekly. Backups may be requested by Alliance 
Manufacturing Technical Support when troubleshooting a problem, they should be available. See 
the Alliance/MFG Technical Reference for detailed information. 

Restore MSDE Database 

You may need to restore a database if your server goes down or if you want to view history. 
Restoration is usually done by a System Administrator or Supervisor. See the Alliance/MFG 
Technical Reference for detailed information. 

Delete MSDE Database 

You should use extreme caution when deleting a database. Databases that have been restored 
to view history can be safely deleted. However, deleting your live database will result in 
permanent data loss. Deletions should only be performed by a System Administrator or 
Supervisor. 

Verify MDB Structure 

This feature is designed for use with Alliance Manufacturing Technical Support, and is typically 
only performed by a system administrator. For more information, see the Alliance/MFG Technical 
Reference, Chapter 3: System Administration. 

Import/Export 

You can import data into and export data out of Alliance/MFG for use in other programs. This 
procedure is normally performed by a System Administrator or Supervisor. Detailed information 
about importing and exporting data is presented in the Alliance/MFG Technical Reference. 

NOTE: 

The MSDE/SQL instructions described here are for MSDE Databases only. Microsoft SQL Server 
2000, SQL Server 2005 and SQL Express all come with there own Administration Tools. 
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Company 
Once you have logged in to the appropriate database, you are ready to begin entering Company 
information.  Select the Company option on the main menu to enter data about your company, 
including name and address, holiday schedule, employee information, and preferences for 
various global company attributes such as the number of decimal places you wish to display, and 
whether you want the system to auto-generate numbers for sales orders, purchase orders, work 
orders, and invoices. We recommend setting up the system codes prior to setting up your 
Company>Preferences as the Preferences screen will require various default codes be 
established. 

Company Menu Options 

Name and Address - Add basic company information such as name and address, contact, 
phone, fax, and e-mail address. 

Holiday Calendar - Schedule the days your company is closed; such as weekends, holidays, 
and plant shut downs.  These closed days will be excluded from MRP planning. 

Employees - Maintain information about employees that will be used in various functions 
throughout the system. 

Reset Year-to-Date Usage - Use periodically to reset to Year-to-Date usage on inventory parts. 

Preferences - Configure default values, formats, and codes; and Sales Order, Purchase Order, 
Work Order, and Invoice numbering conventions. 

Each is described in detail in the following sections. 

 

Company Name and Address 

Enter your company’s name, address, contact names, telephone numbers, fax number, and e-
mail address as you would like them to appear on any displays, reports, orders, invoices, or other 
documents that will be produced by your system. Multiple addresses are permitted.  Your 
company’s “Bill To” address may be different than your “Ship To” address. 

Once this information is added, you can enter as many different address lines as you need to 
conduct business.  Each address line will have a unique ID. 

To enter your company name information: 

1. Select File>Company>Name and Address to open the Company data entry form. 

2. Enter your company name. 
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Company Tab  

1. Enter the name of the person you wish to appear on any documentation generated by the 
system for company contact. 

2. Enter the phone numbers for the Primary Contact person. 

3. Enter the name of a second contact person, if available. 

4. Enter the phone numbers for the second contact person. 

5. Enter the Fax number for your company as you want it to appear on any correspondence. 

6. Enter your company’s primary e-mail address as you want it to appear on any 
correspondence. 

7. Enter a Region Code or click the hyperlink to select one from the Region Code View.  

8. Enter your VAT Registration Number if you will use the Intrastat Reporting Tracks Value 
Added Tax payments and receipts. 

9. Enter your VAT Branch ID if you will use the Intrastat Reporting feature. 
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Company Address Tab 

Click the Company Address tab.  

 

The Company Name displays at the top of the form.  Any existing address lines display in the 
body.  You can create as many address lines as you need to conduct business.  For example, 
you may have different Bill To and Ship To addresses or you may have different warehouse 
locations. 

To add a new address: 

Click Add on the left side of the Company form.  The Company Address form opens.  

  

1. Enter a unique Address ID.   

2. Enter up to four address lines for this Address ID.  For example, you can enter a 
warehouse name, a block or suite number, and a person’s name. 

3. Enter the city, state and Zip code for this address ID.  City, State, and Zip codes are 
hyperlinks to the Zip code table. 
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4. Select either Ship To or Bill To, or both, to identify this address ID as either the Bill to or 
Ship to address. 

5. Enter the country name, if needed. 

6. Enter a postal code, if needed. 

7. Enter the tax code that applies to this address ID, or click the hyperlink to select one from 
the Tax Code table.   

8. The Tax Rate will display for the Tax Code selected in the previous step. 

9. Click Close to save your entries and return to the Company data entry from. 

10. When  you are finished entering company information, do one of the following: 

Click Save to save your entries and leave the form open. 

Click Add to add another company. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving.  (Saved entries will be saved.) 

To edit a company address: 

1. From the Company form, Address tab, select the Address ID line you wish to edit. 

2. Click Edit on the left side of the form to open the Company Address  data entry form. 

3. Change information as needed. 

4. Click Close to save your changes and return to the Company form, then click Save or OK 
to save. 

To delete a company address: 

1. From the Company form, Address tab, select the line you wish to delete. 

2. Click Delete.   

NOTE: 

You cannot delete an address if it is in use on any PO's in the system.  You must first 
change or delete it from the PO, then delete it from the Company Address list. 

Creating a Holiday Calendar 

Settings in the Holiday Calendar tell the system which days throughout the year your company 
will be closed.  It is important to keep this calendar up to date because MRP does not schedule 
closed days when planning production requirements.   

New holidays are added in the Holiday Calendar data entry form.  Each holiday must have a 
unique description, start and end date. 
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To add a new holiday: 

1. Select File>Company>Holiday Calendar>New to open a blank Holiday Calendar data 
entry form. 

2. Enter a description for the new holiday.   

3. Select start and end dates from the date boxes. (The start and end dates can be the 
same if the holiday is a single day.)   

4. Click Save to save the holiday, or click Add to continue adding holidays to the calendar. 

5. When you have finished adding all holidays, click OK to save your entries and exit the 
form.  The system will now consider these days as non-production days when planning. 

NOTE:   

If the Start and End dates of the holiday you select have already passed, a caution icon will 
appear next to the field.  If the date is still acceptable to you, you may save the record. 

Using the Calendar View: 

The Holiday Calendar View lists all the holidays currently set up for your company.  From here 
you can print the Holiday Calendar Report or edit existing holidays. 
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To edit an existing holiday: 

Select File>Company>Holiday Calendar>All.  The Holiday Calendar view list opens. Select the 
holiday you wish to edit and click Edit or double-click to open the Holiday Calendar data entry 
form. 

1. Select new Start and End dates. 

2. Click OK to save your entries and close the form. 

To delete a holiday: 

1. Select File>Company>Holiday Calendar>All.   

2. Select the holiday you wish to delete and click Delete. 

3. Click Yes at the Warning to confirm the deletion. 

4. Click Close to save your change and exit the data view. 

 

Entering Employees 

Alliance/MFG can store personal information about each employee who works for your company, 
such as address, phone, and social security number; however, its primary purpose is to define 
employee parameters such as department code, wage and commission rates, and in what 
system functions an employee’s name will appear on selection lists.  

Select File>Company>Employees>New to open a blank Employee data entry form. 
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1. In the form header, enter the Employee ID.  The Employee ID is a key field and cannot be left 
blank. Employee ID's are used throughout the system for user identification. 

2. Select Active if this is a current employee who will be accessing Alliance/MFG. 

Address Tab 

The Address tab contains employee personal information.  This information is optional and not 
used in any system calculations; however, you can print a comprehensive Employee Report that 
includes this information. 

1. Enter employee address information.  (Two lines available.) 

2. Enter the first name, middle initial, and last name of the employee as you want it to appear in 
the system and on reports. 

3. Enter the city, state, and Zip Code for the employee address. 

4. Enter the Phone, FAX, E-mail, Country, and Postal information, if required. 

TIP: 

Alliance/MFG contains a comprehensive Zip Code table. To quickly enter the city, state 
and Zip, click the City hyperlink and enter a city in the By City dialog box. The Zip 
Code view list displays Zip Codes for only that city.  Click the appropriate line and 
click Select to automatically fill in the City, State, and Zip code fields on the 
Address tab. 
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Employee Detail Tab 

The Employee Detail tab contains settings that determine how the employee record is used 
throughout the system.  

 

1. Enter a valid Department code or click the hyperlink to select one from the Department 
Codes View.  The code description will display to the right of the field.   

2. Enter the employee Social Security Number.   

3. Enter the employee wage rate to be used in labor calculations.  

4. Enter a commission rate, if applicable. 

Employee Functions:  

Select the Alliance/MFG functions this employee will perform. This will help narrow your search 
for employees when needed. 

Engineering Changes - Select Engineering Changes if this employee will be involved in this 
activity.  If selected, the Employee ID will be available from the Originator drop-down list on the 
Engineering Change Notice data entry form. 

Labor Operations - Select Labor Operations if this employee’s activity will be tracked via the 
Labor Distribution function.  If selected, the Employee ID will be available from the Employee ID 
drop-down list on the Labor Distribution data entry form. 
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Purchase Orders - Select Purchase Orders if this employee is a buyer or purchasing agent.  If 
selected, the Employee ID will be available from the Buyer Code list on Purchase Order data 
entry forms. 

Sales Orders - Select Sales Orders if this employee is a salesperson.  If selected, the Employee 
ID will be available from the Salesperson list on Sales Order data entry forms. 

Inventory Accuracy - Select Inventory Accuracy if this employee will perform physical inventory 
counts.  If selected, the Employee ID will appear on the Inventory Tags Counted-by list.   

NOTE:  

Do not confuse these settings with Security Access. See Security in the Alliance/MFG 
Technical Reference for information about assigning employee permissions. 

Viewing Employee Records:  

Once employee records have been entered into the system, they can be accessed from the 
Employees View list.  Select File>Employees> All to open the entire list, or use a predefined 
query to locate a specific employee or group of employees. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

To edit an employee record: 

1. Select an employee from the Employees View. 

2. Click Edit or double-click to open the Employees data entry form. 

3. Enter any changes. 

4. Click Save or OK to save. 

5. Click Preview to see the report on screen. 

6. Click Print to print a hard copy of the report. 

To print a single employee record: 

1. From the Employee View or data entry form, select the employee record you would like to 
print and from the sidebar or link button click Reports. 
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2. Select Employee Information Report.  The Employee List Report dialog box opens.  The 
Employee ID field displays the ID for the employee selected. 

3. Click Preview to see the report on screen. 

4. Click Print to print a hard copy of the report. 

5. When you are finished, click Close to return to the Employees View, or enter another 
Employee ID and preview or print another record. 

Reset Year-to-Date Usage 

Alliance/MFG tracks all issues and shipments from inventory throughout the year and displays 
that figure as the YTD Usage field on the Part Master>Statistics Tab.  Companies typically reset 
this feature to zero annually. Select File>Reset Year-to-Date Usage to set all parts usage back to 
zero.  Employee access to this function can be controlled through the security function. 

Setting Your Company Preferences 

Company preferences specify universally used settings for your company such as formats for 
displaying dates and numbers, whether or not to auto-generate sales order, purchase order, work 
order, or invoice numbers and what those number formats will be; define your default billing and 
shipping address; define default AP and COGS accounts, and other settings specific to your 
operation.  

The settings in this window apply to all areas of the company database. You should select 
settings in the Preferences window according to your Implementation Plan.  

Settings are accessed via five tabs: Accounting, Auto-Numbering, Base Units,  Number, and 
Manufacturing.   

Enter the information on each tab as described in the following sections.  You can click Save as 
you work your way through the tabs to save your settings, or when you are done, click OK to save 
your settings and exit the Preferences window.  Your settings will be applied throughout the 
system.   

NOTE:   

The Company Preferences data entry form offers selections from the data set up in the 
Codes feature.  If you have not yet set up these codes and tables, no selections 
will be available.  See Codes, for more information about setting up Codes. 

Accounting Tab 

This tab defines various default accounting information used throughout the system. 
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Enter your company’s Default PO Bill To address as set up in your Company Address list.  This 
address will default to new purchase orders. You can override this address on a purchase order 
at your discretion. 

Enter your Default PO Ship To as set up in your Company Address list. This address will default 
to new purchase orders. You can override this address on a purchase order at your discretion. 
(The Bill To and Ship To address need not be the same.) 

Enter a Default A/P Department. This account number will default to new purchase orders. You 
can override it on a purchase order at your discretion.  

Enter a Default COGS Department. This department number will default to new sales orders. You 
can override it on a sales order at your discretion.  

Enter an Invoice Remit To Address if your invoice address will be different from your billing and 
shipping address. This address will default to your invoices. 

Select a Cost Type from the drop-down list.  You can choose to maintain the average cost of your 
purchased parts (and standard costs on your manufactured parts), use standard costing for all 
parts, or maintain average costs for all parts (For more information about cost types, see 
Selecting a Cost Type below). 

Enter your company’s Base Currency code.  You can use other currencies on purchase order and 
sales order reports.  Alternate currencies will be converted to or from  this currency for internal 
accounting transactions. 
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Select Require Intrastat if you do business in the European market and require Intrastat 
Reporting.  This feature works in conjunction with ICN Codes, Intrastat Rates, and 
Region/Country codes. (See Inventory Control, for more information about setting up the Intrastat 
Reporting feature.) 

Select Require Invoicing to enforce invoice creation from sales order shipments. 

Selecting a Cost Type 

There are three cost type options available in Alliance. This option should be discussed with your 
Owner, CFO (Chief Financial Officer), accountant or consultant. The value of your WIP (work in 
process) and on-hand (purchased and/or manufactured) inventory is dependent on the costing 
method chosen. After deciding which method is appropriate for your business you will need to set 
your cost type in System Preferences and establish your initial costs. See Inventory Control>Cost 
Maintenance for information on entering costs for new parts.    

Standard Cost – All Parts 

If you use the Standard Cost The normal expected costs of an operation, process, or product 
including labor, material, and overhead charges, computed on the basis of past performance 
costs, estimates, or work measurement method, you will need to establish initial standards based 
on current or historical costs, engineering or purchasing estimates and work measurements. Most 
manufacturers then record and measure any variances (Labor, PPV and MUV) against their 
established standards and perform a periodic cost revision to update those standards. Also see 
Cost Roll Up and Update Standard Cost in the Inventory Control section of the Help. 

Average Cost – All Parts  

If you use the Average Cost - All Parts method; 

The average cost for manufactured parts will be recalculated and updated when you move 
material into a nettable stockroom (WO Completion/Backflush). You must complete your 
manufacturing work orders in one (1) transaction (no partial completions).  

The following formula is used to calculate a new average cost. The existing quantity on hand 
multiplied by the current inventory cost plus the WO completed quantity multiplied by its cost (WO 
cost = The total of WIP Issues cost + labor cost + burden cost + setup cost).  

(quantity on hand x current inventory cost) + (quantity completed x WO cost)  

divided by 

quantity on hand + quantity completed  (or total quantity) 

The average cost for purchased parts will be recalculated and updated when you move 
material (receive) into a nettable stockroom.  

The following formula is used to calculate a new average cost. The existing quantity on hand 
multiplied by the current inventory cost plus the PO received quantity multiplied by its PO price. 
The existing inventory quantity includes purchased parts issued to work orders that are still in 
WIP. 

(quantity on hand x current inventory cost) + (quantity received x PO cost)  

divided by 

quantity on hand + quantity received  (or total quantity) 
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Average costing A system-calculated cost value based on the average price of received 
materials. recalculates the cost of your parts and displays this current average cost as the 
“Current Inventory Cost.”  You can view the Current Inventory Cost on the Part Cost tab of the 
Part Maintenance form.  (Select Inventory>Part Maintenance and select a part from the list, click 
Edit, then select the Part Cost tab.)  

The "Use Current Cost" checkbox must be checked when performing a cost roll up.  

Average Cost - Purchased Parts Only 

When you elect to Average Purchase Parts Only, Alliance will use an average cost when 
performing transactions involving purchased parts, such as PO Receipts, Work Order Kitting, 
Subcontract PO Kitting, Backflushing and any Shipments of purchased parts.  

A standard cost will be used for manufactured parts when performing transactions such as Work 
Order Completions, Backflushing, and Shipments of manufactured parts. 

Average costing recalculates cost of your purchased parts with every receipt, and displays this 
current average cost as the “Current Inventory Cost.”  You can view the Current Inventory Cost 
on the Part Cost tab of the Part Maintenance form. (Select Inventory>Part Maintenance and 
select a part from the list, click Edit, then select the Part Cost tab.)  

The "Use Current Cost" checkbox must be checked when performing a cost roll up.  

The following formula is used to calculate a new average cost. The existing quantity on hand 
multiplied by the current inventory cost plus the PO received quantity multiplied by its PO price. 
The existing inventory quantity includes purchased parts issued to work orders that are still in 
WIP. 

(quantity on hand x current inventory cost) + (quantity received x PO cost)  

divided by 

quantity on hand + quantity received  (or total quantity) 

Example: 

For this example you have zero items in stock.  You then receive 100 from a Purchase Order at 
$1.00 each.  You now have 100 on hand, and the average cost field is set to $1.00.  Next you 
receive 100 more at $1.50.  Now you have 200 on hand and the average cost field is set to $1.25: 

[(100 x $1.00) + (100 x $1.50)] /200 = $1.25 

Next you issue 50 of the part to a Work Order.  You still have 200 at $1.25 (150 on hand and 50 
in WIP).  Next, you receive 100 more at $1.50 each.  You now have 300 at $1.33. 

[(200 x $1.25) + (100 x $1.50)] /300 = $1.33 

The average cost is not recalculated until the material is received to a nettable stockroom.  If you 
receive into a non-nettable stockroom the material’s value will not be included in the average cost 
until it is relocated into a nettable stockroom. 

Auto Numbering Tab 

You can set up the Alliance/MFG system to automatically generate Sales Order, Purchase Order, 
Work Order, Invoice or Quotation Numbers.  We recommend that you use this feature. This way, 
the system will automatically keep track of system numbering for you. You can format the 
numbers any way you wish to meet your company requirements. 
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To set up auto-generated numbering: 

1. Select the Auto-Generate boxes as appropriate to indicate if you would like the system to 
automatically generate numbers (this is recommended). This option will generate unique, 
sequential numbers in the desired format for your sales order, purchase order, work order, 
and invoice documents.   

2. If you select Auto-Generate, you must enter a format to auto-generate. This can be any 
combination of letters and numbers up to 10 characters. Any part of a date (Month, Year, 
Day) may be included in the auto-generation by entering  *M, *Y, or *D in any combination. 
Sequential numbering fills in the remaining numbers. For example, the sales order number 
SO00041547, would be the 47Th sales order automatically generated on April 15, 2000 in the 
format “SO*Y*M*D”.  

3. If you do not wish to use 10 characters, enter your preferred format, then insert “#” for the 
number of characters you wish to use.  The system will increment those numbers.  In the 
example, the system has been set up to create invoice numbers beginning with 1, then 
generate a five-digit number that increments by 1. 

4. You can set the starting number to any number you wish. Enter the number in the Start 
Number field. 

NOTE: 

You can select auto-generate for some or all of the functions; if you don’t wish to use 
auto-generate, clear this checkbox. 
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Base Units Tab 

 

You must define a base unit of measure (The smallest units of measure used for either/or length, 
weight volume, or units. The smallest length unit may be inches, feet, etc., while the smallest 
weight unit may be ounces, pounds, etc.)  for each type you will use (length, weight, area, 
volume, and unit).  These form the basis for converting all measurements in your system and 
should represent the smallest unit of measure used anywhere in your system.  For example, you 
may purchase tubing by the foot, but if you use it by the inch in production, then your base unit of 
measure for length should be “inch.”   For more detailed information, see Working with Units of 
Measure at the end of this chapter. 

NOTE: 

You must define your UOM Codes before you can select them in this tab. 

Manufacturing Tab 

In the Manufacturing tab, define the days your company will be in production. MRP and CRP will 
consider this information when building schedules. 

1. Under Scheduled Work Days, select the check boxes for the days of the week you want MRP 
and CRP to consider when planning.   

2. Enter your daily Start and Stop times.  You can use 12- or 24-hour formats.  If you do not 
define work center shifts with individual start and stop times, CRP will use these times for all 
work centers. 
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Numbers Tab 

In the Numbers tab, enter the number of cost and quantity decimal places you wish to be 
displayed on Alliance/MFG forms and reports. 
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Codes 
Codes Menu and Tables 

Codes tables provide the means to standardize your system and apply these standards to your 
company and to all your customers, suppliers, parts, pricing and inventory control, as needed. 
How you create and apply these codes should be part of your Implementation Plan. 

Creating well-defined codes tables will save you time when entering information, as well as 
ensure that the data entered is consistent; particularly if several different users enter information. 
Standardizing such information will help guarantee reliable database sorting and reporting. 

For example, if you create a region codes table containing North, South, East, and West; they will 
be accessible via hyperlink from your customer and supplier forms. Only codes contained in this 
table will be considered valid. When users enter customers and suppliers, they can choose the 
appropriate region code from a hyperlink, or enter a valid code if they know it. However, if they 
attempt to enter an invalid code, such as Western or W, the system will display an invalid icon 
next to the Region Code field, and disables the OK and Apply buttons until the invalid entry is 
corrected. You can also add new records via the hyperlink. In this example, region code 
validation ensures that when you want to report or view all sales orders by the region code, you 
will get all the records. 

If you created your database using the Default database, some of the codes tables will contain 
entries to help you get started. 
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NOTE: 

Code setup should proceed in a logical sequence; therefore, the following sections are 
presented in logical order, rather than in the order they appear on the Codes menu. 

Access system codes tables from the Alliance/MFG File menu. For each code type, you can 
select New to open a blank data entry form, or select All to open a list of any existing codes. 
Additional menu queries available on submenus depend on the code you select. For example, the 
submenu queries for Commodity Codes are New, All, and By Buyer Planner; while the submenu 
queries for Department/Stockroom Codes are New, All, and By Account Number. 

Creating and Editing Codes 

With a few exceptions, creating codes is a simple matter of entering a code or meaningful 
abbreviation for the code, along with a description. Once the codes are defined,  they will be 
available for general use within the system. For example, Currency Codes, once defined, will be 
selectable via hyperlink on the customer, supplier, part cross reference, sales order and purchase 
order data entry forms. 

To add a new code: 

1. Select File>Codes and from the submenu, the code type you want to create, then select New. 
A blank data entry form opens. 

2. Enter a code and description for the new record.   

3. Enter any additional information in the fields, depending on the code selected, then do one of 
the following: 

4. Click OK, Add, Save, or Close as needed. 

To edit an existing code: 

1. Select File>Codes, the code type you wish to edit, then select All. 

2. The data view list opens for the code type selected, for example, if you select Region Codes, 
the Region Codes View opens. 

3. From the view list, select the code you wish to edit and click Edit to open the data entry form. 
  The code will display in the key field at the top of the form.  You can edit the description and 
any other available information.   

NOTE:   

You cannot edit a key field on a data entry form. Therefore, if the code is incorrect, you 
must delete the code from the codes list, then re-enter it in its corrected form. 

When you are satisfied with your edits, do one of the following: 

Click Save to save your changes and leave the form open. 

Click Add to add another code. 

Click OK to save your changes and return to the data view. 

Click Close to exit the form without saving your changes. 

If you don’t wish to save your edits, and you have not yet applied your changes, you can click the 
Refresh button on the toolbar to restore the original entries. 
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The following sections describe how each code type applies throughout the system; the other 
tables the code is related to in the system; and what information to supply in the fields when 
creating a code.  
 
System Codes 

The following codes apply generally throughout the system.  Unit of Measure and Discount codes 
are system codes but are presented separately and in more detail at the end of this section. 

Class Codes 

The Class code table is currently for use with the Alliance/MFG QuickBooks accounting link. See 
your QuickBooks User Guide for details. 

Commodity Codes  

Commodity codes are assigned to part numbers, assigning a commodity code helps categorize 
the inventory into buying and planning groups. Commodity codes may also be assigned to buyers 
and planners, they can be queried and are displayed on the MRP Action Parts screens and 
reports. For example, you may stock several different sizes of screws, nuts and bolts and though 
each one would have a separate part number, you may find it useful to categorize them also with 
a broad commodity code such as “hardware” or “HDW.” 
 

 
 

To add a commodity code: 

1. Enter a code and description for the new commodity. 

2. Enter the Buyer Planner’s Employee ID. (To associate the Commodity Code with a 
Buyer/Planner, the employee must be set up as a Buyer in the Employee Functions box in 
the Employee’s record. See Company, Employees.) 

3. Click OK, Close, or Save as required to complete the record. 

Viewing Commodity Codes  

The records displayed in the Commodity Codes View depend on the query you select. In the 
following example, we selected “All.” From here you can add, edit, or delete a code; drill down or 
via the sidebar, access related data; preview or print a report. 

89 



Alliance/MFG User Guide 

 
 

Currency Codes 

If your company trades internationally, currency codes define exchange rates for each country 
you do business in.  All exchanges will be compared to the base currency defined in your 
Company Preferences form.  
If you specify a currency code in their respective records, exchange rates will print on the Sales 
Orders and Purchase Orders generated for customers and suppliers.  (The codes and rates can 
also be edited in the Sales Order or Purchase Order data entry forms.) 
 

 
 

To add a currency code: 

1. Enter a code and description for the Currency code.  

2. Enter the appropriate Exchange Rate. This field is required and must be greater than zero. 

3. Select EMU Member? If this currency is used by a member of the European Monetary Union. 
 This flag will tell the system to calculate VAT accordingly (apply triangulation, or not). 

4. Enter a Rate to one Euro if you are an EMU member.  This will define the applicable 
conversion rate. 
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Viewing Currency Codes  

The records displayed in the Currency Codes View depend on the query you select. In the 
following example, we selected “All.” 
 

 
 
From here you can add, edit, or delete a code, or via the sidebar you may drill down or access 
related data, preview or print a report. 
 
NOTE:   

The system will display all costs in your default currency; however, Sales Order and 
Purchase Order printouts will show units in the currency code entered for the 
customer or supplier for that order. 

Department/Stockroom Codes 

Departments are functional areas of your company, such as Purchasing, Engineering or 
Assembly (WIP). Alliance/MFG also uses departments to refer to accounting activities. 
Departments and stockrooms can have default account numbers assigned.  
You must provide at least one “Department” and one “Stockroom” to represent an area that you 
will move stock/inventory into, out of, or through. You can create any number of Department and 
stockroom codes to meet your requirements. 
If you are using an Alliance Accounting Link, the account numbers you set up in Alliance/MFG 
Department Codes must match account numbers in your accounting package. 
 
Typical Manufacturing Department and Stockroom Codes 

Purchasing - Reference an accounts payable account 
Subcontract WIP - Reference an inventory account  
Work in Process - Reference an inventory account  
Stockroom - Reference an inventory account (see stockroom flags below)  
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To add a Department/Stockroom Code: 

The body of the Department Code data entry form contains two tabs: Department/Stockrooms 
and Location. Departments and stockrooms use the same data entry form, however, stockrooms 
require additional information such as Location and three (3) Inventory Flags. After you enter a 
code, tab down and enter the information in the tabs as described in the following sections. 
Department/Stockroom Tab 

 
 
1. In the Department/Stockroom tab, enter a description for the department or stockroom. 

2. Enter an Account Number. If you use an Alliance Accounting Link, this account must match 
the corresponding account in the Chart of Accounts of your accounting package.  

3. Select the Inventory Flag box if this is a stockroom and it will maintain inventory. 

4. Select the Nettable The designation given to a stockroom to indicate that the parts within are part of available 
inventory and are to be used by MRP in its calculations. Flag box if the inventory is to be considered in 
MRP calculations. If Engineering has a stockroom with inventory specifically for design and/or 
prototypes, that is not available for manufacturing to use, don't check this box. 

5. Select the Quarantine box if the inventory is to be considered in MRP calculations but is not 
yet available for kitting and shipping. Use this check box for Incoming Inspection, burn-in, 
quarantine, etc.  

NOTE: 

All stockrooms must have at least one location assigned.   

Locations Tab 

You can have as many locations as you need per stockroom.  The body of the tab displays any 
locations already defined. 

92 



Setting Up Your Company 

 
 
To add a new location: 

In the Location tab, click Add to open a blank Stock Locations form. 
 

 
 
1. The Stockroom Code, Inventory Flag, Nettable Flag and Account Number display at the top 

of the form. 

2. Enter the new location code.  

3. Enter a description for the new location.   

4. Click Close. The new location is added to the list in the body of the Locations tab, and will 
now be available for selection when you receive or kit parts. 

5. Click OK, Close, or Save as required. 
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Viewing Department Codes and Locations 

The records displayed in the Department Codes View depend on the query you select. Codes are 
displayed along with a description, G/L account, and inventory, nettable and quarantine flags. 

 
 
From here, you can add, edit, or delete records; or via the sidebar you can access related data, 
preview or print reports; and, because department codes are related to every transaction in the 
system, you can drill down to nearly every function. 
ECN Class Codes 

When engineering changes are introduced, you can use a class code to advise users of the 
scope of the change.  Once the codes are created, they can be accessed via hyperlink when 
employees create ECNs using the Engineering Change Notice feature. 
ECN Class codes might include: 

CL1 - Class 1 - Stop All Shipments/Production 
CL2 - Class 2 - Stop All Production 
CL3 - Class 3 - Phase-in Changes 
REL - Product Release for Manufacturing 

To add a new ECN Code: 
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1. Enter an ECN Class Code and description. 

2. Click OK, Close, or Save as required. 

Viewing ECN Class Codes 

The records displayed in the ECN Class Codes View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

FOB Codes 

Free On Board or Freight On Board (FOB) Codes assign responsibility and ownership during 
product delivery.  For example, if the FOB point for a particular sales order is “shipping dock,” the 
goods are your company’s responsibility up until the order ships from your dock.  At that point, 
ownership of the goods passes to the buyer.  If the FOB for the sales order is “receiving dock,” 
your company is responsible for the goods until they are received by your customer.   

To add an FOB code: 

 

1. Enter a Code and description for the FOB Code 

2. Click OK, Close, or Save as required.   
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Viewing FOB Codes 

The records displayed in the F.O.B. Codes View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

Region/Country Codes 

Enter Region/Country Codes to define geographical or other regions you would like to apply to 
your customers and suppliers. You may use this feature to group your sales orders by region and 
view sales volume by geographical areas.  

If your business requires Intrastat Reporting, you can define Intrastat tax codes and rates. 
 Region codes are used in conjunction with ICN codes, defined later in this section. 

Once your region codes are created, they will be accessible via hyperlink from Customers, 
Suppliers, Sales Order, and Purchase Order data entry forms. 

To add a Region/Country code: 

 

1. Enter a Region Code. 

2. Enter a description. 

3. Click OK, Close, or Save as required. 
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Viewing Region/Country Codes 

The records displayed in the Region Codes View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

Tax Codes/Rates 

You can create tax codes and rates that can be applied to any taxable items.  Once you create 
the codes and associated rates, they will be accessible via hyperlink from the Sales Order and 
Purchase Order Detail Line Items forms, Intrastat Rates, and Customer and Supplier Address 
data entry forms. 

To add a Tax Code/Rate: 

 

1. Enter a Tax Code. 

2. Enter the Tax Rate. 
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3. Enter a Liability Account number.  This corresponds to your general ledger for sales tax 
payable. 

4. Enter a description for the tax code. 

Viewing Tax Code/Rates 

The records displayed in the Tax Code/Rates View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

ICN (Intrastat) Codes  

If you do business within the European Union, you can assign ICN codes to help you track value-
added tax payments and receipts for international customers.  ICN codes and Region codes work 
together to compute tax codes and rates for Intrastat reporting. (Region codes are described later 
in this section.) 

After you create ICN codes and Region codes, you assign tax codes and rates to them in the 
Intrastat Rates table.  

TIP: 

You can set up this table from the Intrastat codes data entry form as you enter ICN codes, 
or create all ICN and Region Codes, then select Intrastat Rates from the Codes 
submenu and apply tax codes and rates all at once. 

ICN codes are assigned by commodity type to part numbers in the Part Maintenance function. 

Once the ICN codes are created and rates assigned, they will be accessible by hyperlink from the 
Inventory tab on the Part Master.  (For more information about setting up Intrastat Reporting, see 
the Inventory Control section.) 
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To add a new ICN Code: 

 

1. Enter an ICN Code and Description 

2. Click OK, Close, or Save as required. 

Viewing ICN Codes 

The records displayed in the ICN Codes View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

Intrastat Rates 

After you create Intrastat codes and Region codes (see Region codes later in this section), you 
assign tax codes and rates to them in the Intrastat Rates table.  

To define a tax code and rate for an ICN Code: 

Select Codes>Intrastat Rates to open the Intrastat Rates data entry form. 
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1. Enter an ICN Code. 

2. Enter the Region Code that the rate will apply to. 

3. Enter the Tax code to apply to the rate. 

Operation Codes 

Operation codes identify individual labor or machine operations performed on the shop floor. 
 When accessed in the Labor Distribution feature, the operation code helps you track individual 
operations on a work order, including the actual time worked on a specific operation and the 
quantity completed.  Operations codes are linked to work centers and displayed on Labor Routers 
and Work in Process detail. 

To add an Operation Code: 

 

1. Enter an Operations Code and Description. 

2. Click OK, Close, or Save as required. 

Viewing Operation Codes 

The records displayed in the Operations Code View depend on the query selected.  In the 
following example, we selected “All.” 
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From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

Product Revenue Class  

You can create product revenue classes to assign revenue and expense accounts to individual 
part numbers. When you assign a product revenue class to a part number, the revenue and 
expense accounts override the default COGS and department number on the sales order.  If you 
use an Accounting Link, this information will be passed through the Link to your accounting 
package.  
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To add a Product Revenue Class: 

 

1. Enter the new Product Revenue Class.   

2. Enter the Revenue and Expense account numbers. 

3. Enter a description for the Product Revenue Class. 

Once your product revenue codes are created, they will be accessible via hyperlink from the Part 
Master data entry form. 

Viewing Product Revenue Class Codes 

The records displayed in the Product Revenue Classes View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

Ship Via Codes 

You can enter Ship Via Codes to define shipping methods frequently used by your company, 
such as UPS, FEDEX, and so on. Once these codes are defined, they are accessible via 
hyperlink from Customers, Suppliers, Sales Order, and Purchase Order data entry forms. 
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To add a Ship Via Code: 

 

1. Enter a Ship Via Code and description. 

2. Click OK, Close, or Save as required. 

Viewing Ship Via Codes 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

System Used On Codes 

You can apply codes to components or assemblies to associate them with product lines. For 
example, in the sample Pen Database, the component “red ink” may be used in only one 
product—a red pen—while several different products may use a “spring.”  You may want to give 
the red ink a code to identify its family, while the spring might be coded as mixed use. This code 
simply provides one more way to analyze inventory.  Once your System Used On codes are 
created, they will be accessible by hyperlink from the Part Maintenance View.   
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To add a System Used On code: 

 

1. Enter a System Used On Code and Description. 

2. Click OK, Close, or Save as required.   

Viewing System Used On Codes 

The records displayed in the System Used On Codes View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

Terms Codes 

You can define payment terms codes that will print on sales orders, invoices, or on purchase 
orders.  Once you create the codes and descriptions, they will be accessible via hyperlink from 
the Customer sales order, Supplier, and purchase order forms. 
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To add a Terms code: 

 

1. Enter a terms code for each payment type you will use. 

2. Enter a description for the terms code. 

Viewing Terms Codes 

The records displayed in the Terms Code View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

ZIP Codes 

If you set up your system using the Default database, the ZIP Codes table will be populated with 
current United States ZIP codes.  These are accessible from all address windows in the system. 
 You may need to enter a new ZIP code from time to time; however, it is more likely that you 
would use this feature as a lookup table.   

To look up a Zip Code: 

Select File>Codes>ZIP Codes.  
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1. Choose by City or by State and enter the city or state name in the dialog box. 

2. Click Save. The ZIP Codes View list displays only the ZIP codes for the city or state entered.  

 

To enter a new Zip Code: 

Select File>Codes>ZIP Codes>New (or select Edit>Add New from the Zip Codes View list) to 
open a blank ZIP Codes form. 
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1. Enter the new ZIP code in the key field at the top of the form. 

2. Enter the City, State, County, and (Phone) Area Code. 

3. Time from GMT and DST information are optional.  

Customer Discount Codes 

Alliance/MFG offers both customer and product discount setup options.  The following sections 
describe how to set up the codes that govern discounts and how they are applied in the system. 

Customer Discount Types 

Alliance/MFG gives you flexible customer discount options by offering three discount types: 

None - Customer always gets list price, no discount applied (User can still edit the customers 
price)  

Discount % - Flat Percent Discount applied on all orders 

Quantity Discount - A combination of Product Discounts, Customer Discount Levels, and 
quantity ordered 

After you set up the discount codes and structures described in the following sections, these 
options will be accessible from the Customers data entry forms. Each customer can be assigned 
a unique pricing type on the basis of either a Discount %, (flat percent rate) or the Quantity 
Discount (quantities and products) they buy.  When customer orders are entered, the discount 
type and description will be displayed on the Sales Order, and the Sales Order Detail will 
calculate the actual discount applied to that particular line item based on this type.  

The following sections describe how to setup each customer discount type. 

None (No Discount) 

No discount code needs to be set up to apply this type to a customer.  Simply select None as the 
Discount Type on the Customers Discount Type Tab data entry form. 
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The customer will get the list price no matter what quantity or parts they purchase. Authorized 
users can still override the List Price when necessary. 

Discount % 

Price Discount Codes are used to assign a flat discount percentage to this specific customer type 
(Discount Percent).  In the example below, the customer with a Price Discount Code of EDU 
would get a straight 10% discount no matter what parts or how many they buy.  

To Set up Customers for Discount % 

Step 1 - Set up your Price Discount Codes 

To add a new Price Discount Percent Code: 
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1. Enter a Price code and description for the code. 

2. Enter the Discount % for the code. 

3. Click Save, OK, or Close, as required. 

Once you set up the code, you can select it from the Price Discount Codes View. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access 
related data; preview or print a report.  

You can enter as many Price Discount Codes (price types) as you need.  These codes 
will then be accessible from the Customers Discount Type Tab data entry form.   

Step 2 - Set up the Customer’s Discount Type 

When you enter the customer record, select Discount % as the Discount Type.  The sales order 
entry function will automatically look up the Discount % for the Customer's Price Code, and apply 
the appropriate percentage discount each time you enter an order. 
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Quantity Discount  

This Customer Discount Type is based on a combination of the Customer Level and Product 
Type. You can define discount levels for each type of customer you do business with.  For 
example, give a reseller or a distributor different pricing than your standard retail customers. 
Once you set up Customer Discount Level codes, you can use them in combination with Product 
Discount codes to create Price Break Structures on the basis of quantity ordered. 

When you enter a sales order for a customer that has been assigned Quantity Discount as the 
Discount Type, the system will automatically look up the product type for the part they purchased, 
and then apply the appropriate percentage discount based on the quantity they purchased.  (See 
Demand, Customers for more information on assigning Discount Levels.) 
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To set up a customer for Quantity Discounts 

Quantity Discounts are applied to customer sales orders depending on the Customer Discount 
Level assigned to the customer and the Product Discount Code for the parts they purchase.  

Step 1 - Set up the Customer Discount Level Codes 

To add a Customer Discount Level code: 

 

1. Enter a Customer Discount Level code, for example, RETAIL for retail customers, or DISTR 
for distributors. 
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2. In the  Discount Level tab, enter a Description for the code; for example, Volume Distributor. 
 You can enter as many discount level (customer types) as you need.  These levels will be 
accessible from the Customers data entry form 

3. After all your Customer Discount Levels and Product Discount Levels (described in the 
following section) are added, you can use the Price Break Structures tab to assign values to 
discount level and product combinations.   

Once you set up a code, you can select it from the Customer Discount Level View. 

 

From here you can add, edit, or delete a record; or via the sidebar drill down or access 
related data; preview or print a report. 

Step 2 - Set up the Product Discount Codes 

To add a Product Discount Code: 

 

1. Enter a code for the Product Price code. 

2. In the Product Discount Code tab, enter a Description for the code. 

3. When you are finished, click OK to save your settings and exit the form. 

The new code will be displayed in the Product Discount codes view. 
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From here you can add, edit, or delete a record; or via the sidebar drill down or access 
related data; preview or print a report. 

Step 3 - Set up a Price Break Structure 

To create a Price Break Structure: 

After you have set up Customer Discount Levels and Product Discount Codes, you can create a 
Price Break Structure to associate a discount with a customer, a part, and a quantity purchased. 

To add a Price Break Structure: 

Select File>Codes>Price Break Structures>New. A blank data entry form is displayed 

1. Enter or select Customer Discount Level for this Price Break Structure 

2. Enter or select Product Discount Code for this Price Break Structure 

3. Enter a Price Break Quantity 

4. Enter the discount for this customer level, product code and quantity purchased 

5. Enter a Description for the discount if desired 

6. When you are finished, Click OK, Close, or Save as required 
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In the following Price Break Structure View, a customer assigned the DISTR Discount Level 
purchasing parts assigned Product Discount Code of BPP gets a 10% discount for quantities of 
500 up to 999 and a 12% discount for purchasing quantities of 1000 up to 4999. 

 

Once you create a Price Break Structure, you can access it from the Codes menu, and from the 
Customer Level and Product Discount Types Codes data entry forms. 

Unit of Measure Conversions 

You must define a stocking UOM for each part on the Part Master.  Inventory transactions into 
and out of stockrooms will be converted to the stocking UOM. Once UOM codes are defined, you 
can access them from various data entry forms in the system; the conversion units displayed 
depend on what form you open.  For example, the Part Master always displays inventory costs in 
the stocking unit of measure, while a Purchase Order form may display in the Purchase unit of 
measure, if different from stocking units of measure. 

Base Units 

Unit of measure conversions are calculated from and to five base units of measure.  The five 
base codes are first set up in the Unit of Measure codes table and then selected as the Base 
Code in the Company Preferences window.  (See Company Preferences, in this section, for more 
information.)  The five base UOM codes are unit, length, weight, volume, and area. 
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The far right column indicates “True” with a check mark if this code is a Base Unit of Measure. 

Unit of Measure Codes 

You can buy, build, and ship/sell a part in your stocking UOM, or define alternate UOM’s as 
needed. If you create alternate UOM’s, however, you must define a conversion rate back to 
stocking units. For example, if you purchase springs by the gross; but stock and issue by the unit 
each; a purchase order placed for a quantity of one (1) gross will show 144 each when received 
into stock.  You would define a UOM conversion rate to inform the system as to the number of 
EACH units are in 1 GROSS. 

Converting Between Like UOM Types - If the conversion is between UOM’s of the same type 
(both are lengths, both are weights, and so on) the conversion is performed by the UOM codes 
table. 

Converting Between Different UOM Types - If the conversion is between UOM’s of different 
types, for example, you purchase a material by the “pound” but stock it by the “EA,” for use in 
production, you must create a Density Code and then assign this density code in the Part Master 
record for that part.  This conversion will be done by the Density Codes table. (See Density Code, 
in the following section.) 

All Unit of Measure codes created for the system are displayed from the Unit of Measure Codes 
View list.  Each entry defines how many Base units are associated for each UOM Code. If you 
used the Default database to set up your system, the five base units of measure will already be 
defined. You can enter additional definitions as required. 
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 To enter a new Unit of Measure Code: 

 

1. Select File>Codes>Unit of Measures Codes>New (or click Edit>New Record from the Unit of 
Measure Codes View list) to open a blank Unit of Measure Codes form. 

2. Enter a new UOM Code in the key field at the top of the form. 

3. Enter a description for the code. 

4. Enter a Conversion Factor from the Base Unit for the code.  

5. Select a UOM type from the drop-down list. 

6. Check the box if this is a Base Unit. 

7. Click OK, Close, or Save as appropriate. 

Density Codes  

MRP considers stock on hand and on order to recommend POs and WOs as needed. This is a 
simple task when you purchase and use materials that can be calculated in like measures, such 
as feet-to-inches or pounds to ounces. (Like calculations are based on entries in your Units of 
Measure table.) If, however, you purchase material by the “pound” but use it in production by the 
“each,” you must supply MRP a basis for conversion between different base measures.  

If product manufacturing requires conversion between different measure types, you can use a 
density code to perform the conversion.   

For example, you may purchase small screws by the pound, but stock them by the each for use 
on assemblies according to your bill of materials.  If each pound contains a thousand screws, a 
representative unit for one screw would be .001.  If your base unit of measure is “EA,” then you 
would create a density code to compute: .001 = EA.   
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To add a Density code: 

1. Enter a Density code. 

2. Enter the appropriate conversion per unit.    

3. Enter a description for the code. 

Viewing Density Codes  

The records displayed in the Density Codes View depend on the query you select.  

 
From here you can add, edit, or delete a record; or via the sidebar drill down or access related 
data; preview or print a report. 

NOTE:   

You must enter your base UOM codes before you can enter UOM conversion ratios in the 
UOM codes table.  Remember:  Changing your base UOM will alter the conversion 
ratio of all UOM’s of the same type. 

Using Unit of Measure and Density Codes   

Following are two UOM setup scenarios that will help you understand how to use this feature. 
 Remember: for conversion of same types (length-to-length), use UOM.  For conversions of 
different types (weight-to-length), use Density. 
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EXAMPLE 1:  You purchase screws by the pound, but stock them by the each.  There are 100 
screws per pound: 

UOM Table - Setup pounds (weight) and each (unit), if needed.   

Set 1 LB = 16 OZ. 

Base UOM - Setup EA as your base unit, and OZ as your base weight. 

Density Table - Create a new density called “SCREWS.” Fill out the table as follows: 

Each screw equals: 

Weight:  0.16000 ounces (weight) * 

Sample math:  100 EA = 1 LB =16 OZ, solve for 1 EA (divide by 100): 

100/100 EA = 1/100 LB = 16/100 OZ 

1 EA = .01 LB = .16 OZ 

*  Because the base unit for weight is ounce, you must convert pounds to ounces first.  

After all tables are set up as shown, you can assign UOM values on the Part and Inventory 
masters as follows: 

Part Master (ENG Tab  - Enter EA as the UOM  and SCREW as the density. 

Part Master (Inventory Codes Tab) - Enter LB as the UOM Purchase. 

EXAMPLE 2:  You purchase carbon rods by the pound, but stock them by the inch.  Each rod 
weighs 6 OZ and is 12 inches long: 

UOM Table:  Set up ounces (weight) and inches (length), if needed. 

Base UOM:  Set up OZ as your base weight, and IN as your base length. 

Density Table:  Create a new density called “RODS”.  Fill out the table as follows: 

NOTE: 

Because you must fill in a length, weight, and volume for each density, you may consider 
using the number “1” for any unneeded values (as used in the following example). 
 Multiplying or dividing by 1 will not change the value of the number. 

Each ROD equals: 

Length:  12.00000 Inches 

Weight:  6.00000 Ounces (Weight) 

Volume:  1.00000 Fluid Ounces 

Enter IN as the UOM on the Part Master Engineering tab, RODS as the density, and on the Part 
Master (Inventory Codes Tab) - Enter LB as the UOM Purchase. 

Variable or Catch Weights  

If your products are stocked and sold/shipped in boxes, but each box could be a different weight 
and your products are priced by the weight of the box , you probably want to create and use a 
Catch Weight. A catch weight can be set up and maintained in the Part Master for each product 
you sell (See the Part Maintenance, Inventory Control Tab section for more information on 
assigning Catch Weights).   
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Print 
Printing Reports in Alliance/MFG 

Alliance/MFG provides a number of standard reports for each function, they are listed at the end 
of each section.  Once you have queried and displayed an Alliance Report, the Print menu 
selection is enabled.  

To preview a Bill of Materials Report from the sample Pen Database: 

If you are not already in the Pen Database, login now. Select Products>Reports>Bill of Materials. 
The Bill of Materials Query dialog box opens.  

 

1. Enter an assembly, for example, BPP-100. 

2. Click Apply.  The Report Preview window displays the report.   

3. From here you can resize the report display, page through the report, export the report, 
search the report text, or apply an additional filter to the report. 

NOTE: 

The dialog box opens with the default query setup by Alliance. To view additional queries 
or create a custom query, click on the drop down box. 

In the following example, the Bill of Materials report lists the Assembly, Description, Rev., 
number, and Stock UOM in the header.  The body of the report lists each component by item 
number in the BOM, along with a description, Rev. Number, Qty Per, UOM, Obsolete and 
Effective dates and the ISC Code. 

 

To print to the default printer click on the Print button on the bottom of the window. To change 
printers click on File>Print to display the printer dialog box.  Click on Close to exit. 

For more information about using Alliance/MFG standard reports, See the Alliance/MFG 
Technical Reference. 
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Products Menu Functions 
This section describes how to enter part information into your Part Master; how to create and 
maintain your Bill of Materials and product structures, and how to manage related documentation, 
engineering change notices, and part cross references.  All of the parts you use to create your 
assemblies and components are maintained in the Part Master, accessed from the Products 
selection on the Alliance/MFG Main Menu.  
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Part Master 
The Part Master is a file of all your parts. Everything you need to know about every part in the 
system is entered and stored in the Part Master.  Whether you are in engineering and design, 
planning and scheduling, sales, cost accounting, or just about any other company function, you 
will find information in the Part Master that you can use to efficiently perform your tasks. 

Tasks described in this section assume familiarity with the basic use of Alliance/MFG data lists, 
data entry forms, dialog boxes, queries, and finding and sorting features.  If you need more 
information about how to use these features, review the System Overview section. 

Creating New Part Information 

This sections describes how to manually enter parts into your part master; however, several 
options are available to import existing part numbers into the system.  See the Alliance/MFG 
Technical Reference additional data entry options. 

Engineering Tab 

You must define "at a minimum" a part number, description, and stocking unit of measure for 
each part.  Alliance/MFG provides many additional fields that you can use to add detailed notes, 
revision numbers, weight, dimensions, special storage and shelf life and other optional 
information. One record is required for each unique part that you make, buy, sell, or stock; 
whether it is a component, a subassembly, or the finished product. 

Adding new parts to the Part Master: 

From the main menu, select Product>Part Master>New.  A blank Part Master data entry form 
opens at the Engineering tab.  
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1. Enter a unique Part Number, according to your numbering conventions. 

2. Enter a Revision indicator, if needed. 

3. Enter a Description for the part. 

4. If this part is for engineering purposes only at this time, check the Inactive box. 

5. Enter a weight for one stocking unit of this part, if needed.  

6. Enter the Dimensions for one stocking unit of this part, if needed. 

7. Select Special Storage, if required. 

8. Enter the Shelf Life in days, if required. 

9. In the User Defined fields, you can enter up to ten digits of your choice. You can use 
these fields in custom queries and reports. 

10. Enter the path to any graphic you have stored in the system for this part.  If you know the 
path, type it in; or click the Graphic Path hyperlink to browse for the path.  You can then 
click Show Graphic to display the image. 

11. When you have finished adding a part or block of parts, do one of the following: 

Click Save to save your settings and leave the form open. 

Click Add to open another blank Part Master data entry form. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving. 

TIP: 

ENTER MINIMAL INFORMATION UNTIL YOUR CONFIGURATION IS LOCKED DOWN 

Your engineering department might go through a number of iterations before designs are 
validated and parts are approved.  It makes sense to enter just the “bare bones” 
until the design is locked down.  As long as there are no invalid icons on the Part 

Master data entry form, you have entered the minimum amount of data to create a 
valid record.  You can add MRP, Inventory, and Costing data later. The Inactive 

flag will prevent the part from appearing on queries for "All" parts, you must use the 
query button and select the "Obsolete Only" query. 

Notes Tab 

Click the Notes tab to add any additional information about the part.  You can add unlimited text 
here, including text cut and pasted from other Windows programs or text files. 

MRP Planning, Inventory Codes, Part Costs and Statistics Tabs 

Information used for MRP Planning, Inventory, Part Costs, and Statistics is not normally entered 
or used until the Bill of Materials and Product structures have been finalized.   

You’ll find detailed information about entering information in these tabs in the Inventory 
Control>Part Maintenance section. 
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Accessing Part Master data 

After parts are added to the system, Alliance/MFG gives you a number of ways to access the 
data.  

From the Products Menu 

The main menu is the first access level.  From here you can go straight to a blank form to enter 
new parts, edit existing part records, or use predefined queries to locate specific records. 

 

From the Part Master View 

Once parts are entered into the system, you can use the Part Master View to access all product 
related data in every other table in the system that contains a part.  Just highlight a record in the 
view and click on the related record in the sidebar.  

 

124 



Setting Up Your Products 

From here you can directly access all Part Cross References, ECN’s, Documents, and Inventory 
Quantities for the selected part. If the part is a component, you can display all occurrences of this 
part in all assemblies (Where-Used View).  If the part is an assembly or subassembly, you can 
display all of its components (Product Structure/BOM View). 

After MRP, Inventory, and Costing data has been added to the Part Master record, you can 
access additional tables via the sidebar.  (See the Inventory Control, Part Maintenance section for 
more information.) 
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Documents 
You can associate any number of documents to a part number.  For example, you may have a 
schematic, design drawing, specification, manufacturers product information sheets—any number 
of documents related to parts in your system.  Alliance/MFG gives you a place to organize this 
information, assign a Document ID, note the current location and revision numbers, and record 
effective dates. At a minimum, you must enter a Part Number and Document ID to create a valid 
record.   

Creating New document information 

Documents Tab 

Select Products>Documents>New to open a blank Part Documents data entry form.   

 

1. Enter a part number. The Revision and Stock UOM will display for the part selected. 

2. Enter a Document ID.  This can be any combination of up to 15 characters. 

3. Enter Optional information as required:  

4. Click the Document Path hyperlink to define a document location.   

You can open the document in its native program if the program is installed on your computer. 
 Click Show Document to open the file. 

Description - Enter a description of the document. 

Document Location - Enter the document storage/retrieval location. 

Document Revision - Enter a Document Revision number. 

Document Size - Enter the drawing size, or create a size code that users can readily recognize. 
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Job Number - If the part is associated with a particular job, you can attach the job number to the 
document record.  Enter the number or click the Job Number hyperlink to select one from the Job 
Number list. 

ECN Number – Documents are often generated or revised as part of the ECN process.  Enter the 
appropriate ECN number or click the ECN Number hyperlink to choose one for the ECN List. 

Effective and Obsolete Dates – Use the calendar boxes to enter Effective and Obsolete dates 
for the document. 

Notes Tab 

Click the Notes tab to add any additional information about the part.  You can add unlimited text 
here, including text cut and pasted from other Windows programs or text files. 

When you are finished, do one of the following: 

Click Save to save your settings and leave the form open. 

Click Add to open another blank data entry form. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving. 

To edit a Part Document record: 

Select Products>Documents>Edit and enter the Document ID to open the Part Document data 
entry form for the document selected.  Change the information in the fields as required, and click 
OK, Save, or Close as needed. 

Accessing Part Documentation Data  

Once you create part document records, Alliance/MFG gives you several ways to access the 
data. 

From the Products Menu 

The main menu is the first access level. From here you can go straight to a blank Documents 
data entry form to enter new document information, edit existing document information, or use a 
predefined query A function that can be customized to search for and extract records from a database to create a 
subset of records that match specific criteria. and wild cards to locate a specific record. 

 

From the Documents View 

The records displayed in the Part Documents View depend on the query you select. 
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From here you can add, edit, or delete a record; or via the sidebar you can drill down or access 
related data; preview or print a report. 
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Engineering Change Notices (ECN) 
Maintaining precise records of engineering process and design modifications is important to 
preserving the integrity of your parts database and the quality of your finished product.  Because 
manufacturing involves constant flux—product designs are changed, suppliers discontinue lines 
or go out of business, components are refined, materials are substituted—a means of tracking 
these changes is an essential part of an efficient manufacturing system. 

With the ECN feature, you can record the progress of parts through the normal design-to-
manufacturing release, as well as track modifications to design specifications, assemblies, or 
components in your database.  Additionally, you could identify parts in which defects have been 
discovered and stop production or shipments, or both. 

Creating New ECN information 

Select Products>Engineering Change Notice>New (or Click Add>New Record) to open a blank 
Engineering Change Notice data entry form. Enter an ECN Number or Name. 

 

ECN Tab 

1. Enter an ECN Classification Code. 

2. The ECN Date will default to “today.”  You can use the calendar box to assign another date, if 
needed. 

3. Enter the Employee ID for the ECN originator. 

Notes Tab 

1. Enter any notes related to the ECN.  These will print on any reports generated for the ECN. 
Notes could include modification or rework instructions, release notes, or specifications. 

ECN Parts Tab 

The ECN Parts tab displays Parts defined in the ECN.  From here you can add, edit, or delete 
ECN Part information. 
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1. Click Add to open the ECN Parts data entry form.  The ECN number continues to display at 

the top of the form. 

 

1. Enter the part number or click the hyperlink to select one from the Part Master View. 

2. Enter a phrase describing the change or action required. 

3. Add additional text describing the details of the change or background information. 

4. Click OK.  The new part is added to the body of the Engineering Change Notice form. 

5. When you are finished, do one of the following: 

Click Save to save your entries and leave the form open. 

Click Add to open another new ECN Parts data entry form. 

Click OK to save your entries and exit the Engineering Change Notice form. 

Click Close to exit without saving. 

130 



Setting Up Your Products 

To edit an ECN Number 

1. Select Products>Engineering Change Notice>Edit and enter an ECN number to open the 
ECN Notice data entry form for that record. 

2. Edit the information in the fields as required, then click Save, OK, or Close as required. 

Accessing ECN Data 

Once you have enter ECN’s records into the system, Alliance/MFG gives you a number of ways 
to access the data. 

From the Products Menu 

The main menu is the first access level. From here you can go straight to a blank Documents 
data entry form to enter new document information, edit existing document information, or use a 
predefined query and wild cards to locate a specific record. 

 

From the Engineering Change Notice View 

Records displayed in the Engineering Change Notice View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar you can drill down or access 
related data; preview or print a report. 
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GUI BOM 
Graphical User Interface 

After you have entered all parts into the Part Master you can use them to create your product 
structures (Bills of Materials), that is, an assembly made up of components and/or 
subassemblies.  You can select parts from the Part Master and assign them to an assembly using 
the Product Structure data entry form, or you can drag-and-drop parts into a graphical structure 
using the GUI BOM.  Once you have created a product structure, you can view it either from the 
GUI BOM or the Product Structure View list. Each method is described in the following sections. 

NOTE: 

The GUI BOM work area is a place to drag and drop parts from a part master list or view 
to create your Product Structures, rather than by manually entering the parts into a 
data entry screen to create your Product Structures. 

ALSO NOTE: 

A BOM is Bill of Materials, a Product Structure is a Bill of Materials, an assembly that has 
components is a Bill of Materials. 

Creating a new Bill of Materials using the GUI BOM 

The Graphical User Interface Bill of Materials (GUI BOM) is a single-paned window (work area) 
where you can view, create and modify a bill of materials. You can add parts to a structure, edit 
quantities, maintain effective or obsolete dates and other information.  The work area is drag and 
drop. 

Select Products>GUI BOM to open a blank GUI BOM work area window. 

 

Select Products > Part Master, then select ALL, or use a query to narrow the parts list You may 
drag a part number to the GUI BOM work area from any view containing part numbers. 
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1. Highlight the part number you want to drag to the work area.  The part can be an assembly or 
a component. 

2. Using the mouse, drag the part number to the open work area.  It will display at the top of the 
work area. 
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If the part is an assembly, its components will be displayed. A plus sign will indicate additional 
levels of subassemblies or components. 

Click on the plus sign to expand the structure and display these elements.   

Click on the minus sign to collapse the structure. 
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You can drag additional parts or subassemblies into the structure until you have the entire 
structure defined. Do not drag a part off of the work area, to remove a component, highlight the 
component in the product structure and click on the Delete Button. 

To Edit a Product Structure Record from the GUI BOM  

In the work area, highlight a component of an assembly and click on the Edit Button to open the 
BOM Edit window.  All existing field values will be displayed in the Component Tab. 
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1. The assembly the part belongs to and the component part number display at the top of the 
window along with their revisions. 

2. Enter/change the Item Sequence. 

3. Enter/change the quantity (per) of this part needed to complete one assembly. 

4. Enter/change the BOM UOM code, if different from the Stock UOM. 

5. Enter/change the Effective Date (the date you want the system to begin planning for this 
part). 

6. Enter an Obsolete if needed.  (The date you want the system to discontinue planning for this 
part.) 

7. Click on the Notes Tab to enter any notes you want associated with the part. 

8. When you are satisfied with the structure you have created, click Save to save your structure. 

9. Click on the Ref Designators Tab to enter any reference designators or notes you want 
associated with the component. This is normally used to identify like parts on a drawing or 
BOM when more than one (1) per is used on an assembly. 

 

CAUTION 

If you add, modify or delete a component of an assembly, that change becomes 
permanent to the assembly and also applies wherever that assembly is used within 
all product structures. 
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Product Structure  
After you have entered all parts into the Part Master you can use them to create your product 
structures (Bills of Materials), that is, an assembly made up of components and/or 
subassemblies.  You can select parts from the Part Master and assign them to an assembly using 
the Product Structure data entry form, or you can drag-and-drop parts into a graphical structure 
using the GUI BOM.  Once you have created a product structure, you can view it either from the 
GUI BOM or the Product Structure View list. Each method is described in the following sections. 

NOTE: 

The GUI BOM work area is a place to drag and drop parts from a part master list or view 
to create your Product Structures, rather than by manually entering the parts into a 
data entry screen to create your Product Structures. 

ALSO NOTE: 

A BOM is Bill of Materials, a Product Structure is a Bill of Materials, an assembly that has 
components is a Bill of Materials. 

Creating a New Bill of Materials Using the Product Structure 

One approach to creating a product structure begins with the lowest level subassemblies and 
builds to the top level assembly. The following instructions use this model. If all part numbers for 
raw materials, subassemblies and assemblies have been entered in your Part Master, you are 
ready to begin. 

Define all sub-assemblies and components in the structure 

Select Products>Product Structure>New, to open a blank BOM data entry form.  At a minimum, 
you must enter an Assembly, a Component  and a Quantity Per to create a valid BOM record. 
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1. Enter the Assembly part number. The parts description will display below the part number. 

2. Enter a component part number.  The parts description will display below the part number 
field. 

Components Tab 

1. Enter an item sequence number for this component.  It is a good idea to enter component 
numbers that allow you some capability to add/insert additional items later.  For example, use 
item numbers such as 10, 20, and 30 rather than 1, 2, and 3. 

2. Enter the quantity of this component used in creating one of this assembly. 

3. Enter the effective date to begin planning for this part in MRP (optional). MRP will plan 
immediately if this field is left blank. 

4. If you are phasing in a new part with a different number, you can specify an obsolete date for 
the old part to exclude it from planning on a specific date.  

5. Enter the BOM UOM Code for this part used in manufacturing this assembly if it differs from 
the parts stocking UOM.  Enter a code or click the BOM UOM hyperlink to select one from the 
UOM Code table. If you leave this field blank, the stock UOM will be used. 

NOTE: 

The system won’t allow you to enter a duplicate part in a product structure, or use a 
subassembly within itself.  If you enter a duplicate number by mistake, the green 
arrows will change to red icons and the error message “Record already exists” will 
display in the tool tip (to display tool tip error messages, hold the mouse cursor 
over the red icon). 
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Note Tab 

Enter unlimited notes relevant to this part in this assembly. 

Ref Designators Tab 

A reference designator where a component is located on a drawing or in assembly instructions, 
and can be used for material preparation, insertion, and/or lead forming information. 

You can create virtually unlimited reference designators for every component/assembly 
relationship in your product structure.  For example, if you create a circuit board that calls out 
three of switch “A” and three of switch “B”;  the reference designator for switch “A” could be S1, 
S2, and S4, as positions on the circuit board; the reference designator for switch “B” could be 
positions S3, S5, and S6.  Or, you could enter unlimited text instructions in the Notes field such 
as, “all leads must be tinned before insertion.” 

Adding a Reference Designator to a component record 

Click the Ref Designator tab.  A list of any reference designators created for the component 
displays.  

 

1. Click Add to open a blank Reference Designator dialog box. 

2. Enter a code or drawing reference designator.   

3. Enter a description of the reference designator, if needed. 

4. In the Notes area, enter a detailed instruction for the reference designator, if needed.  The 
code, description and notes will print in the BOM with References Report. 
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5. Click Close to exit the Reference Designator tab and return to the BOM data entry form, then 
do one of the following: 

Click Save to save your entries and leave the form open. 

Click Add to add another assembly/component. 

Click OK to save your entries and exit the form. 

Click Close to exit without saving.  (Previously saved entries will be saved.) 

Accessing Product Structure data  

After parts are entered in the Product Structure forms, either from Product Structure or GUI BOM, 
Alliance/MFG gives you a number of options for accessing the data. 

From the Products Menu 

The main menu is the first access level.  From here you can go straight to a blank Product 
Structure data entry form, edit existing product structures, or see a list of all product structures. 
You can copy a BOM, globally replace a component, or execute a Where Used search by using a 
predefined query. 

 

From the Product Structure (BOM) View 

The records displayed in the Product Structure (BOM) View depend on the query you select. 
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From here you can add, edit, or delete records; or via the sidebar you can drill down or access all 
data related to assemblies and components (part numbers) in the system; preview or print any 
BOM related reports.   

Copy BOM   

Often components in one BOM are similar to components in another.  You can copy components 
from one assembly to another using the Copy BOM Query.  Once the items are copied, you can 
then edit the BOM for minor differences before saving. 

To Copy Components from one BOM to another 

Select Products>Product Structure>Copy BOM. The Copy Product Structure query opens. 

 

1. In the From field, enter a part number to copy. 

2. In the To field, enter a part number to copy to. 

3. Click Copy.  
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Replace Component 

You may have occasion to replace a component in all BOM’s.  Use the Replace Component 
query to select the component to replace and the part to replace it with. 

To Replace Components in a BOM 

Select Products>Product Structure>Replace Component. The Replace Product Structure query 
opens. 

 

1. In the Replace field, enter a component to replace.  

2. In the With field, enter a component to replace it with.   

3. Click Replace. Note: Always use this feature with caution; once the replace button is clicked 
the action cannot be stopped until completed.  

Viewing a sample Product Structure 

Using examples from the Pen Database, you can look at the product structure for BPP-100, 
Assembly, Barrel, Blue. 
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1. In the Part Master View list, select BPP-100, then via the sidebar, click Product Structure 
(BOM) View.  The Product Structure (BOM) View list shows the parts and subassemblies that 
make up Assembly BPP-100 (a finished product).  This view tells you that there are four 
items in the assembly and how many of each item is used in the assembly.   

2. Click on Item Sequence 10, component B-01, then via the sidebar select Component BOM 
View, to drill down or view the components for that subassembly, you may continue to drill 
down through all levels of a product structure.  In this example, all second level components 
are raw materials, and no additional drill down is necessary.  

CAUTION ! 

If you add, modify or delete a component of an assembly, that change becomes 
permanent to the assembly and also applies wherever that assembly is used within 

all product structures. 
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Part Cross Reference 
You can relate your part numbers to OEM, customer, and supplier part numbers.  You can also 
attach helpful purchasing information such as Supplier Prices, Supplier Currency, Priority, 
Supplier Lead Times, and check whether or not the supplier is an approved source.  Every part 
can have an unlimited number of cross reference part numbers and descriptions.  Customer and 
Supplier cross references can be printed on Purchase Orders and Sales Orders. 

Creating a new Cross Reference 

Select Product>Part Cross Reference>New from the main menu, or click Add New from the 
Cross Reference View.  A blank Part X-Reference data entry form opens. 

 

1. Enter a part number or click the hyperlink to choose one from the Part Master View.  The 
Revision and Stock UOM display from the Part Master record for the part. 

2. Enter a Part Cross Reference to your part.  This can be any combination of numbers or 
characters. 

3. Enter the Supplier ID for the Part Cross Reference number. 

4. In the lower half of the window, enter a description for the cross reference. 

5. Select Approved Source if this supplier has been approved for this part. 

6. Enter a Supplier Lead Time. 

7. Enter the suppliers Price. 

8. Enter or select the suppliers Currency Code. The Purchase Order currency is defaulted from 
the Suppliers Currency Code. If the Part Cross Reference currency code entered here is 
different from the purchase orders Currency Code, the PO line item price will be set to zero 
(0). 
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9. Enter a Supplier Rating, if desired. 

10. Enter any additional codes or references in the User Defined fields. 

11. When you have completed your entries, do one of the following: 

Click Save to save your entries and leave the form open. 

Click Add to continue to add new cross references. 

Click OK to save your entries and exit the window. 

Click Close to exit the window without saving. 

Accessing Part Cross Reference Data  

Once your part cross references are created, Alliance/MFG gives you a number of options for 
accessing the data. 

From the Products Menu 

The main menu is the first access level.  From here you can go straight to a blank Cross 
Reference data entry form, edit an existing cross reference, or use a predefined to locate specific 
records. 

From the Part Cross Reference View 

The records displayed in the Part Cross Reference View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar you can drill down or access 
related data; preview or print a report. 
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Products Reports 
The following reports are available from the Products menu.  You can preview or print a report 
from a predefined query, or create a custom query to display specific information in an 
Alliance/MFG standard format.  For more information about Alliance/MFG reports, see the 
Technical Reference. 

Bill of Materials  

BOM with References 

Costed BOM – Pending Costs 

Costed BOM – Standard Costs 

Engineering Change Notice 

Indented BOM 

Indented Costed BOM 

Parallel Indented Costed BOM 

Part Master List 

Part Cross References 

Where Used 
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Demand Menu Functions 
This section describes how to maintain your customers and contacts, create and maintain 
forecasts, create, maintain and release The authorization to produce or ship material that has 
already been ordered. blanket/contract orders, enter and ship sales orders, invoice customers for 
shipments; and how to track discrete costs through the system using the Job Master Maintains a 
Job Number and description for each job being tracked as a discrete cost entity throughout the 
system and lets you view details associated with that job.. 

Creating Demand in your System 

Alliance/MFG is designed around the concept of “Supply and Demand.”  The customer orders 
and forecasts you create are the “demand” that, through the action of running and responding to 
MRP, generate purchase orders and work orders (the supply) in the system.   

Tasks described in this section assume familiarity with the basic use of Alliance/MFG data lists, 
data entry forms, dialog boxes, queries, and finding and sorting features.  If you need more 
information about how to use these features, review the System Overview section. 
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Customers 
Alliance/MFG gives you a variety of fields to use when creating your customer records.  In 
addition to basic information such as billing and shipping address, terms, and contact information; 
you can assign credit limits, hold shipments, and apply three different sales discount types.  You 
can access sales order, invoice, and shipment activity for a customer, and drill down from any of 
these to get more detail. 

Creating New Customer Information 

Enter a customer record for each customer you sell to.  If you have not yet defined codes related 
to customers; such as FOB, Region, Terms, Discounts, Ship Via, and Currency Codes; you 
should complete this task before entering customer records (Review the Setting Up Your 
Company section if you need more information.) 

Adding a Customer record 

Select Demand>Customers>New from the main menu to open a blank 

 

At a minimum, you must enter a Customer ID and Customer Name to create a valid record.   

LINK NOTE: 

If you use an Alliance Accounting Link, this code and name may need to match the record 
in your accounting package. 

Customer Tab 

1. Enter a date. The system will default to the current date; however, you can use the 
calendar box to select a different date.   
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2. Enter a Credit Limit, if needed. This entry is optional and for information only.  If you track 
this information, you could apply ship holds as necessary.   

3. Select the Ship Hold  Flag to prevent a sales order shipment for a customer. This flag will 
override the “Sales Order” Ship Hold flag on an individual sales order for the customer. 
 (A Ship Hold applied on an individual Sales Order for a customer without a  “customer” 
Ship Hold will only prevent shipment of that order.)  Once a customer Ship Hold is 
applied, all sales orders placed for that customer will automatically be on Ship Hold 
Status.   

4. Enter the Salespersons ID.  All sales orders generated for this customer will be linked to 
this Salesperson ID.  You can override this setting from the Sales Order data entry form.   

5. You can enter a up to 10-characters in the User Defined field for any additional code, 
number, or item you wish the system to display.  You can query on this field, or include it 
on Customer Reports. 

6. Enter a VAT Registration Number if you’re part of the European Economic Community. 
 This number is used in Intrastat Reporting to track Value Added Tax payments and 
receipts. 

7. Enter a VAT Branch ID. 

8. Enter the URL of the customer's website or a path to a document or contract you want to 
associate with this customer. 

NOTE:   

For more information about setting up Intrastat Reporting, see the Setting Up Your 
Company (ICN Codes, ICN Rates, Region/Country Codes), and the Inventory 
Control, Intrastat Reporting sections.   

Notes Tab 

Enter unlimited notes into the customer record.  Type into the body or copy/paste from another 
Windows program or text file. 

Default Codes Tab 

Enter the customer’s default codes.  These codes will default values to new customer sales 
orders. 

1. Enter an FOB code.  (This field will default to the FOB Code field on the Sales Order data 
entry form.)  The code name will display next to the field. 

2. Enter a Region code. (This field will default to the Region code field on the Sales Order data 
entry form.)  This information is also used with Intrastat Reporting. The code name will 
display next to the field. 

3. Enter a Terms code.  (This field will default to the Terms Code field on the Sales Order data 
entry form.) The code name will display next to the field. 

4. Enter a Ship Via code.  (This field will default to the Ship Via Code field on the Sales Order 
data entry form.) The code name will display next to the field. 

5. Enter a Currency code.  (This field will default to the Currency Code field on the Sales Order 
data entry form.) The code name will display next to the field.  
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Discount Type Tab 

You can assign a customer one of three price discount types;  None, Discount %, or Quantity 
Discounts. This discount will be automatically calculated and applied to all new customer sales 
orders.  You can override this discount if you wish.  The discount is applied after the quantity field 
is entered on the sales order line item. Discount % and Customer Discount Levels must exist in 
your codes tables so you can enter or select them here.  For more information about creating and 
applying these codes, see the Codes section, and Setting up Customer Discounts.   

 

1. Select a Price Discount Type from the drop-down list.  The Price Code or Customer Discount 
Level fields are enabled depending on your selection.  If you select None, you are finished 
with this tab.  If you select Discount %, the Price Code field is enabled; see Step 2. If you 
select Quantity Discounts, the Customer Discount Level field is enabled; see Step 3.   

2. Discount % - Enter the discount code in the field or select from the Price Code hyperlink. 

3. Quantity Discounts - Enter the customer level in the field or select from the Customer 
Discount Levels hyperlink. 

Addresses Tab 

You will enter customer address information via the Addresses tab.  You can assign as many 
customer bill to and ship to addresses as needed. If you only define one (1) Ship To Address and 
one (1) Bill To Address these values will default to new sales orders for that customer. 
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Adding an Address ID 

In the Addresses tab, click Add to open a blank Customer Address data entry form. 

 

151 



Alliance/MFG User Guide 

1. Enter an Address ID at the top of the form.  You could use “Ship To” or “Bill To”, an 
abbreviated city or location, or a store # or ID.  

2. Both the Ship To and Bill To flags default as checked, if this is OK move to the Address Tab, 
or uncheck if incorrect. 

3. Enter up to four address lines for this ID. 

4. Enter the City, State, Zip Code, Country, and Postal code, as needed. 

5. Enter a Tax Code. This will be the default tax rate for taxable items on sales orders with this 
address. 

6. When you are finished, do one of the following: 

Click the Contacts tab to add contact information for this address. 

Click Close.  The Address is added to the body of the Customers Addresses tab. 

Click Add to enter additional addresses as required. 

Adding Contact Information 

Click the Contacts tab.    

 

1. Click the Add button to open a blank enter form. 

2. Enter a Contact ID at the top of the form.  This could be the contact’s initials, first name, or 
simply a number. If you define a single ShipTo Address with a single Ship To Contact, and a 
single Bill To Address with a single Bill To Contact, these values will default to new sales 
orders for that customer.  
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3. Enter the Contact Name, Phone and Fax numbers, and e-mail address, if applicable.   

4. Click the Notes tab to enter any additional information you wish to store in the system about 
the contact. 

5. Click close to return to the Customer form and click OK or Save to save your entries.  

Accessing Customer Data  

Once customers are added to the system, Alliance/MFG gives you a number of ways to access 
the data. 

From the Demand Menu 

Select Demand>Customers from the main menu.  From here you can use the submenus to go 
straight to a blank data entry form to enter new customer records, edit existing records; or use 
predefined queries and wild cards to locate specific records. 

From the Customer View 

The records displayed in the Customer View depend on the query you select.  

 

From here you can add, edit, or delete a record; or via the sidebar you can drill down or access 
related data; preview or print a report.  
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Forecasts 
Forecasting is a powerful production management tool that projects expected demand over a 
predetermined planning period. With forecasting, you can create a demand on the manufacturing 
process based on anticipated seasonal orders.  For example, if you know from experience  that 
December is an exceptionally large month and you have had trouble meeting orders in the past 
because of inadequate supplies, you may want to enter a “holiday forecast” to help prepare for 
the anticipated surge in demand.   

Overview 

MRP recommendations based on forecasted demand represent an accurate picture of what you 
can expect and what you must purchase or manufacture to meet your anticipated demand. 

You can prepare multiple “what if” forecast scenarios and analyze their impact on the system. For 
example, you could create three forecasts for a product, each for a different quantity, all with the 
same dates.  Run MRP three times, each time with a different forecast included in the calculation. 
 From the results, you can easily see where the process is compromised, select the forecast that 
best suits your needs, and proceed. 

This section gives you the basic ground rules for forecasting, briefly describes the use of time 
fences in forecasting, and tells you how to create and maintain forecasts in Alliance/MFG. 

Ground Rules for Forecasting 

• Forecasts within the time fence parameter are ignored 

• All past due forecasts are ignored 

• All open sales orders lines that have scheduled ship dates within the forecast period will 
consume the forecast 

• If sales order quantities exceed forecast quantities within the forecast period, the system 
plans for the greater quantity 

Using a Time Fence 

A time fence A date or period of time that indicates to MRP that forecasts within this period should be ignored and 
only actual sales orders should be planned. For example, if you forecast 100 of part A for the 6th, with a time fence of 3, 
on and after the third, MRP will ignore the forecast. defines a time boundary inside which the forecast will be 
ignored and only actual sales orders will be used for planning. The boundary is set based on the 
forecast period end date.  By accurately defining your time fence, you can reallocate inventory 
planned for, but not consumed. 

Creating and Maintaining Forecasts 

Forecasts affect MRP the same way sales orders affect MRP, except that no customer 
information is entered. Parts entered in forecasts are normally finished products, spare parts, or 
repair items.  When you enter a forecast, you can choose to include it or exclude it from an MRP 
calculation.   

To create a forecast: 

Select Demand>Forecasts>New from the main menu to open a blank Forecast data entry form.  

1. Enter a Forecast ID. 

2. Enter the forecast information in the tabs as described in the following paragraphs. 
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Forecast Tab 

1. Enter an Employee ID. 

2. Select an Origination date from the Calendar box. 

3. Select Include in MRP Calculation if you wish your forecast to be considered in MRP 
planning. (The space bar toggles this selection on and off.) 

Notes Tab 

Enter unlimited notes about the forecast. 

Forecast Parts Tab 

Click the Part Numbers tab to open the Forecast Parts data entry form.  
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1. The Forecast ID displays at the top of the form. 

2. Click Add to enter a part number and time fence.  The Forecast Parts data entry form opens. 

3. In the Sales Horizon tab, enter the number of days from the end of the forecast period the 
forecast should be ignored  

 

Example: For your September Forecast, starting on the 1st and ending on the 30th, you forecast 
sales of 50 units. In your business you estimate that if sales haven’t been booked by the 20th of 
the month, they will probably not happen that month. Set your time fence at 10 days. When MRP 
is run on the 20th (or after), if you have only booked 40 sales the system will ignore the forecast 
and free up that inventory to be used somewhere else. 

Forecast Quantity Tab 

 

1. In the Forecast Quantity tab, click Add to open the Forecast Quantity data entry form.  
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2. Enter Start and End dates for the forecast. The forecast demand for inventory will be planned 
for the start date.  

3. Enter a Forecast Quantity. The forecast quantity will be consumed (reduced by) all sales 
order lines with scheduled ship dates that fall within the date range. 

4. When you are finished, do one of the following: 

Click Close to save your entries and return to the Forecasts Parts form. 

Click Add to open a blank Forecast Parts data entry form and create forecasts for a 
different part number, repeating the previous steps. 

Accessing Forecast Data 

Once forecasts are added to the system, Alliance/MFG gives you a number of ways to access the 
data. 

From the Demand Menu 

The main menu is the first access level.  From here you can go straight to a blank data entry form 
to create a new forecast, edit existing forecasts, or use a predefined and wild cards to locate a 
specific record. 

From the Forecast View 

The records displayed in the Forecast View depend on the query you select. 

 

From here, you can add, edit, or delete a record; or via the sidebar you can drill down or access 
related data; preview or print a report. 
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Quotations 
The Quotations function allows you to create and maintain unlimited quotes for a customer or 
prospective customer. Enter as much or as little information as you need. When and if the order is 
awarded, you may convert the quotation into an actual customer order to be included in the MRP 
calculation as demand for a product or service. Quotations will require a valid part number and 
customer when converted to a sales order, until then you may keep related information in a notes 
field, if desired. If the quote is for a prospective customer and you don’t wish to enter all prospects 
into your customer file, just keep the information in the quotes Notes field and only add the 
prospect if you actually get the order. 

Creating a Quote 

Select Demand>Quotations>New, to open a blank Quotation data entry form.  

Entering Quotation Information 

The Quote data entry form opens at the Order tab.  Header information will remain in view as you 
work your way through the tabs. As quotation line items are entered, the Quote Total amount 
value will display at the bottom of the form. 

  

Header Information 

1. If you specified auto numbering in your Company Preferences, the next incremental quotation 
number will be entered automatically when you save the order, otherwise you must enter a 
unique quotation number. 

2. Enter a Customer ID. The customer name displays below the field.  
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3. Customer Defaults Button - When you select a Customer ID, default customer information 
such as Currency Code, Salesperson ID, Bill To and Ship To Address values are defaulted 
from the Customer record to the new quote.  You may change the default values as needed. 
If you make changes, then decide to return to defaults, simply click the Customer Defaults 
button to refresh. 

Order Tab 

1. Enter a quote Expiration Date, this date will determine if the quote is open or closed. If the 
date is less than today the quote will be considered closed.  

2. Enter the Employee ID of the salesperson to be referenced with the order.  The employee 
name displays below the field. This value will default if set up on the customer record 
otherwise the login user id will be defaulted. 

3. Enter a valid currency code. The exchange rate will be displayed. 

4. If there is only one customer Bill To, Ship To, Bill To Contact and Ship To Contact these 
values will default from the customer record. If there is no customer record, do not enter 
these fields. 
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Lines Tab 

The lines tab gives you access to line item detail including line number, cross reference, part 
number, quantity, price and tax information.  From here you can edit existing line items or add 
new ones. The Quote Detail data entry form contains two tabs, line and notes. The form opens at 
the Line tab, and displays the Quotation Number, Customer ID, Customer Discount Type and 
Line Number in the header. Here you may enter detailed information about the part quoted; 
including the quantity, price, discount given and any tax information. At a minimum you must 
enter a part number and quantity to create a valid line record. If there is no part number, you may 
use the Line Notes Tab to enter a description of the item being quoted and any additional 
required information.   

 

Click the Add button on the left side of the form to open the Quotation Detail data entry form. 
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1. Enter a cross-reference to the customer’s part number if required. If only one (1) customer 
cross reference exists for the part number entered and it is checked as an Approved Source, 
the cross reference field will be defaulted. (Optional field) 

2. Enter the part number. The part number will default if you entered a Part Cross Reference 
above. 

3. Enter the quantity ordered for this line item. 

4. Enter the unit price. If the customer record is set up for a discount, that discount will be 
applied automatically, or you can manually enter the customer price.  The list price for the 
part will be displayed for information only.  

5. If this line item is taxable, select the Taxable Flag A check box used to turn sales tax on or off. . If the 
part taxable flag is set up in the Part Master this flag will be defaulted to True. Enter a Tax 
Code. If the part taxable flag and tax code are set up in the Part Master this value will be 
defaulted. 

6. If the Sales UOM is different than the Stocking UOM, enter the sales UOM code. 

7. The Line Amounts box displays the line item price multiplied by the quantity as the Line 
Amount, adds any Base Tax applied, then computes the Line Subtotal. 
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Line Notes Tab 

The line notes tab can be used in lieu of entering a part number or to hold additional information 
about that line. 

NOTE:   

All data in both the header and the line notes fields print on the Quotation Report. DO 
NOT enter sensitive data or data not meant to be viewed by your customers. If you 
need to enter sensitive data, first modify the Quotation Report to disable the 
printing of these fields.     

 

Notes Tab 

If you do not intend to create line items and/or part numbers you may use the notes tab on the 
quotation header to define the quote details. Nothing else is needed until you are awarded the 
quote and intend to convert it to a customer sales order. 
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Sales Orders 
Sales orders are the primary demand that drives the system.  Once sales orders are entered into 
the system, MRP will use the part numbers, quantities, required dates, and  planning codes to 
plan material requirements and create planned orders.  (Planned sales orders, closed sales 
orders and sales order line items marked “closed” do not generate demand.)  The system also 
uses customer and sales order data to create reports, shipping documents and invoices.  

Sales order entry, blanket orders, customers, shipments, invoices, and returns are all maintained 
through the Demand menu.   

If you have not yet defined customers and codes related to customers such as FOB, Region, 
Terms, Ship Via, and Currency Codes; you should complete this task before to entering sales 
orders. 

Creating a sales order 

There are two methods for maintaining and entering sales orders in Alliance/MFG, Advanced and 
Easy Entry. The Advanced method gives you more capabilities and additional field selections 
without having to toggle between screens to enter alternative data or change default values. On 
the other hand, if your customers can be set up with standard default values and only basic data 
is required, the Easy Entry method might save you entry time and efforts. You can toggle from the 
Advanced method to the Easy Entry method by clicking on the Easy Entry hyperlink in the upper 
right hand corner of the entry screen, you may also toggle back to the Advanced screen using the 
Advanced hyperlink.  

Select Demand>Sales Orders>New, to open a blank Sales Order data entry form. The last type 
of entry screen (Advanced or Easy Entry) used will open. The Advanced method is detailed below 
and the Easy Entry method will be described at the end of this section.  Blanket or Contract 
Orders, which can also be used to create sales orders, are discussed later in this section. 

 

 

The Advanced Sales Order data entry form opens at the Order tab.  Header A record containing 
common, constant, or identifying information for a group of records which follows. information will remain in view 
as you work your way through the tabs. As sales order line items are entered, the Sales Order 
Total amount and the Total Remaining value display at the bottom of the form.   

Sales Order Header  

1. If you specified auto numbering in your Company Preferences, the next incremental sales 
order number will be entered automatically when you save the order, otherwise you must 
enter a unique sales order number. 

2. Enter a Customer ID. The customer name displays below the field.  
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3. Customer Defaults Button - When you select a Customer ID, default information such as 
Terms, Ship Via and FOB values are defaulted from the Customer record.  If you make 
changes, then decide to return to defaults, simply click the Customer Defaults button to 
refresh. 

4. The Status is automatically defaulted to Firm when creating a new sales order. If the sales 
order is created from a Blanket Order the status will be defaulted to Planned. Caution, 
Planned sales orders are considered in MRP calculations but CANNOT be shipped until 
changed to Firm. See Blanket Orders later in this chapter. 

5. When entering a new sales order, the Closed box should be unchecked.  You can return to 
select the Closed check box when the order is shipped or close it automatically from the 
Shipping transaction form.  

6. Select the Ship Hold box to prevent this order from shipping.  If Ship Hold? has been applied 
on the customer record, the customer record status will override this entry. 

 
Order Tab 

1. Order Date - The Order Date defaults to “today’s” date, or you can use the calendar box to 
specify a different date. 

2. Date Required - The Date Required defaults to “today’s” date, or you can use the calendar 
box to specify a different date. This is the date MRP will plan to ship the order on. Activate 
the date by checking the checkbox. 

3. Date Promised - The Date Promised defaults to “today’s” date, or you can use the calendar 
box to specify a different date. This is the date you promised the customer to deliver on. This 
date in for information only, it is NOT used by MRP.    
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4. Department Code - The Department Code value will default if set up in Company Preferences 
or you may enter a Department Code.  The department account number displays below the 
code field. This should be the department associated with the GL account for this order 
(normally COGS).  

5. Salesperson - Enter the Employee ID of the salesperson to be referenced with the order. 
 The employee name displays below the field. This value will default if set up on the customer 
record. 

6. Job Number - If you wish to use the Job Tracking feature, enter the job number. The Job 
Number description displays below the field. 

7. Class Code - The Class Code is for QuickBooks accounting link use See your QuickBooks 
accounting link Help File or Users Guide. 

8. Ordered By - You may enter the name of the customer contact or the person placing the 
order.  

9. Customer PO - You may enter the Customer PO number. This information is optional; 
however, if you use it, you can access sales orders for this customer PO using the predefined 
queries on the Sales Orders submenu. 

10. Attention  - An entry in the Attention field will be printed on the Alliance/MFG shipping 
documents. 

11. Blanket Order - You may enter a Blanket Order number. If this SO was created from a 
Blanket/Contract Order this field will be defaulted. 

12. Quote Number - Enter a quote number, if applicable.   

13. Order Type - Enter Phone, FAX, EDI, or another method to denote how the order was placed. 

14. Entered By - The Entered By field value will default to the user login id. 

15. SO Total Amount and SO Remaining Amount are system calculated values.  

Customer Tab 

When you select a customer in the SO Header, the system defaults the customer’s code data. 
You may change the data if required. Code descriptions display below the fields. 
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1. Enter a Terms code or accept this customers default entry. 

2. Enter a Region code or accept this customers default entry. 

3. Enter an F.O.B. code or accept this customers default entry. 

4. Enter a Ship Via code or accept this customers default entry. 

5. Enter the Currency Code or accept this customers default entry. This currency and exchange 
rate will be displayed when you print the sales order report. The Conversion Rate will display 
based on the rate entered in the Currency Code Table. 

6. Enter a Bill To Address ID or accept this customers default entry. 

7. Enter a Bill To Contact or accept this customers default entry. 

8. Enter a Ship To Address ID or accept this customers default entry. 

9. Enter a Ship To Contact or accept this customers default entry. 

10. Enter a Document Path if you are referencing a drawing, contract or other document (This 
field is for internal use only and will not print on the sales order). 

NOTE: 

If the Ship To Address or shipping method has changed you may update the SO line 
items tax code by pressing the Update Tax (Upd.Tax) button. 
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Lines tab  

The sales order lines tab gives you access to line item detail on the sales order including line 
number, part, quantity, and tax information.   

From here you can edit existing line items or add line items.  

 

Click the Add button on the left side of the form to open the Sales Order Detail data entry form.  

NOTE: 

The New and Copy New buttons on the toolbar are for creating another sales order, not 
adding a line item. 

1. The SO Detail data entry form contains two tabs. The form opens at the Line tab, and 
displays the SO Number, Customer ID, and SO Line in the header. Enter detailed information 
about the part ordered; including the quantity, scheduled ship date, and tax information. At a 
minimum you must enter a part number and quantity to create a valid record.    

2. Enter a cross-reference to the customer’s part number if required. If only one (1) customer 
cross reference exists for the part number entered and it is checked as an Approved Source, 
the cross reference field will be defaulted. (Optional) 

3. Enter the part number. The part number will default if you entered a Part Cross Reference 
above. 
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1. Enter the quantity ordered for this line item and sales UOM. 

2. The customer price will default from the customer part cross-reference.  

NOTE: 

If the part cross reference currency code does not match the sales order currency code 
the price will be set to zero (0). 

If no part cross reference exists for this customer the price will default from the part master List 
Price. If the customer record is set up for a discount, that discount will be applied automatically, or 
you can manually enter the customer’s price.  The list price for the part will be displayed for 
information only.  

NOTE: 

If the customer’s currency code is different from your base currency code and the 
exchange rate is greater than 1.0, the Exchange Price field will be displayed. You 
may enter a fixed exchange price and Alliance will convert this amount to your 
base currency using the currency exchange rate table. 

1. If this line item is taxable, select the Taxable Flag. If the part taxable flag is set up in the Part 
Master this flag will be defaulted to True. 

2. If you select Taxable, enter a Tax Code. If the part taxable flag and tax code are set up in the 
Part Master this value will be defaulted. 

3. If the Required Date was entered on the sales order header that value will be defaulted to the 
Scheduled Ship Date; however, you can override it on a line item basis if you wish. Use the 
calendar box to select a different date. 
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4. Check the Closed? box if this line item is closed.  MRP will only plan open line items.  Closing 
an order on the Sales Order header will automatically close all line items, regardless of 
whether this box is checked. 

5. The Line Amounts box displays the line item value multiplied by the quantity as the Line 
Amount, adds any Base Tax applied, then computes the Line Subtotal.   

More Tab 

Click the More tab to enter additional line information such as Product Class Code and any multi-
tiered tax values. 

 

The system will apply the Base Tax rate by default.  However, you can enter 2nd and 3rd Tax 
Rates in the appropriate fields to apply multi-tiered (compound) tax rates.  To apply these taxes, 
do one or both of the following: 

NOTE: 

You must select the Taxable Flag in the Line Tab to enable the multi-tier tax fields on the 
More Tab. 

Select the Tax on Tax 2 checkbox to apply a second tax amount to the original 
subtotal (quantity x price plus tax), enter the second Tax Code you wish to apply.  

Or leave the Tax on Tax 2 checkbox empty to apply a second tax amount to the 
original quantity x price only (the no tax on tax option). 

Select the Tax on Tax 3 checkbox to apply a third tax amount to the original subtotal 
(quantity x price plus tax), enter the third Tax Code you wish to apply.    

169 



Alliance/MFG User Guide 

Or leave the Tax on Tax 3 checkbox empty to apply a third tax amount to the original 
quantity x price only (again the no tax on tax option). 

The Line Amounts box will display the Base Tax from the previous tab, compute a subtotal, then 
compute and add a 2nd and 3rd tax as applicable to compute the Extended price for this line 
item. 

1. Last Ship Date – Displays the last ship date for this line item.  

2. Quantity Shipped – Displays all quantity shipped against this line item. 

3. Quantity Returned – Displays all quantity returned for this line item. 

4. When you have finished entering or editing line items, do one of the following: 

Click Save to save all entries and leave the form open. 

Click OK to save all entries and exit the Sales Orders data entry form. 

Click Close to exit the form without saving any entries not saved previously. 

Using the Easy Entry Sales Order method 

There are two methods for maintaining and entering sales orders in Alliance/MFG, Advanced and 
Easy Entry. If your customers can be set up with standard default values and most of the time 
only basic data is required, the Easy Entry method might save you entry time and efforts.  

Select Demand>Sales Orders>New, to open a blank Sales Order data entry form. The last type 
of entry screen (Advanced or Easy Entry) used will open. You can toggle from the Advanced 
method to the Easy Entry method by clicking on the Easy Entry hyperlink in the upper right hand 
corner of the entry screen, you can also toggle to the Advanced screen using the Advanced 
hyperlink. The Easy Entry method is detailed below and the Advanced method is described at the 
beginning of this section.   
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The Easy Entry Sales Order data entry form opens.  All information entered will remain in view as 
you work your way through the form. As sales order line items are entered, the Sales Order Total 
amount and the Total Remaining value display at the bottom of the form.   

Entering Sales Order Header Information 

1. If you specified auto numbering in your Company Preferences, the next incremental sales 
order number will be entered automatically when you save the order, otherwise you must 
enter a unique sales order number. 

2. The Order Date defaults to “today’s” date, or you can use the calendar box to specify a 
different date. 

3. Enter a Customer ID or click on the Customer ID hyperlink to select from your customer table. 
When you enter a Customer ID, default customer information such as Terms, Ship Via and 
FOB codes are defaulted from the customer record to the sales order, additionally, if you 
defined a single ShipTo Address with a single Ship To Contact, and a single Bill To Address 
with a single Bill To Contact, these values will also default to a new sales order. If the values 
did not default click on the hyperlink to select them from their appropriate tables.  

4. To enter sales order notes click on the Notes hyperlink, enter your notes and click the Close 
button. The first line of the notes will be visible on the sales order. 

5. When entering a new sales order, the Closed box will normally be clear.  You can return to 
select this box when the order is shipped or you may close it from the Shipping transaction 
form. 

6. Enter a Terms code or accept this customer’s default entry. 
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7. Enter an F.O.B. code or accept this customer’s default entry. 

8. Enter a Ship Via code or accept this customer’s default entry. 

9. Enter the Currency Code or accept this customer’s default entry. When you print the sales 
order report, this currency and exchange rate will be displayed. The Currency Rate will 
calculate and display based on the conversion rate between your base company currency 
code and the customer currency code. 

10. Enter the Customer PO number. This information is optional; however, if you use it, you can 
access sales orders for this customer using the predefined queries on the Sales Order 
submenu. 

11. Enter the Employee ID of the salesperson associated with the order. This value will default if 
set up on the customer record. 

12. Enter a quote number, if applicable.  If you are creating a quote, mark the order Closed to 
prevent it from creating demand until it is a firm sales order. 

13. If you wish to use the Job Tracking feature, enter the Job Number or click on the Job Number 
hyperlink to select from your Job table. 

14. Enter the date the customer requests the completed order. The Required Date defaults to 
“today’s” date, or you can use the calendar box to specify a different date. If you enter a date 
here it will automatically default to all line items.  

NOTE: 

If you make changes to defaulted fields, then decide to return to default values, simply 
click the Advanced hyperlink, click the Customer Defaults button to refresh the 
default values, then click the Easy Entry hyperlink to return to this form. 
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Adding a new Sales Order Line item 

 

1. Tab into or click in the Part Number field, enter a part number or click on the elispse button to 
select one from the part master table. The part description will default from the Part Master 
table.  

2. Enter the quantity ordered for this line item in the sales UOM. As soon as you leave the 
quantity field the customer’s price will be calculated based on the customers part cross-
reference and/or discount codes if applicable.  

3. If the Sales UOM is different than the Stocking UOM, enter the sales UOM code. 

4. Enter the date the customer requests the completed order. The Required Date defaults to 
“today’s” date, or you can use the calendar box to specify a different date. If you entered a 
date in the sales order header it will automatically default to all line items.  

5. The Extended Price field is automatically calculated by multiplying the line item price by the 
quantity then adding any base tax applied.  

6. If you have correctly entered your line items a green “+” will be displayed in the Line field (the 
green plus sign will change to a line number when the record is saved. If any field is invalid a 
red “X” will be displayed in the Line field and the invalid field will display a red background, 
the Save and OK buttons will be disabled.  
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7. Click on the down arrow in the Line field to add notes to that line item, toggle to the Advanced 
Line Item entry form for that line item, delete that line item or to view the MRP Action screen 
or Inventory Lots screen for that part number. 

Click Save to save all entries and leave the form open. 

Click OK to save all entries and exit the Sales Orders data entry form. 

Click Close to exit the form without saving any entries not saved previously. 

NOTE: 

The fields shown below are part of the complete sales order record even though they are 
not displayed on the Easy Entry form. Some of these fields may default from 
related tables. They can be viewed, entered and edited by clicking on one of the 
Advanced hyperlink toggles. If one of these fields is invalid the Save and OK 
buttons will be disabled and the record cannot be saved. 

Advanced Sales Order fields not displayed 

Sales Order Header  

1. Department code, the departments account number will display below this field. This should 
be the department associated with the GL account for this order (usually COGS). This value 
will default if set up in Company Preferences. 

2. Ordered By, the name of the customer contact or the person placing the order. (Optional) 

3. Attention, an entry in this field will be printed on the shipping documents. (Optional) 

4. Order Type, enter Phone, FAX, EDI, Blanket, or another method to indicate the order type. 
(Optional) 

5. User Field 1, (Optional) 

6. Ship Hold, select the Ship Hold box to prevent this order from shipping.  If Ship Hold? has 
been applied on the customer record, the customer record entry will override this entry. 

7. Class Code, the Class Code is for QuickBooks accounting link use. See your QuickBooks 
accounting link Help File or Users Guide. 

8. Document Path, you may enter a Document Path if you are referencing a drawing, contract or 
other document (This field is for internal use only and will not print on the sales order). 

Sales Order Line Item  

1. Part X Reference, enter a cross-reference to the customer’s part number if needed.  If only 
one (1) customer cross reference exists for the part number entered and it is checked as an 
Approved Source, the cross reference field will be defaulted.(Optional) 

2. Part number, the part number will default if you entered a Part Cross Reference above. 

3. Taxable Flag, if the part taxable flag is set up in the Part Master this flag will be defaulted to 
True. The Tax Code can be defaulted from either the customers ship to address record or the 
part master record.  

4. Closed? Check the box if this line item is closed.  MRP will only plan open line items.  Closing 
an order on the Sales Order header will automatically close all line items, regardless of 
whether this box is checked. 
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Sales Order Line More Tab 

5. The system will apply the Base Tax rate by default.  However, you can enter 2nd and 3rd 
Tax Rates in the appropriate fields to apply multi-tiered (compound) tax rates.  To apply these 
taxes, do one or both of the following: 

6. Select the Tax on Tax 2 checkbox to apply a second tax amount to the original subtotal 
(quantity x price plus tax), enter the second Tax Code you wish to apply. Or leave the Tax on 
Tax 2 checkbox empty to apply a second tax amount to the original quantity x price only (the 
no tax on tax option). 

7. Select the Tax on Tax 3 checkbox to apply a third tax amount to the original subtotal 
(quantity x price plus tax), enter the third Tax Code you wish to apply. Or leave the Tax on 
Tax 3 checkbox empty to apply a third tax amount to the original quantity x price only (again 
the no tax on tax option). 

Click Save to save all entries and leave the form open. 

Click OK to save all entries and exit the Sales Orders data entry form. 

Click Close to exit the form without saving any entries not saved previously. 

Accessing Sales Order Data 

Once sales orders are added to the system, Alliance/MFG gives you a number of ways to access 
the data. 

From the Demand Menu 

Select Demand>Sales Orders from the main menu.  From here you can go straight to a new, 
blank Sales Order data entry form, edit an existing sales order, or use predefined queries and 
wild cards to locate specific records. 

From the Sales Order View 

The records displayed in the Sales Order View depend on the query you select.  

 

From here you can add, edit, or delete a record; or via the sidebar you can drill down or access 
related data; preview or print a report. 
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Blanket Orders 
The Alliance/MFG Blanket Order feature provides the tools for managing quantities and 
scheduling shipments originating from a contract. The Blanket order defines the contracted 
quantity and rests atop the Sales Order, effectively controlling the “Firming” and “Release” of the 
scheduled shipments. The shipping schedule may or may not be agreed to in advance (Firm), it 
may be updated as the dates move in on the planning horizon and additional information about 
actual requirements is known. The existing sales order in Alliance essentially stays the same, 
with a few additional fields required by the blanket order. Customer defaults, contract pricing and 
billing information will automatically default from the blanket order to each sales order created. 
You may enter different Ship To information for each firm release (sales order) as needed. You 
can create both planned and firm shipment schedules (sales orders), the only difference is you 
cannot ship a planned shipment (sales order). Planned sales orders created from blanket orders 
are not ignored by MRP. If you want to plan material for the entire contract quantity, you must 
create either Firm or Planned Shipments (sales orders) for the entire blanket order quantity. As 
you manage the blanket order shipment quantities and dates, MRP will manage the material plan 
accordingly. The blanket order will contain summary information for quantity, price, firm orders, 
planned orders, shipped, past due, returned and allocations remaining.  

Creating a Blanket or Contract Order 

Select Demand>Blanket Orders>New, to open a blank Blanket Order data entry form. When 
creating a blanket or contract order you will normally go through the same steps as when creating 
a sales order. 

The Blanket Order data entry form opens at the Order tab.  Header information will remain in view 
as you work your way through the tabs. As order line items are entered additional summary 
information will display at the bottom of the form.   

 

Blanket Order Header  

1. If you specified auto numbering in your Company Preferences, the next incremental blanket 
order number will be entered automatically when you save the order, otherwise you must 
enter a unique blanket order number. 

2. Enter a Customer ID. The customer name displays below the field.  

3. Customer Defaults Button - When you select a Customer ID, default information such as 
Terms, Ship Via and FOB values are defaulted from the Customer record.  If you make 
changes, then decide to return to defaults, simply click the Customer Defaults button to 
refresh. 
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4. When entering a new blanket order, the Closed box should be unchecked.  You can return to 
select this box when the entire contract order is shipped.  

Order Tab 

1. The Order Date defaults to “today’s” date, or you can use the calendar box to specify a 
different date. 

2. Enter the name of the customer contact or the person placing the order. 

3. Enter the Customer PO number. This information is optional; however, if you use it, you can 
access sales orders for this customer PO using the predefined queries on the Blanket Orders 
submenu. 

4. Enter the Employee ID of the salesperson to be referenced with the order.  The employee 
name displays below the field. This value will default if maintained in the customer record. 

5. If you wish to use the Job Tracking feature, enter the job number. The Job Number 
description displays below the field. 

6. The Date Required defaults to “today’s” date, or you can use the calendar box to specify a 
different date. This is the date MRP will plan to ship the order on. Activate the date by 
checking the checkbox. 

7. Enter a Ship Via code or accept this customers default entry. 

8. Enter a Ship To Address ID or accept this customers default entry. This field will only default 
if a single Ship To address is maintained for this customer. Right click to view All ship to 
addresses for this customer.  

9. Enter a Ship To Contact or accept this customers default entry. This field will only default if a 
single Ship To Contact is set up for this address. Right click to view All ship to contacts for 
this ship to address.  

10. An entry in the Attention field will be printed on the shipping documents. 

11. The Create Sales Order check box is used to create Planned and Firm sales orders. The use 
of this Create button will be discussed as the final step of the Blanket Order section. 
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Customer Tab 

When you select a customer in the Blanket Order Header, the system defaults customer’s data. 
 You may change the data if required. The code descriptions display below the code fields. 
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1. Enter a Terms code or accept this customer’s default entry. 

2. Enter a Region code or accept this customer’s default entry. 

3. Enter an F.O.B. code or accept this customer’s default entry. 

4. Enter the Currency Code or accept this customer’s default entry. This currency and exchange 
rate will be displayed when you print the sales order report. The Conversion Rate will display 
based on the rate entered in the Currency Code Table. 

5. Enter a Bill To Address ID or accept this customers default entry. 

6. Enter a Bill To Contact or accept this customers default entry. 

7. This should be the department associated with the GL account for this order (usually COGS). 
This value will default if set up in Company Preferences or you may enter a Department 
Code.  The department account number displays below the field.   

8. Entered By will default to the user login id. 

Lines tab 

The blanket order lines tab gives you access to line item detail including line number, part, 
quantity, and tax information. From here you can edit existing line items or add line items.  

Click the Add button on the left side of the form to open the Blanket Order Detail data entry form.  
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The BO Detail data entry form contains three tabs. The form opens at the Line tab, and displays 
the BO Number, Customer ID, and BO Line in the header. Enter detailed information about the 
part ordered; including the quantity, scheduled ship date, and tax information. At a minimum you 
must enter a part number and quantity to create a valid record. 

 

1. Enter a cross-reference to the customer’s part number if required. If only one (1) customer 
cross reference exists for the part number entered and it is checked as an Approved Source, 
the cross reference field will be defaulted. (Optional) 

2. Enter the part number. The part number will default if you entered a Part Cross Reference 
above. 

3. If the Sales UOM is different than the Stocking UOM, enter the sales UOM code. 

4. Enter the contract quantity ordered for this line item and sales UOM. 

5. The customer price will default from the customer part cross-reference. If the customer record 
is set up for a discount, that discount will be applied automatically, or you can manually enter 
the customer price.  The list price for the part will be displayed for information only.  

6. If this line item is taxable, select the Taxable Flag. If the part taxable flag is set up in the Part 
Master this flag will be defaulted to True. 

7. If you select Taxable, enter a Tax Code. If the part taxable flag and tax code are set up in the 
Part Master this value will be defaulted. 

8. Enter a Sales UOM Code if different from the Stocking UOM Code. The stocking UOM is also 
displayed. 
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9. Check the Closed Flag box if this line item is closed. Closing an order from the Blanket Order 
header will automatically close all blanket order line items, regardless of whether this box is 
checked. This flag will NOT affect sales orders created from this blanket order, sales orders 
must be closed separately.  

10. Enter a customer line number if desired. 

11. The Line Amounts box displays the line item value multiplied by the quantity as the Line 
Amount, adds any Base Tax applied, then computes the Line Subtotal.   

NOTE: 

If the customer’s currency code is different from your base currency code and the 
exchange rate is not 1.0, the Exchange Price field will be displayed. You may enter 
a fixed exchange price and Alliance will convert this amount to your base currency 
using the currency exchange rate table. 

More Tab 

Click the More tab to enter additional line information such as Product Class Code and any multi-
tiered tax values. 

 

NOTE: 

You must select the Taxable Flag in the Line Tab to enable the multi-tier tax fields on the 
More Tab. 

You can enter 2nd and 3rd Tax Rates in the appropriate fields to apply multi-tiered (compound) 
tax rates.  To apply these taxes, do one or both of the following: 
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Select the Tax on Tax 2 checkbox to apply a second tax amount to the original 
subtotal (quantity x price plus tax), enter the second Tax Code you wish to apply.  

Or leave the Tax on Tax 2 checkbox empty to apply a second tax amount to the 
original quantity x price only (the no tax on tax option). 

Select the Tax on Tax 3 checkbox to apply a third tax amount to the original subtotal 
(quantity x price plus tax), enter the third Tax Code you wish to apply.    

Or leave the Tax on Tax 3 checkbox empty to apply a third tax amount to the original 
quantity x price only (again the no tax on tax option). 

1. The Line Amounts box will display the Base Tax from the previous tab, compute a subtotal, 
then compute and add a 2nd and 3rd tax as applicable to compute the Extended price for this 
line item. 

2. The Blanket Order Summary box will display the current status of this line for this blanket 
order. 

3. Last Ship Date –  Displays the last ship date for this line item.  

4. Past Due - Displays Total Quantity Remaining for open Firm sales orders with past due 
Required Dates 

5. Total Shipped – Displays the total quantity shipped against this BO line item. 

6. Total Returned – Displays the total quantity returned for this BO line item. 

7. Planned Shipments - Displays the Total Quantity Ordered for Planned sales orders plus the 
Total Firmed for all Firm sales orders  

8. Total Firmed - Displays the Total Order Quantity for open Firm sales orders or net Quantity 
Shipped for closed Firm sales orders 

9. Allocations Remaining - Balance of the contract order not planned or firmed (Ignored by 
MRP) 

10. When you have finished entering or editing line items, do one of the following: 

Click the Save button on the toolbar to save all entries and leave the form open. 

Click Close to exit the line item form and return to Blanket Order form, then either  

Click OK to save all entries and exit the Blanket Orders data entry form. 

Click Close to exit the form without saving any entries not saved previously. 

Creating Scheduled Shipments (Sales Orders) from Blanket Orders 

You may create as many scheduled shipments (sales orders) as required to consume the entire 
contract order quantity. If the quantities and required dates are known, create Firm Sales Orders, 
if the required dates, quantities or ship to locations are not known, but you want to plan materials, 
create Planned Sales Orders (you will have to establish via your “Best Guess” or a tentative 
shipping schedule, both the required date and quantity for MRP to plan with).  

From the Demand Menu 

Select Demand>Blanket Orders from the main menu.  From here you can go straight to a new 
blank Blanket Order data entry form, edit an existing blanket order, view open blanket orders, or 
use predefined queries and wild cards to locate specific blanket orders.  
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Example: 

1. In our example below the quantities and required dates are known for the next quarter only, 
the balance is subject to minor changes. We will create three (3) Firm sales orders and the 
balance as quarterly Planned sales orders.  

2. Select the blanket order you wish to schedule.  

3. Review the BO Order Tab to insure the Required Date is set for the first Sales Order Ship 
Date and that the Ship To Address is correct (You may ship to multiple locations, 
warehouses, etc.). Click the Create Sales Order check box at the top right side of the form, 
then click the Create button.  

4. The system will automatically create a Planned Sales Order and default the majority of 
information from the blanket order.  

5. If a Promised Date exists, check the box and enter it (informational only). This is normally the 
required date (Ship Date) plus any transit time. For Firm orders change the Status from 
Planned to Firm.  

6. Verify the information in both the Order Tab and Customer Tab is accurate. 

 

Click on the Line Tab and enter the first shipment quantity. Verify the rest of the information on 
the Lines Tab is accurate. Click on the More Tab to enter additional taxes or the Notes Tab to 
enter Notes (Notes will not be automatically defaulted or copied by the system). Click on the 
Close button, Click on the OK button to save the sales order. 
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The system will return you to the Blanket Order you started from, continue to create additional 
firm and planned orders as required. Remember to change the Required Date and Ship To 
Address as needed before pushing the Create button and the Promise Date and Status before 
saving the order.  

To review the orders you have created and view the current status of the contract/blanket order, 
click on the Lines Tab, Edit and then the More Tab.  
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To view a list of all the sales orders created from this blanket order, click on Sales Orders (All) in 
the Related Views section of the Sidebar. 

 

You may also print the Blanket Order Summary Report, linked in the Sidebar or from the 
Demand>Reports menu. 
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Shipments and Returns 
Sales Order Shipments 

The Alliance/MFG shipments feature is flexible and easy to use. You can ship all lines or a single 
line item on a sales order, and you can invoice a customer for the sales order shipment. Mark the 
order closed or leave it open, depending on how much of the order is shipped.  Once a sales 
order is shipped, you can also return individual line items from a customer and issue credit 
memo’s. If you created sales orders from Blanket Orders, you can only ship Firm Sales Orders, 
not Planned Orders. 

Shipping a Sales Order 

Select Demand>Sales Order Shipments to open a SO Shipments transaction form. You can ship 
detail line items from this form. For a new shipment, the lines in the Header of this screen will be 
empty. As you fill in the sales order number and ship from this sales order, the shipment 
information displays in the body of the Shipments Tab. 

 

Creating a Sales Order Shipment 

1. Enter a Sales Order number or right click on the SO Number hyperlink for predefined queries. 

2. The Ship Date will default to “today’s” date.  You can use the calendar box to change it if 
required. Both the entered Ship Date and the actual transaction date will be recorded in the 
Transaction Log. 

3. The Entered By field defaults from the system Login. The system also generates a 
Transaction Group number for each shipment transaction to identify record specific 
transactions. 

186 



Working with Demand 

4. You can assign this shipment to a new invoice number or add it to an existing one.  (See 
Invoicing a Customer later in this section for more information.) If you selected Invoice 
Required in your Company Preferences, you must complete the header portion of the invoice 
prior to shipping the order. 

 

Selecting Items for Shipment 

All sales order line items are displayed on the SO Detail Tab. You can ship all lines or select a 
line item for shipment.  

1. To ship all lines on the sales order, click the All button on the left side of the form.  The 
available inventory for all line items will display in the Quantity Shipped column.  The 
Remaining column will show any balances that were not available for shipment.  

2. To ship individual line items, highlight the line item you wish to ship, and click Ship Line 
button. All available stock for the line item selected will display in the Quantity Shipped 
column.  The Remaining column will show any balance not available for shipment. 

NOTE: 

An invalid icon may appear on the Shipments tab to remind you that you must perform an 
additional action to complete the shipment; for example, if you have specified 
Require Invoices in Company Preferences, you must create an invoice before you 
can complete the transaction. 

You can continue to select lines and ship them.  When you are finished, click on the Shipments 
tab. The body of the form will show the quantities shipped and the stockrooms and locations the 
stock came from.   
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At this point, you can create the invoice, fill in the Bill of Lading, Carrier, and so on. (See Creating 
and Editing an Invoice, later in this section for more information.) 

You can also edit the quantities, stockroom, and location at your discretion; click Apply, and then 
print shipping documents. 

Editing the Shipment  

You can edit the quantity shipped and the stockroom and location on a line item in the SO 
Shipments data entry form. 

In the Shipments tab, select the line you wish to edit and click Edit.  The Shipments data entry 
form opens for the line item selected. 
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1. You can edit the Stockroom, Location, and quantity; add an SN/Lot Number or Job Number; 
or enter up to 60 characters of your choice in the Tran Info field. If the part master Require 
SN/Lot Number field is checked you will be required to enter a lot or serial number. 
Additionally, if the part master record contains a Catch Weight and Catch Weight UOM, you 
will be required to weigh the shipment.    

2. When you are satisfied with your shipment, click Close to save your entries and return to the 
Sales Order Shipments tab. 

3. When you are satisfied with the line items in the shipments data entry form, you are ready to 
create an invoice. (See Invoicing a Customer, for more information.) 

4. When you have finished adding shipments and creating invoices from the Shipment form, do 
one of the following: 

Click Apply so save your entries and leave the form open. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving any entries not applied or saved. 

RETURNING A CUSTOMER ORDER 

The Alliance/MFG returns feature is flexible and easy to fit to your particular needs. You can 
return all lines or a single line item on a sales order, and you can issue a credit memo to a 
customer for all or a single line item or quantity of the sales order. If the sales order has been 
marked “closed,” you must open it to receive returns, and issue a credit memo against it. 

Creating a Sales Order Return 

Select Demand>Sales Orders>Return a Customer Order to open the Returns data entry form. 
For a new shipment, the lines in the Header of this screen will be empty. As you fill in the sales 
order number and return from this sales order, the return information displays in the body of the 
SO Returns Tab.  
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To Create the Sales Order Return 

1. Enter the Sales Order Number for the item you wish to return. 

2. The Return Date will default to “today’s” date.  You can use the calendar box to change it at 
your discretion.  

3. The Entered By defaults to the workstation Login ID. 

4. Enter the Credit Memo Number by clicking on the New Button.  

You can assign this return to a new credit memo number or add it to an existing one.  (See 
Creating a Credit Memo for a Customer later in this section for more information.) 

Selecting Items for Return 

1. All sales order line items are displayed on the SO Detail Tab. You can return all lines or 
select one line item for shipment.  

2. Click the All button on the left side of the form.  The returned quantities will display in the 
Quantity Returned column. 

or 

3. Select the item you wish to return, and click the Return Line button on the left side of the 
form. The returned quantity will display in the Quantity Returned column. 

4. You can continue to select and return lines.  When you are finished, click the SO Returns tab. 
The body of the tab will show the quantities returned and the stockrooms and locations the 
stock will be returned to.   

NOTE: 

You can return a partial quantity on a line item.  See Editing the Return in the following 
section. 
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At this point, you can create the credit memo, and exit the returns transaction form.  You can 
return later to fill in the Bill of Lading, Carrier, and other optional information.  (See Creating a 
Customer Credit Memo later in this section for more information.) 

Editing a Returned Line 

You can edit the quantity returned and the stockroom and location on a line item in the Returns 
data entry form. 

In the SO Returns tab, select the line you wish to edit and click the Edit button on the left side of 
the form.  The SO Returns data entry form opens for the line item selected. 

 

1. The SO number, SO line item, and Part Number display in the SO Returns header. 

2. You can edit the Stockroom, Location, and quantity; add an SN/Lot Number or Job Number; 
or enter up to 60 characters of your choice in the Tran Info field. If the part master Require 
SN/Lot Number field is checked you will be required to enter a SN/Lot number. Additionally, if 
the part master record contains a Catch Weight and Catch Weight UOM, you will be required 
to weigh the return.    

3. When you are satisfied with your edits, click Close to save your entries and return to the 
Sales Order Returns tab. 

4. When you are satisfied with the line items in the Returns transaction form, you are ready to 
create a credit memo, if required. (See Issuing a Customer Credit Memo, for additional 
Information.) 

5. When you have finished adding returns and creating credit memos from the sales order, do 
one of the following: 

Click Apply to save your entries and leave the form open.  

Click OK to save your entries and exit the data entry form. 

Click Close to exit the data entry form without saving any entries not applied or saved. 
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Invoicing and Credit Memos 
INVOICING A CUSTOMER 

Invoices can be created and printed when the shipment transaction is performed.  You can add 
Bill of Lading, Carrier and Tracking number information as required.   

If you wish to enforce invoice creation at each shipment transaction, you must specify Require 
Invoices in your company Preferences setup. (See Chapter 3: Setting Up Your Company, 
Preferences.)  

Creating and Editing an Invoice 

You can create a new invoice from the main menu at any time, or you can create an invoice at 
the time of shipment from the Shipment transaction form. 

Create an Invoice from the SO Shipments Transaction Form 

In the SO Shipments Header, click the Edit button next to the Invoice field to add information to a 
new invoice for the line items selected.  If you specified auto numbering in your Company 
Preferences, the system will apply the next sequential invoice numbers according to your 
numbering format.  If not, enter a unique invoice number in the field. 

If you wish to add this shipment to an existing invoice, click the IVNumber Hyperlink to select an 
existing invoice. The Invoice Number and current invoice amount will display in the header, along 
with the SO number and Customer ID.  

Logistics Tab 

The Invoice data entry form opens at the Logistics tab where you can add the Bill of Lading, 
Carrier, Tracking number and Freight amount.  Two User fields are also available to add more 
detail, and you can click the Notes tab to enter any additional information.  If the bill of lading and 
carrier information is not available at the time the shipment transaction is performed, you can 
open this invoice later and add the information.  Click Close to return to the Invoice form. 
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Invoice Detail tab 

Click the Invoice Shipment tab to add or edit line items on the invoice. 
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Click Close to save your entries and return to the Sales Order Shipments data entry form. 

Accessing Invoice Information 

Once invoices are created, Alliance/MFG gives you several ways to access the data. 

From the Demand Menu 

Select Demand>Invoices to access the Invoices submenu.  From here you can go straight to a 
blank invoices data entry form to create a new invoice, or use a predefined query and wild cards 
to find the invoice you want. 

From the Invoices View 

The records displayed in the Invoices View depend on the query you select. 

 

From here you can add, edit or delete a record; drill down or access related data; preview or print 
a report. 

Issuing a Customer Credit Memo 

To Issue a Credit Memo: 

Enter the information in the tabs as described in the following sections. 

Sales Order Detail Tab 

On a SO Return, click the New button next to the Credit Memo field to add a new credit memo. 
 The Credit Memo data entry form opens at the Logistics Tab. 

1. In the header, enter a unique number for the credit memo.   

2. The Customer ID will display for the line item selected. 

3. Enter the sales order number you wish to issue the credit memo for. 

4. Enter an invoice number. 

5. The Return date defaults to “today,” however, you can change it at your discretion. 

6. Optional Fields - Enter the Bill of Lading, Carrier, Tracking Number, any user define 
information, Freight Amount, and number pieces in the shipment, as required. 
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Credit Memo Detail Tab 

The line item detail from the return displays in the Credit Memo Detail tab.  

 

You can accept the information as is, or you can add or edit from here.  For example, you may 
want to adjust the quantity or price of the credit being issued.   

Click Add or Edit as required to open the Credit Memo Detail data entry form.  
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The Credit Memo Detail header displays the credit memo number and line in the header.  The 
Credit Memo Detail tab displays the Part Number and description along with the original sales 
order line item and quantity.   

Tax Codes and Rates Tab 

Click the Tax Codes/Rates tab to review tax information. The Tax Summary displays the 
calculated results.  
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Completing the Credit Memo 

When you have completed your entries, click Close to return to the Credit Memo data entry form, 
and do one of the following: 

Click Apply to save your entries and leave the form open. 

Click Add to enter additional Credit Memo lines. 

Click Close to exit the data entry form without saving your entries (no credit memo will 
be created). 

Click OK to save your entries and exit the data entry form. 
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JOB MASTER 
When you enter a specific job number on a sales order, MRP will order discrete purchases and 
plan discrete work orders for that job number.  As the parts required to complete the sales order 
move through the system, all costs for parts with the assigned job number will be tracked and 
totaled.   

If you apply Job Tracking to products with complicated, multilevel BOM's, or to a large number of 
orders, MRP Action Parts could easily generate an overwhelming number of discrete orders that 
may be difficult for a small manufacturer’s staff to process. 

Job Master Tracking setup involves other functions 

1. Create Job Numbers using the Job Master feature. 

2. Assign the Order Method Code to the parts you wish to track in the Part Maintenance, MRP 
tab: Job Tracking, Plan by Job. 

3. Enter the Job Number on the Sales Orders you wish to track. 

4. Run MRP. 

When you view MRP Action Parts, you can select Job Tracking to display only those jobs that 
have tracking numbers assigned. 

You can apply job tracking in a number of ways: 

• Track costs for a unique order or part. 

• Run a periodic job tracking to compare actual costs to your cost estimates. 

• Track accumulated costs for parts ordered on a specific contract. 

Once Job numbers are created, parts coded OMC “J” and Sales Orders with Job Numbers will be 
tracked. For example, when you place multiple sales orders totaling 100 for a part number that 
has been assigned the OMC “J,” all 100 of the requirements are considered in MRP planning; 
however, if 20 of those requirements have also been associated with a specific job number, MRP 
will break the 20 job-ordered units into separate purchase orders and work orders.  All the costs 
associated with that job number can then be tracked through the Job Master feature. 

Creating Job Numbers in the Job Master 

You can create unlimited job numbers in the system.  You must first create a job number and 
then in the Part Master, MRP tab, assign “Job Tracking, plan by job” as the  Order Method Code.  

When you enter a sales order for an item you want tracked by job number, enter the job number 
on the Maintain Sales Order data entry form, Order button tab.  Alliance/MFG will now discreetly 
track all costs associated with that job number. 

Once sales orders, purchase orders, or work orders are created with the job number, the Job 
Master  shows the progressive costs. 

Viewing Accumulated Costs in the Job Master 

Select Demand>Job Master to open the Job Master View.  Select a Job Number and click Edit to 
open the Job Master for Job Number selected. 
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The Job Master displays the job number and description (as entered in the Job Master data entry 
form).  You can enter information in two User Defined fields and also indicate if this particular job 
number is closed.  

The Job Master is divided into three sections: Sales Orders, Purchase Orders, and Work Orders. 

 

The Sales Order column displays the dollar values of Total Ordered, Total Shipped, Total 
Returned, and Sales Order Net Amount for any parts in the system assigned to the selected job 
number.  The Purchase Order and Work Order columns will remain empty until actual purchase 
orders and work orders have been created. 

As purchase orders and work orders are created, their associated costs display in the appropriate 
column.  When a purchase order is created, the dollar amount will display under Total Ordered. 
 When the purchase order is received, costs will be reflected under Total Receipts (dollar value 
received), Total Returns (dollar value returned to vendors), and Purchase Order Net Amount 
(dollar value of what you received, less any return value).  In the preceding sample, you can see 
the value of sales orders assigned to this job number; only $10 worth of parts assigned to this job 
number have been orders and received on POs; no work orders have yet been created or 
completed against this job number. 

From here via the sidebar you can drill down or access related data; preview or print a report. 

 

 

    

199 



Alliance/MFG User Guide 

Demand Reports  
The following reports are available from the Demand menu.  You can preview or print a report 
from a predefined query, or create a custom query to display specific information in an 
Alliance/MFG standard format.  For more information about Alliance/MFG reports, see the 
Technical Reference. 

Acknowledgment 

Past Due Shipments 

Bookings Report 

Blanket Order  

Blanket Order Summary 

Contact List 

Customer List 

Forecast  

Invoice 

Job Summary 

Shipments By Date 

Pick List 

Quotation 

Sales Order 

SO List by Customer 

SO List by Part Number 
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Supply Menu functions 
Alliance/MFG is designed around the concept of “Supply and Demand.”  Purchase Orders and 
Work Orders become the “supply” that MRP recommends based on sales orders and forecasts 
that are the "demand" in the system.  This chapter describes how to maintain your suppliers and 
any part cross references to your supplier’s parts.  Additionally, you will learn how to enter and 
receive purchase orders, return a purchase order; and enter and complete work orders and 
perform backflushing. 
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Suppliers 
Alliance/MFG gives you a wide variety of options to create your supplier records.  You can enter 
basic information such as your company account number with this vendor; their address and 
contact information; terms, ship via, FOB, Region, and Currency codes; and supply a VAT ID and 
Registration number, if doing business in Europe.  You can also enter any part cross references 
to the supplier’s parts. Once added to the system, you can access supplier information from the 
main menu and submenus, or from the Supplier View list.  From here you can access purchase 
order and shipment activity for a supplier, see what POs are past due, and drill down from any of 
these to get more detail. 

Tasks described in this chapter assume familiarity with the basic use of Alliance/MFG data lists, 
data entry forms, dialog boxes, queries, and finding and sorting features.  If you need more 
information about how to use these features, review Chapter 2: System Overview. 

Entering New Supplier Information 

Enter a record for every supplier you purchase from.  If you have not yet defined codes related to 
suppliers such as FOB, Region, Terms, Ship Via, and Currency, you should complete this task 
before beginning to enter supplier records. 

Select Supply>Suppliers>New to open a blank Supplier data entry form.  

 

To enter a new supplier: 

1. Enter a Supplier ID. 

2. Enter the Supplier Name. 

3. Select the Active Flag box if this is a current supplier.  

4. Enter the information in the tabs as described in the following sections. 
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Supplier Tab 

1. The system will default to today’s date; however, you can use the calendar box to select a 
different date.   

2. If you’re part of the European Economic Community, enter the VAT Branch ID.  This is used 
in Intrastat Reporting to track Value Added Tax payments and receipts. 

3. Enter the VAT Registration number.  This is used in Intrastat Reporting to track Value Added 
Tax payments and receipts. 

4. Enter the URL of the supplier's website or a path to a document or contract you want to 
associate with this supplier. 

NOTE: 

For more information about setting up Intrastat Reporting, see Chapter 3: Setting Up Your 
Company (ICN Codes, ICN Rates, Region/Country Codes), and Chapter 8: 
Inventory Control, Intrastat Reporting.   

Notes Tab 

Enter unlimited notes into the supplier record.  Type in the body or copy/paste from another 
windows program or text file. 

Default Codes Tab 

These are the codes that will default to purchase orders created for this supplier, they can be 
changed or over ridden. 

 

1. Enter a Terms code. This code will default to the Terms Code field on the Purchase Order 
form. The code description will display next to the field. 
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2. Enter a Ship Via code . This code will default to the Ship Via Code field on the Purchase 
Order form. The code description will display next to the field. 

3. Select the Active Flag box if this is a current supplier.  This is information only. 

4. Enter an FOB code.  This code will default to the FOB Code field on the Purchase Order 
form.  The code description will display next to the field. 

5. Enter a Region code. This code will default to the Region code field on the Purchase Order 
form. This information is also used with Intrastat Reporting. The code description will display 
next to the field. 

6. Enter a Currency code .  This code will default to the Currency Code field on the Purchase 
Order form. The code description will display next to the field. 

7. You can enter up to10-characters in the User Defined field for any additional code, number or 
item you wish the system to display on Supplier Reports, Purchase Orders, and Receipts 
from this supplier. 

Supplier Address Tab 

All supplier address information is displayed in the Supplier Address tab.  From here you can 
Add, Edit, or Delete supplier address information. You may enter as many supplier addresses as 
are required. 

 

To enter address lines: 

1. In the Supplier Addresses tab, click Add on the left side of the form to open a blank Supplier 
Address data entry form.  

2. Here you will enter an Address ID and any contacts you wish to identify for this address. The 
Supplier Address form opens at the Addresses tab. 
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3. Enter an Address ID at the top of the form.  This might be “INV” for the invoice address, or a 
store number or ID for example. 

 

Addresses Tab 

1. Enter up to four address lines for this ID. 

2. Enter the City, State, Zip Code, Country, and Postal code if required. 

3. Enter a Tax Code or click the hyperlink to choose from the Tax Code list. 

4. Click Close.  The Address is added to the body of the Suppliers Addresses tab. 

5. Continue to click Add and enter additional Address IDs and addresses, as required. 

6. Select a line and click Edit to change the information on a line item One item on a customer order 
or purchase order, regardless of quantity. . 

7. Select a line and click Delete to delete an address ID. 
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Contacts Tab 

In the Supplier Address form, click the Contacts tab.  Any existing contacts will display in the body 
of the tab. 

 

1. Click Add. The Supplier Contacts data entry form opens at the Contacts tab. 

2. In the Contacts tab, enter the Contact ID, Name, Phone and Fax (either formatted or not 
formatted), and enter an e-mail address, if available.   

3. Click the Notes tab to enter any additional information about the contact you wish to store in 
the system. 

4. Click Close to exit the form and return to the Supplier Address data entry form. 

5. You can continue to add as many Contacts as required. 
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When you are finished, do one of the following: 

Select a line and click Edit to change the information on a line item. 

Select a line and click Delete to delete a contact ID. 

Click Close to return to the Suppliers data entry form. Saving changes to the supplier 
will save your address and contact data. 

Accessing Supplier data  

Once suppliers are added to the system, Alliance/MFG gives you a number of ways to access the 
data. 

From the Supply Menu 

Select Supply>Suppliers from the main menu.  From here you can go straight to a blank data 
entry form to enter new supplier records, edit existing records; or user predefined queries and 
wild cards to locate specific records. 

From the Supplier View 

Records displayed in the Supplier View depend on the record you select.  

 

From here you can add, edit, or delete a record, or via the sidebar you can drill down or access 
related data; preview or print a report.  
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Purchase Orders 
You can enter purchase orders in the system as desired, or you can run MRP and respond to 
Planned Orders based on demand. Alliance/MFG also provides a means to create a purchase 
order to send to a supplier for a subcontracted service; either on a regular basis, or to handle a 
temporary production overload. All purchase orders in the system can be entered or accessed 
from  the Supply>Purchase Order menu.  

Entering a New Purchase Order 

There are two methods for maintaining and entering purchase orders in Alliance/MFG, Advanced 
and Easy Entry. The Advanced method gives you more capabilities and field selections. On the 
other hand, if your suppliers can be set up with standard default values and only basic data is 
required, the Easy Entry method might save you entry time and efforts. You can toggle from the 
Advanced method to the Easy Entry method by clicking on the Easy Entry hyperlink in the upper 
right hand corner of the entry screen, you may also toggle back to the Advanced screen using the 
Advanced hyperlink. 

Select Supply>Purchase Orders>New, to open a blank Purchase Order data entry form. The last 
type of entry screen (Advanced or Easy Entry) used will open. The Advanced method is detailed 
below and the Easy Entry method will be described at the end of this section. The form opens at 
the Order tab, where you’ll enter general information.  When the PO is complete, the total value 
will display at the bottom of the form. 

Advanced Method 
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To Complete the Purchase Order Header: 

1. If you specified Auto-Generate in your Company Preferences settings, the new PO number 
will display once you have entered and saved the information, otherwise you can enter a 
unique Purchase Order number here.  

2. Enter or select a Supplier ID.  

3. If you make changes to Supplier default information, you can click Supplier Defaults to 
restore the defaults.  

4. The Entered By field defaults from the systems Login ID. 

5. When entering a new order, the Closed Flag should be clear.  You can select it later when 
the PO is received. 

Order Tab 

1. The Order Date will default to “today’s date,” or you can use the calendar box to select a 
date. 

2. Enter the Required Date (the delivery date). This is the date MRP will use in planning, the 
parts leadtime should include transit and receiving times and the supplier should plan the 
shipment in time to satisfy this date. 

3. Enter the Department account to which the purchase order is assigned. 

4. Enter the part requesters Employee ID.  

5. Enter the buyer’s Employee ID. The employee’s ID will appear on the hyperlink list only if 
“Purchase Orders” was selected in their Employee Record. 

6. The Class Code field is for future use by QuickBooks accounting links. 

7. Enter an Order Type: Phone, Fax, blanket, EDI, or other, at your discretion. 

8. Enter a requisition number, if used. 

9. Enter the name of the person with whom you placed the order. 

10. Enter up to 10 characters in the User-Defined field, as required.  This information will be 
displayed on the Purchase Order and can be used in custom queries. 

11. Enter a Currency Code for the order or accept the Suppliers default entry. 

12. Exchange Rate defaults based on the Currency Code entry (previous step). 

13. Once all part information is entered, the PO Total Amount will display at the bottom of the 
form. 

14. When you have completed the information, do one of the following: 

Click OK to save your header and entries and exit the form.  

Click Save on the toolbar to save your entries and move to another tab or leave the 
form open. 

Click Close to exit the window without saving your entries. 
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LINK NOTE: 

If you use an Alliance/MFG Accounting Link, you should choose the department 
associated with Accounts Payable. (The department code will default from the AP 
Account you specified in your Company Preferences.)   

Supplier Tab 

Enter general information such as supplier payment terms, region, ship via, and FOB in the 
Supplier tab. 

 

1. The Payment Terms default from the Supplier record.  You can select or enter a different 
code to override the default. 

2. The Region code defaults from the Supplier record.  You can select or enter a different region 
to override the default. 

3. The FOB code defaults from the Supplier record.  You can select or enter a different FOB 
code to override the default. 

4. Enter a Ship Via code to indicate the shipment method. 

5. Enter a Document Path if you are referencing a drawing, contract or other document (This 
field is for internal use only and will not print on the purchase order). 

6. The billing address will default to the one entered in Company Name/Address and indicated 
in Preferences.  You can enter a different address if you wish.   
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7. The delivery address will default to the one entered in Company Name/Address and indicated 
in Preferences. You can enter a different address if you wish. The default shipping address is 
the one entered in Company Name/Address and indicated in Preferences. 

8. Enter a Supplier Address ID. 

9. The Currency Code defaults from the Currency Code list, but can be overridden. (All costs on 
a purchase order will be entered in your base currency; this exchange rate is used for report 
printouts only.) 

10. Select the A/P Hold box to indicate the supplier is on payment hold.  (This field is information 
only.) 

11. When you have completed the information, do one of the following: 

Click Save on the toolbar to save your settings and leave the form open.  

Click OK to save your entries and exit the form.  

Click Close to exit the window without saving. 

Lines Tab 

Once line items are added to the PO, the line item detail is displayed in the Lines tab. Columns 
display the Required Date, Quantity Received, Job Number, Quantity Ordered, Part Number, PO 
Price, and Kit Part Flag.  From here you can Add, Edit, or Delete line items using the buttons on 
the left of the form.  (The Add button on the toolbar opens a new PO data entry form.) 

 

Adding Purchase Order Details 

You can add or edit individual items on the Purchase Order. Select a line and click the Add or 
Edit buttons on the left side of the Purchase Order data entry form to access the Purchase Order 
Detail form.  In the Line tab of the PO Detail form, you can edit required dates, part numbers, 
supplier cross references, quantities, tax information or assign a job number; and in the More tab, 
you can enter any additional tax information and see the cumulative quantities received, returned, 
or released for this PO.   
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To add a PO line item: 

From the Purchase Order Lines tab, click Add on the left of the form.  The Purchase Order Detail 
form opens at the Line tab. Enter the details as described in the following paragraphs. 

 

Line Tab 

The header displays the current PO number and the PO Line field displays the next line item 
available.  

1. The Part Cross-Reference (PartXReference) is the number used by your supplier or OEM to 
refer to the part. Enter the cross reference, if the cross reference is associated with a part, 
your part number will be defaulted by the system. The suppliers price associated with the X-
Reference will also default. If you enter your part number first, click the Part X-Reference 
hyperlink to query the X-Reference View for existing cross references to that part.  

2. Enter a part number or use the hyperlink to select a part from the Part Master View. These 
parts must have an Inventory Source Code of “Buy part,” “Subcontract”, “Free/bulk,” or “Non-
stock,” and have a valid department code.  The part description will display beneath the part 
number field. 

3. The required date defaults from the PO Header; however, you can change it if needed.  User 
the calendar box to select a different date. 

4. Enter a quantity. 

5. The default unit price is the price from the supplier cross-reference above. If no supplier 
cross-reference exists the Default PO Cost from the Inventory Record Part Costs Tab will be 
used.  
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6. If the line item is a subcontract part and you supply the components, select the Kit Part Flag. 
This flag indicates component material will be sent to the subcontractor for assembly or 
service.  See Subcontract PO Kitting in the Kitting and Dekitting chapter for information on 
kitting.  

NOTE: 

If the part cross reference currency code does not match the purchase order currency 
code the price will be set to zero (0). 

7. If the supplier currency code is different from your base currency code and the exchange rate 
is greater than 1.0 the Exchange Price field will be displayed. You may enter a fixed 
exchange price and Alliance will convert this amount to your base currency using the 
currency exchange rate table. 

8. Select the Taxable flag 

9. If you select the Taxable Flag, the Base Tax Code field is enabled.  Enter a Base Tax Code 
or click the hyperlink to select one from the Base Tax Code View.   

10. Enter the purchase unit of measure for the part or use the hyperlink to choose from the Unit 
of Measure View. The Purchase UOM may be different from the Stocking UOM.  If a 
Purchase UOM Code is entered in the Part Master, it will automatically default here. 

11. The Part Revision number defaults from the Part Master record. 

12. The unit of measure used to stock the part defaults from the Part Master record.  

13. If you use Job Tracking, enter a Job Number. Parts must have been assigned an OMC of 
“Job Tracking” to use this feature. 

14. The Line Amounts box summarizes the Non-Tax Total, Base Tax, and Subtotal for this line 
item. 

15. When you have completed the information, do one of the following: 

Click Save on the toolbar to save your settings and move to the next tab. 

Click OK to save your entries and exit the form.  

Click Close to exit the window without saving. 

NOTE: 

You must select the Taxable Flag in the Line tab to enable multi-tier tax fields on the  

More tab. 

 

More Tab 

Click the More tab to enter options for multi-tiered taxing and alternative accounts.  
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NOTE: 

To use this function, you must set up a non-inventory stockroom and locations in your 
Stockroom table. 

16. You can specify a receiving department code separately from that specified in the Inventory 
record. For example, you may want to specify a separate department/account for non-
inventory items.  When this item is received, it will bypass the default stockroom and transact 
to the department indicated here. 

17. Select  the Taxable Flag if you need to apply multi-tiered or compound taxes.  The default tax 
applied on the line tab will be the Base Rate.  However, by entering 2nd and 3rd Rates, you 
can apply multi-tiered taxing.  Checking the Tax on tax 2 or Tax on tax 3 check boxes will 
determine whether to apply the additional tax to the lines original Non-Tax Total (quantity x 
price) or to the lines original Subtotal (quantity x price + base tax) 

18. On the Line Tab you entered a Base Tax code or used the hyperlink to select from the Tax 
Code table. The Base Tax amount is calculated based on the tax rate (Displayed next to the 
base tax code). 

19. Select the Tax on Tax 2 checkbox to apply a second Tax Rate to the original subtotal 
(quantity x price plus taxes).  Select the second Tax Code you wish to apply. Leave the Tax 
on Tax 2 checkbox empty to apply a second tax rate to the original non-tax total (quantity x 
price). 

20. Select the Tax on Tax 3 checkbox to apply a third Tax Rate to the original subtotal (quantity x 
price plus taxes).  Select the third Tax Code you wish to apply. Leave the Tax on Tax 3 
checkbox empty to apply a third tax rate to the original non-tax total (quantity x price). 
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21. Enter up to10-characters in the User-defined fields.  This information will be displayed on the 
Purchase Order detail and can be used in custom queries. 

22. The Line Amounts box summarizes and displays the Non-tax Total, Base Tax, Subtotal; the 
2nd and 3rd taxes, and the Extended Price. 

23. The Quantity Received, Last Receipt Date, Quantity RTV (returned to vendor), and any 
Quantity Released are displayed in the right side of the tab.  These provide a cumulative 
transaction history for the line item. 

NOTE: 

These multi-tiered and compound tax rates will not apply to most US businesses; they are 
intended for use in countries with multiple taxes, such as Canada’s GST. 

PURCHASING NON-INVENTORY PARTS 

You may wish to use Alliance/MFG to track non-inventory parts purchases, such as tools, 
office supplies, and miscellaneous items that you may not want on your Part and Inventory 
Masters.  Here’s one way to do it: 

Create a part number such as “NON-INV,” in your part and inventory masters with an ISC 
of “Non-stock” and an OMC of “Manual”. Create a non nettable Stockroom for non-stock 
items. One for each category of parts (i.e. office supplies, services, etc.). 

When you write a purchase order for a non-inventory part, use this part number in the part 
number field.  Enter the item you are actually purchasing in the X-Reference part or memo 
field. 

Fill in the quantity and price.  The printed purchase order will show both the part “NON-
INV” and your X-Reference descriptive information.  You don’t need to set up the part in 
the X-Reference table but you can. 

On the line item More tab, enter the non-inventory stockroom.  When received, the PO will 
be transferred directly to that department, bypassing the inventory default stockroom. 

Accessing Purchase Order data  

Once purchase orders are added to the system, Alliance/MFG gives you a number of ways to 
access the data. 

From the Supply Menu 

The main menu is the first access level.  From here you can go straight to a blank data entry form 
to enter new purchase orders, edit existing POs, or use a predefined query and wild cards to 
locate specific records. 

From the Purchase Order View 

The records displayed in the Purchase Order View depend on the query you select. 
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From here you can add, edit, or delete a record; or via the sidebar you can drill down or access 
related data; preview or print a report. 

Easy Entry Purchase Order Method 

There are two methods for maintaining and entering purchase orders in Alliance/MFG, Advanced 
and Easy Entry. If your suppliers can be set up with standard default values and most of the time 
only basic data is required, the Easy Entry method might save you entry time and efforts.  

Select Supply>Purchase Orders>New, to open a blank Purchase Order data entry form. The last 
type of entry screen (Advanced or Easy Entry) used will open. You can toggle from the Advanced 
method to the Easy Entry method by clicking on the Easy Entry hyperlink in the upper right hand 
corner of the entry screen, you can also toggle to the Advanced screen using the Advanced 
hyperlink. The Easy Entry method is detailed below and the Advanced method is described at the 
beginning of this section.   
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The Easy Entry Purchase Order data entry form opens.  All information entered will remain in 
view as you work your way through the form. As purchase order line items are entered, the 
Purchase Order Total amount and the Total Remaining value display at the bottom of the form.   

To enter Purchase Order Header Information: 

24. If you specified auto numbering in your Company Preferences, the next incremental purchase 
order number will be entered automatically when you save the order, otherwise you must 
enter a unique purchase order number. 

25. The Order Date defaults to “today’s” date, or you can use the calendar box to specify a 
different date. 

26. Enter a Supplier ID or click on the Supplier ID hyperlink to select from your supplier table. 
When you enter a Supplier ID, default supplier information such as Terms, Ship Via and FOB 
codes are defaulted from the supplier record to the purchase order, additionally, if you 
defined a single Supplier Address with a single Supplier Contact, these values will also 
default to a new purchase order. If the values did not default click on the hyperlink to select 
them from their appropriate tables.  

27. To enter purchase order notes click on the Notes hyperlink, enter your notes and click the 
Close button. The first line of the notes will be visible on the purchase order form. 
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28. When entering a new purchase order, the Closed box will normally be clear.  You can return 
to select this box when the order is received or you may close it from the Receiving 
transaction form.   

29. Enter a Terms code or accept this supplier default entry. 

30. Enter an F.O.B. code or accept this supplier default entry. 

31. Enter a Ship Via code or accept this supplier default entry. 

32. Enter the Currency Code or accept this supplier default entry. When you print the purchase 
order report, this currency and exchange rate will be displayed. The Currency Rate will 
calculate and display based on the conversion rate between your base company currency 
code and the supplier currency code. 

33. Enter the Employee ID of the person requesting the order.  

34. Enter the Employee ID of the buyer associated with the order.   

35. Order Type, enter Phone, FAX, EDI, Blanket, or another method to indicate the order type.  

36. If you wish to assign a requisition number enter it here. 

37. Check the box and enter the Required Date (the delivery date). This is the date MRP will use 
in planning, the parts leadtime should include transit and receiving times and the supplier 
should plan the shipment in time to satisfy this date. If you enter a date here it will 
automatically default to all line items.  

NOTE: 

If you make changes to defaulted fields, then decide to return to default values, simply 
click the Advanced hyperlink, click the Customer Defaults button to refresh the 
default values, then click the Easy Entry hyperlink to return to this form. 
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To add a new purchase order line item: 

 
1. Tab into or click in the Part Number field, enter a part number or click on the elispse button to 

select one from the part master table. The part description will default from the Part Master 
table.  

2. Enter the quantity required for this line item in the purchase UOM. As soon as you leave the 
quantity field the price will be defaulted based on the Part Master Default PO Cost.  

3. If the Purchase UOM is different than the Stocking UOM, enter the purchase UOM code. 

4. Enter the Required Date (the delivery date). This is the date MRP will use in planning, the 
parts leadtime should include transit and receiving times and the supplier should plan the 
shipment in time to satisfy this date. If you entered a date in the purchase order header it will 
automatically default to all line items.  

5. The Extended Price field is automatically calculated by multiplying the line item price by the 
quantity then adding any base tax applied.  

If you have correctly entered your line items a green “+” will be displayed in the Line field (the 
green plus sign will change to a line number when the record is saved. If any field is invalid a red 
“X” will be displayed in the Line field and the invalid field will display a red background, the Save 
and OK buttons will be disabled.  

Click on the down arrow in the Line field to add notes to that line item, toggle to the Advanced 
Line Item entry form for that line item, delete that line item or to view the MRP Action screen or 
Inventory Lots screen for that part number. 

When you have finished entering the line items do one of the following; 

Click Save to save all entries and leave the form open. 

Click OK to save all entries and exit the Purchase Order data entry form. 

Click Close to exit the form without saving any entries not saved previously. 
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NOTE: 

The fields shown below are part of the complete purchase order record even though they 
are not displayed on the Easy Entry form. Some of these fields may default from 
related tables. They can be viewed, entered and edited by clicking on one of the 
Advanced hyperlink toggles. If one of these fields is invalid the Save and OK 
buttons will be disabled and the record cannot be saved. 

Advanced Purchase Order fields not displayed on the Purchase Order Header  

1. Department code, the departments account number will display below this field. This should 
be the department associated with the GL account for this order (usually AP). This value will 
default if set up in Company Preferences. 

2. PO Placed With, the name of the supplier contact or the person taking the order. (Optional) 

3. User Defined (Optional) 

4. Order Type, enter Phone, FAX, EDI, Blanket, or another method to indicate the order type. 
(Optional) 

5. User Field 1, (Optional) 

Advanced Purchase Order fields not displayed on the Purchase Order Line Item  

1. Sub-Contract Kit Part Flag, Start Quantity, and Start Date. 

2. Part X Reference, enter a cross-reference to the supplier’s part number if needed.  If only one 
(1) supplier cross reference exists for the part number entered and it is checked as an 
Approved Source, the cross reference field will be defaulted.(Optional) 

3. Part number, the part number will default if you entered a Part Cross Reference above. 

4. Taxable Flag, if the part taxable flag is set up in the Part Master this flag will be defaulted to 
True. The Tax Code can be defaulted from the Company>Preferences default PO Tax Code.  

Advanced Purchase Order fields not displayed on the Purchase Order Line Item More Tab 

1. The More tab is used to enter additional line information such as alternate Department Code 
or any multi-tiered tax values. 

2. The system will apply the Base Tax rate by default, if the part is checked Taxable in the Part 
Master. However, you can enter 2nd and 3rd Tax Rates in the appropriate fields to apply 
multi-tiered (compound) tax rates.  To apply these taxes, do one or both of the following: 

Select the Tax on Tax 2 checkbox to apply a second tax amount to the original 
subtotal (quantity x price plus tax), enter the second Tax Code you wish to apply.  

Or leave the Tax on Tax 2 checkbox empty to apply a second tax amount to the 
original quantity x price only (the no tax on tax option). 

Select the Tax on Tax 3 checkbox to apply a third tax amount to the original subtotal 
(quantity x price plus tax), enter the third Tax Code you wish to apply.    

Or leave the Tax on Tax 3 checkbox empty to apply a third tax amount to the original 
quantity x price only (again the no tax on tax option). 
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Purchase Order Receipts 

Receiving Purchase Orders 

Once purchase orders are entered in the system, you have several options for accessing a 
purchase order, and viewing purchase order information such as receipt history, past due orders, 
and all POs not received. 

You can receive all lines or a single line item on a purchase.  Mark the order “closed” or leave it 
open, depending on how much of the order is received.  Once a purchase order is received, you 
can also return items received from a supplier.  (If the purchase order has been marked “closed,” 
you must open it to return parts to a supplier.) 

Purchase Order Receipts 

Select Supply>Receive a Purchase Order.  A blank form is displayed. 

 

Enter a PO number. The Purchase Order receipts entry form opens at the PO Details tab.  From 
here you can receive detail lines or optionally Edit a line item on the purchase order.  If any line 
items have been received on this purchase order, the receipt information will display in the body 
of this tab. 
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Creating and printing a PO Receipt: 

1. After you enter a PO number the Entered By defaults from the user Login. 

2. The Receipt Date will default to “today’s” date.  You can use the calendar box to change it. 
Both receipt date and transaction date will be saved as part of the transaction. 

3. You may either receive each line separately or All Lines. If you receive a line the following 
screen will be displayed. You may change the Stockroom, Location, Job Number, or quantity. 
You may also add a Lot or Serial Number.  

4. In the case below two "Caution" triangle displayed, if you hold the mouse cursor over the 
triangle the message will be displayed Ex. "Total receipt quantity is more than the order 
quantity".  

5. Click the Close button to receive another line. 
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When you are finished receiving items, click Save on the toolbar, a Transaction Group is system 
generated and includes all items selected for this receipt, you may now print a PO receipt by 
selecting PO Receipts from the Related Reports section of the sidebar. 

Reviewing PO Receipts on the PO Detail Tab 

 

All purchase order line items are displayed in the body of the tab by PO Line, Part Number, 
Quantity Received (if any), and Quantity Ordered.  Any quantity returned against the purchase 
order will also be displayed.  You can receive all lines or select one line item for receipt. 

To Receive All Lines on a Purchase Order 

1. In the PO Details tab, click All on the left side of the form. Check marks will appear next to all 
lines to indicate lines that have changed, for example, a quantity has been entered in the 
Quantity Received column.  You can also edit the quantities, and stockroom and location at 
your discretion. (See Editing PO Receipts for Receive All) 

2. You may change information on the original purchase order, if needed.  In the PO Details tab, 
select a line item and click Edit on the left side of the window.  The Purchase Order data 
entry form opens, from here, you can edit the information you wish, click Closed to return to 
the PO Receipts form. Check the Close PO box if you consider this PO complete. 

3. If you click Save on the toolbar, a Transaction Group is system generated and includes all 
items selected for receipt, you may now print a PO receipt by selecting PO Receipts from the 
Related Reports section of the sidebar. 

4. Click OK, Save, or Close as required. 

To Receive a single line on a Purchase Order: 

1. In the PO Details tab, select a line item and click Receive Line. You can edit the quantities, 
job #, serial/lot #, stockroom and location at your discretion.  A check mark appears next to 
the line to indicate a change has occurred.   
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2. Continue to receive individual lines, as needed.  Check the Close PO box if you consider this 
PO complete. 

3. When you are finished, click Save on the toolbar, a Transaction Group is system generated 
and includes all items selected for receipt, you may now print a PO receipt by selecting PO 
Receipts from the Related Reports section of the sidebar. 

Editing the PO Receipts for Receive All transactions 

In the Receipts tab, select the line you wish to edit and click Edit on the left side of the form.  The 
Receipts transaction form opens for the line item selected.  

 

1. The PO number, PO line item, and Part Number display in the PO Receipts header A record 
containing common, constant, or identifying information for a group of records which follows. .   

2. You can edit the Stockroom Location, and quantity; add an SN/Lot Number or Job Number; 
or enter up to 60 characters of Tran Info; at your discretion.   

3. When you are satisfied with your edits, click Close to save your entries and return to the 
Purchase Order Receipts tab. 

4. When you have finished receiving shipments, do one of the following: 

Click Save on the toolbar, a Transaction Group is system generated and includes all items 
selected for receipt, you may now print a PO receipt by selecting PO Receipts from the Related 
Reports section of the sidebar. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving any entries not applied or saved. 
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Purchase Order Returns 

Returning Purchase Orders 

You may have occasion to return parts to a supplier after they have been received.  Alliance/MFG 
gives you several ways to access purchase orders for return.  You can select Supply>Return a 
Purchase Order from the main menu and use the hyperlink to select a PO. You can also select 
PO Return from the Purchase Order View.  You have the option to edit PO line items before 
returning them, and once you tag a line for return, you can edit the stockroom, location, SN/Lot 
number or quantity for the items returned. 

Creating a Purchase Order Return  

Select Supply>Return a Purchase Order from the main menu, or select a PO line in the Purchase 
Order View and click PO Returns in Related Edit on the sidebar to open the return transaction 
form for that PO. The Purchase Order Return form opens at the PO Details tab.   

 

If you access PO Returns from main menu, the body of the tab is empty. You can select a PO by 
entering the number if you know it; or use the hyperlink to select one from the predefined queries. 
If you access the form from the Purchase Order View, line items for the selected PO display in 
the body of the tab.  

The PO Returns header displays the PO Line, Part Number, Quantity Remaining, Quantity 
Returned to Vendor, the  total Quantity Ordered, and the total Quantity Received to date.  

1. Enter the PO number you want to return.  (If you opened this form from the PO View, the 
selected PO number will display. 

2. The part number displays from the PO Header. 

3. The Return Date defaults to “today’s” date.  You can use the calendar box to change it, at 
your discretion. 
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4. A Transaction Group is system generated for all items selected for return when you click 
Save or OK. 

To return all items on a purchase order: 

Click All on the left side of the form to return all lines.  Check marks indicate items selected for 
return.  You can edit individual line items as needed from the PO Returns tab.  

Editing PO Returns 

From the PO Returns tab, you can Add, Edit or Delete individual line items. 

Select a line and click Edit to open the PO Returns form.  

 

1. From here, you can edit the Stockroom, Location, and quantity; or add an SN/Lot Number or 
Job Number at your discretion.   

2. Click Add on the toolbar to open a blank Returns form and enter the information required.  

To return a line item on a PO: 

Click Return Line.  The Returns form automatically opens for the line items selected. 
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1. Click Close to accept the return as is, or edit the fields as required, then click Close. 
Remember to uncheck the Closed Flag if you intend to receive the item again. 

2. You can continue to select items to return and edit as required. No actions will take affect 
until you click Save or OK. 

3. When you are satisfied with your selections, click OK to complete the transactions and return 
to the Purchase Order Returns tab. 

4. When you have finished returning items, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving any entries not applied or saved. 
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Work Orders 
Work orders are an internal authorization to manufacture parts on the shop floor.  Alliance/MFG 
gives you the tools you need to create, kit, relieve shortages, and add, edit, or delete items from 
work order kits as required, and complete work orders. You can run MRP and create work orders 
in response to Planned Orders based on actual demand; or you can enter work orders into the 
system manually. 

Creating Work orders 

Determine that you need to manufacture a given part. Either run MRP and respond to planned 
orders, or create work orders manually as they are required. 

5. Schedule a work order and create a work order traveler. A WO traveler is a report listing 
the steps and routing required to assemble or produce the scheduled item. Labor Routers 
are maintained in CRP>Labor Routers. Scheduling a MRP Planned Order or creating a 
manual WO change the WO status to a “Firm” work order. 

6. Release The authorization to produce or ship material that has already been ordered. and kit the work 
order.  This will “move” the required components from stockroom inventory to Work in 
Process (WIP).  Print a pick list first, if desired. 

7. If a required component has insufficient inventory available, the system will automatically 
create a shortage (shortages are displayed on the Required Tab of the WO Kits 
transaction form and are written to the Shortages file).  When short components are 
received into stock, a notice will be displayed prompting you to relieve (issue) the 
shortages to the WO. 

8. After all work on the Work Order is finished, complete the work order and move the 
finished assembly quantity into stock. There are three methods for completing work 
orders; Standard, Serialized and Backflushing.  

Status Code - Firm vs. Released 

A Firm Order is a planned order that has been converted to a firm work order, “locking in” dates 
and quantities. The order may have been scheduled manually or as a result of an MRP run; 
however, it has not yet been kitted or released to the shop floor for production.  The MRP 
calculation considers these work orders and explodes their component requirements where 
necessary.  These orders will appear on the Work Orders View list; the released quantities will be 
“0.” 

A Released Order is a work order that is ready to build, has had parts issued to it (kitted), and 
has been sent to production. After the work order is released, the MRP calculation will no longer 
plan to order components for that work order. After the work order is kitted, the quantity released 
will display in the Released column of the Work Order View.  When all quantities for the work 
order have been kitted, (no shortages remain) the Released quantity and the Required quantity 
will be the same. 

For more information about how MRP creates Planned Orders for components on work orders, 
see the Material Requirements Planning section. 
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Entering New Work Orders 

Select Supply>Work Orders>New to open a blank Work Order data entry form.  Enter the 
information in the WO header, and continue to fill in the tab information as described in the 
following sections.  The header information will continue to display as your work your way through 
the tabs.   

 

To Complete the Work Order Header: 

1. If you specified Auto-Generate in your Company Preferences settings, the new WO number 
will display once you have entered and saved the information, otherwise you can enter a 
unique work order number. 

2. The Entered by defaults from the Login ID.  

3. Leave the Closed Flag blank when entering a new work order. (MRP will not plan for the 
order after it is closed.) 

Detail Tab 

4. Enter a part number. The part must have been entered in Inventory Maintenance and coded 
with an Inventory Source Code of “Make Part” or “Phantom Part” and have a valid 
manufacturing department. 

5. Enter the quantity needed at start to yield the quantity required.  When MRP plans a work 
order, this will be the required quantity multiplied by the yield factor for the part, indicated on 
the Part Master. If the work order is scheduled via the MRP Action Parts form, the Start 
Quantity will be generated by the system from on the order method code setting specified for 
this part in the Part Maintenance function. (See Chapter 8: Part Maintenance for more 
information about Order Method Codes.) 

229 



Alliance/MFG User Guide 

6. Enter the quantity required to meet planning requirements. 

7. The quantity released is generated by the system when items are kitted. 

8. The total number of completed items on the work order is displayed as generated by the 
system. 

9. Displayed from the Part Master record. You can override it, at your discretion. 

10. Displayed from the Part Master record. 

11. Enter a priority code, at your discretion. (Reference only, based on priority code policies you 
determine.) 

12. You can enter up to 10 characters in the User-Defined field. No calculations will be based on 
information in this field; however, the information will be printed on Work Order Travelers. 

13. If you use Job Tracking, enter a job number. 

 

14. The Start Date is generated by the system. (Date on which component items were planned.) 

15. The Required Date is generated by the system. (Date on which the work order is required.) 

16. The Release Date  is displayed by the system. (Date on which component items were 
released/kitted.) 

17. Standard Hours are displayed based on labor hours required to produce the part (specified in 
the Part Master). 
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18. Total WIP Issues, Total Scrap, and Total Labor applied to this work order display in the lower 
right corner of the form.  These provide work order history for the work order. 

19. When you have completed entering the information, do one of the following: 

Click OK to save your entries and exit the Work Orders form.  

Click Save on the toolbar to save your entries and continue adding work orders. 

Click Add on the toolbar to create another work order. 

Click Close to exit the work order form without saving. 

Notes Tab 

Enter any notes you would like to include about this work order.  These will print on any work 
order documents. 

Accessing Work Order Data  

Once work orders are added to the system, Alliance/MFG gives you a number of ways to access 
the data. 

From the Supply Menu 

Select Supply>Work Orders from the main menu.  From here you can go straight to a blank data 
entry form to enter a new work order, edit existing records; or use predefined queries and wild 
cards to locate specific records. 

From the Work Orders View 

The records displayed in the Work Orders View depend on the query selected. 

 

From here you can add, edit or delete a work order; or via the sidebar you can drill down or 
access related data; preview or print a report. 
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Work Order Release Manager 
The Work Order Release Manager is a decision-assistant tool that allows users to dynamically 
test pick open work orders and selectively release them to production based on the feedback 
provided by the Release Manager. As orders are included/excluded and release quantities are 
increased/decreased the impact on inventory, customer requirements and potential short falls can 
be displayed, reviewed and adjusted to maximize potential production quantities and customer 
satisfaction. You can now answer the question "What can I produce NOW - TODAY ?" 

Determining Work Order Release Quantities 

Select Supply>Work Order Release Manager to display the Work Order Release Manager View.  

Work Order Tab 

All "Open" work orders; Firm MRP work orders that have not yet been released, or released work 
orders that have been only partially released, will be displayed.  

 

The default sort order is by the Work Order Start Date. If the WO Start Date is your main priority 
for scheduling production then you can start the test picking process by clicking the Qty 

Remaining    button for a Work Order. 

The Qty Remaining column is the total quantity remaining to be released for the work order 
selected. Clicking this  button will automatically check the "Include?" checkbox and also copy and 
enter the Qty Remaining amount into the Qty To Release column.  

Test Picking Component Parts 

If you do this by Start Date, for each work order in the list, the Release Manager will also 
calculate and display the Max Build quantity for each work order and display a "Flag" in the 
Status field (the column to the left of the WO Number in the view). A Green Check indicates all 
parts required to kit the work order Max Build quantity are available. The kit list for the work order 
highlighted in the top half of the view is displayed in the bottom half of the view. The current on-
hand inventory position of the component parts is displayed. 
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Affected Parts Tab 

Click on the Affected Parts Tab to display a combined list of all parts required for all "Included" 
work orders. The complete current on-hand inventory position of the component parts is 
displayed. 

 

Click on the Work Orders Tab to return to the Release Manager.  

Release Manager indicates sufficient quantities available  (All Green checks) 

In this example: WO00080003 for part B-02 has Qty Remaining of 2210. Clicking the button in 
the Qty Remaining column will enter 2210 in the Qty To Release, it will also check the Include? 
box and calculate the Max Build quantity (reviews the current on-hand balances for all required 
BOM components), which in this case is 2210. Next, WO05110001 for part B-01 has Qty 
Remaining of 2000. Clicking the button in the Qty Remaining column will enter 2000 in the Qty To 
Release, check the Include? box and calculate the Max Build quantity. The Release manager 
again reviews the current on-hand balances for all required BOM components on all "Included?" 
work orders.  

233 



Alliance/MFG User Guide 

Green checks indicate all required parts are available for all included work orders, you can 
release and build both of these work orders now, today!  

If you have completed the work order test pick function and want to release the work order(s), 
click on the Save button in the Toolbar. Clicking the Save button does several things. 

1. Validate the Qty To Release does not exceed the Max Build quantity for all Included Work 
Orders 

2. Create a Planned Issues list (allocation or shortage list) for each work order released  

3. Releases the "Included" Work Orders 

You may now print Pick Lists and WO Travelers and Kit the released work orders.  

NOTE: 

Additionally the Alliance/MFG RDC Kitting transaction will allocate the Planned Issues 
lists created by the Release Manager to Hand Held Devices used for Remote Data 
Collection. Contact Account Management or visit the Exact Alliance Customer 
Portal for additional details on Alliance/MFG Remote Data Collection.  

Release Manager indicates insufficient quantities available  (at least one Red box ) 

If the release manager has displayed a Red X (actually a red box with a white X) on a selected 
work order, it indicates there are insufficient component inventories to satisfy the full Qty To 
Release. When this occurs the Max Build quantity will be calculated and displayed. The kit list for 
the highlighted work order is displayed in the bottom half of the Release Manager window. 

 

In this example there are two parts with insufficient inventory on-hand to build the work order 
quantity of 5,000. B-01 has 2900 parts in stock available to be pulled and S-01 has 2400 
available. The Max Build quantity is calculated and displayed as 2400 in the top half of the 
Release Manager window.  
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If you decide that the entire quantity of 5000 is still required to satisfy a requirement (customer 
order or other internal priority) you can investigate further.  

Highlight component part B-01, the Sidebar displays a link to the Component MRP, click on that 
Related View link. The MRP Detail for part B-01 is displayed.  

 

The first row lists a past due work order for a quantity of 5100, after checking with either the 
planner or foreman for that department they indicate that a quantity of 2500 will be completed into 
stock today. Close the MRP Detail View for B-01. 

Click on the Affected Parts Tab of the Release Manager, enter 2500 in the Qty Expected column 
for part B-01. 

Highlight part S-01, the Sidebar displays a link to the Component MRP, click on that Related View 
link. The MRP Detail for part S-01 is displayed. The first row lists a past due PO for a quantity of 
15,600 with a reschedule action of Move In displayed (this indicates that MRP notified the 
buyer/planner to expedite this PO). A quick check with buyer indicates the entire 15,600 parts are 
in receiving and will be available soon. Close the MRP Detail View for S-01. Enter 15,600 in the 
Qty Expected column for part S-01 in the Release Manager.  
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The red check boxes displayed on parts B-01 and S-01 are replaced with Yellow caution icons 

. This indicates you are "Expecting" these parts and are planning to release the work order for 
BPP-100 at the full quantity of 5,000. 

Click on the Work Orders Tab. The Max Build quantity for BPP-100 is now displayed as 5,000 
and the inventory status for the two component parts have been updated.  

 

 

236 



Working with Supply 

NOTE: 

The actual inventory balance has NOT been altered, the Qty Expected is only reflected 
and utilized in the Release Manager. The actual transactions, a Work Order 
Completion for B-01 and a Purchase Order Receipt for S-01will update the 
stockroom on-hand balance when the transactions are actually performed. 

If you finished test picking orders, click the Save button in the Toolbar. Clicking the Save button 
does several things. 

1. Validate the Qty To Release does not exceed the Max Build quantity for all Included Work 
Orders 

2. Create a Planned Issues list (allocation or shortage list) for each work order released  

3. Releases the "Included" Work Orders 

You may now print Pick Lists and WO Travelers and Kit the released work orders.  

NOTE: 

Additionally the Alliance/MFG RDC Kitting transaction will allocate the Planned Issues 
lists created by the Release Manager to Hand Held Devices used for Remote Data 
Collection. Contact Account Management or visit the Exact Alliance Customer 
Portal for additional details on Alliance/MFG Remote Data Collection.   
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Kitting and Dekitting 
Alliance/MFG gives you complete control over work order and sub-contract purchase order 
kitting. Each is described in detail in the following sections. 

Work Order Releasing and Kitting 

Component on-hand inventory is calculated with each work order released, which gives you the 
option to “test pick” multiple work orders until the inventory is consumed. Test picking can be 
done here or by using the Release Manager. You can release and kit one component line or all 
lines exactly as displayed; you can release and kit a partial quantity, or you can release more 
than the required quantity.  

You can add work orders, change release quantities, and make any adjustments you wish until 
you are satisfied with the results, then click Save or OK to save your entries and release the work 
orders to WIP (production).  

Select Supply>Kitting from the main menu.  From here, you have the option to kit or test pick a 
work order or a subcontract PO. 

To Kit a Work Order: 

Select Supply>Kitting>Work Order to open a blank WO Kits transaction form. 

 

Required/Short Tab 

The WO Kits transaction form opens at the Required/Short tab. If you accessed this form from the 
Work Order View, the selected WO displays in the WO Number field; otherwise, enter the work 
order you wish to kit. 
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Once you select a work order, the Assembly, Description and any quantity already released 
display in the header, along with the Quantity To Start, Quantity Required, and the Start and 
Required dates. The Kit Date defaults to “today’s” date. You can use the calendar box to select a 
different date if you wish. The system will explode the current BOM to list the parts needed to 
complete the work order.  

You can kit the entire quantity released or change it, kit all lines on the work order, or just kit one 
line, as needed.  

Enter a quantity to release. The system will explode the current BOM to list the parts needed to 
complete the work order. You can add, edit and delete requirements/shortages to the WO if 
needed. The system will adjust quantities as you kit.  The actual kitting won’t be applied until you 
click Save on the toolbar or the OK button.  This allows you to “test pick” different orders until you 
are satisfied. 

 

To Kit All Lines: 

1. Click All to kit the entire work order.  Quantities kitted complete will change to “0” on the 
Required/Short Tab and the issued quantities will be listed on the WIP Issues Tab, the default 
stockroom and locations will be relieved first, if insufficient inventory is available in the default 
stockroom and location, the system will continue to pick from other “Nettable” stockrooms 
and locations until the entire requirement is satisfied.  

2. When you change a quantity, a check mark indicates a change has occurred.  If you add to 
the release quantity from the WO header, additional components may be added to the 
required list.  A plus sign next to the line indicates the system added these components. 

3. When you have finished kitting, do one of the following: 

Click the WIP Issues tab to review the stockrooms and locations, or change quantities, 
stockrooms, or locations.   
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Click the Add button on the left side of the tab to add a part/shortage An amount by which 
an order is deficient. . (See Adding to Shortages in the next section.) 

Click OK to accept the kit and exit the WO Kits data entry form. 

Click Save on the toolbar to kit this work order and leave the form open. 

Click Add on the toolbar to kit another work order. 

To kit a single line: 

1. Select the line you wish to kit.  You can kit a partial quantity, or modify the release quantity as 
described earlier.  Click on the Kit Line button.  A pop-up window will display the stockroom 
and location being relieved.  

 

You may change the stockroom and/or location if required. Quantities kitted complete will change 
to “0” on the Required/Short Tab and the issued quantities will be listed on the WIP Issues Tab. 

When you have finished kitting, do one of the following: 

Click the WIP Issues tab to review or edit the stockrooms, locations, or change 
quantities.   

Click OK, Add, Save as needed. 

NOTE: 

CURRENT BILL OF MATERIALS 

Because bills of materials change from time to time, the system recognizes the Current 
Bill of Materials at the time of the kitting transaction.  If you kit a WO on Monday, 
add a part to the BOM on Tuesday, then DeKit the work order on Wednesday, the 
system will DeKit according to the BOM configuration when the kitting transaction 
took place.  
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WIP Issues Tab 

After you select items to kit, click WIP Issues to see what departments and stockrooms the 
system will issue the components from. You can add more items if you have a new requirement, 
or select a line and click Edit to change a quantity, stockroom, or location. 

 

When you click Save or OK, the system generates a Transaction Group number to associate with 
the kitting transactions completed. 

Adding to or Editing Shortages 

You may have occasion to add or edit a shortage to a work order kit.  You can do this quickly 
from the WO Kits, Required/Short tab data entry form. 

2. Click the Add or Edit button on the left side of the Required/Short tab. The Work Order 
Shortages data entry form opens.   
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3. The WO Number and component part number display as selected in the WO Kits form.  The 
Transaction date defaults to “today,” however, you can change it if required. 

4. To create a new shortage enter the component part number required. 

5. Enter a quantity for the total new or edited shortage.   

6. Click Close to save the entry and return to the Required/Short tab.  The quantity is added. 
Click OK, Add, Save as needed. 

NOTE: 

If some parts are unavailable, the amount remaining unreleased will continue to appear in 
the Required/Short tab as a shortage.  MRP will continue to consider these 
quantities in planning, and they will appear on the shortage report against the work 
order. 

Work Order Dekitting 

It may become necessary to remove components from a kit; for example, you may discover that a 
batch of components parts is defective.  You can dekit them to a scrap stockroom and create a 
shortage so MRP will re-plan their requirements. Or, you may decide to reduce or cancel (Un-
Release) the work order, dekit the components and return them to inventory.  If you have kitted a 
work order but have not yet clicked Save or OK you are free to change quantities and dekit at 
your discretion. However, if you have already accepted the kit (clicked Save or OK), you must 
dekit as a separate transaction. 

Select Supply>Dekitting.  From here you have the option to dekit a subcontract PO item, or a 
work order.  The Dekit window will open to the WIP Issues tab, access any items that have been 
kitted to the work order, and perform a dekit as described in the following sections. 

To Dekit a work order: 

Select Supply>Dekitting>Work Order.  The WO Dekit transaction form opens. 
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1. Enter a work order number.  The Quantity Released to the work order will display on the 
header. 

2. You can dekit any amount of the Released quantity that has not been received or completed 
to inventory.  Enter a quantity in the Reduce Release Quantity By field.  The Quantity 
Released will change accordingly.   

Using the Un-Release Order button 

The Un-Release Order button acts differently, depending on the quantity entered in the Release 
Quantity By field and the original work order quantity released. 

Adjusted work order quantity equals zero - When the quantity entered in the Reduce Release 
Quantity By field equals the original work order released quantity, this action will remove ALL 
issues and ALL shortages.  The only exception would be issues that contain scrapped parts; 
which must be retained to preserve the scrap cost on the work order. 

Adjusted work order quantity is greater than zero - When the work order quantity released is 
greater than zero after being adjusted by the value entered in the Reduce Release Quantity By 
field, this action will use the current exploded bill of materials to get a list of requirements for the 
Reduce Quantity By value.  First, it will remove any shortages up to the amount required by the 
exploded bill.  After shortages are removed, issues will be dekitted.   

For example: You enter a “Reduce release qty by” for 100 units of a part that has component C1. 
Component C1 has a shortage of 75 units and an issued line of 200 units.  The shortage of 75 
units will be marked for deletion and 25 units of the issued line will be dekitted, leaving 175 units 
issued. 

WIP Issues Tab 

In the WIP Issues tab, click All to dekit all lines, or select a line and click Dekit Line to dekit one 
line at a time.   
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WO Dekit Tab 

In the WO Dekit tab, you can review, change, or delete the quantity, stockroom, location, SN/Lot 
Number or Scrap the part. Each dekit is assigned a unique Issue ID number to track issues that 
would otherwise be identical. 

To Edit lines in the dekit: 

3. In the WO Dekit tab, select the line you wish to edit. 

4. Click Edit on the left side of the tab to open the WO Dekit form. From here, you can edit 
the Stockroom, Location, SN/Lot Number, Job Number, enter up to 60 characters of Tran 
Info; or Quantity; tag the dekit for a shortage or to scrap. 

5. Select Create Shortage if you want MRP to plan to replace the dekitted parts.  It is not 
necessary to use this feature when you use the Un-Release button on the WO Dekit form 
(see the next section). 
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1. Select Scrap Part to flag the system to associate the cost of the scrapped part to this 
particular work order. You can dekit a part to scrap and specify a location without checking 
this box; however, the cost of scrap will not be tracked to this particular work order. 

2. Click Close to accept the dekit and return to the WO Dekit tab. Click OK, Add, Save as 
needed. 

Dekitting Parts to Scrap 

You have the ability to dekit components to scrap and create replacement requirements 
(shortages).  For example, if you know a particular component is defective, you can dekit the 
affected work order assigning the components to a stockroom designated for scrap and create 
shortages to replace the components. 

To dekit a part to scrap: 

1. In the WO Dekit tab, select a line and click Edit. 

2. The WO Dekit form opens for the Issue ID selected in the tab.   

3. Select the Stockroom location for scrapped items. 

4. Select the Location for the scrapped item. 

5. Edit the quantity if needed. From here, you can edit the Stockroom, Location, SN/Lot 
Number, Job Number, or Quantity. 

6. Select Create Shortage if you want MRP to plan to replace the dekitted parts.  It is not 
necessary to use this feature when you use the Un-release button on the WO Dekit form (see 
the following section). 

7. Select Scrap Part to flag the system to associate the cost of the scrapped part to this 
particular work order. You can dekit a part to scrap and specify a location without checking 
this box; however, the cost of scrap will not be tracked to this particular work order. 
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8. Click Close to accept the dekit and return to the WO Dekit tab. Click OK, Add, Save as 
needed. 

Working with Sub-contract Purchase Orders 

Alliance/MFG gives you control over sub-contract purchase order kitting.  If you supply parts to 
your suppliers this section will explain sub-contract PO kitting. The PO line item to be kitted must 
have an ISC of Subcontract Part and should have a department with a subcontract WIP account 
number assigned. You can kit one line or all lines exactly as displayed; you can also kit or release 
a partial quantity. A temporary on-hand inventory quantity is calculated with each order released, 
which gives you the option to “test pick” multiple orders until all inventory is consumed.  You can 
add orders, change released quantities, and make any adjustments you wish until you are 
satisfied with the results, then click Save or OK to save your entries and issue the parts to the 
sub-contract PO (SC WIP).  

When components are available to be sent to the supplier, you are ready to kit the work order. 
 Select Supply>Kitting from the main menu.  From here, you have the option to kit a subcontract 
PO or a work order. 

To Kit a Subcontract PO: 

Select Kitting>Subcontract PO Item to open a blank PO Kits transaction form. 

 

Required/Short Tab 

The PO Kits transaction form opens at the Required/Short tab. If you accessed this form from the 
Purchase Order View, the selected PO displays in the PO Number field; otherwise, enter the 
purchase order number you wish to kit. Enter the PO Line Item you wish to kit. 
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Once you select a PO and Line, the Assembly, Description and any quantity previously released 
display in the header, along with the Start Quantity, Quantity Required, and the Start and 
Required dates. The Kit Date defaults to “today’s” date. You can use the calendar box to select a 
different date if you wish. The system will explode the current BOM to list the parts needed to 
complete the work order.  

 

You can kit the entire quantity released or change it, kit all components on the line, or just kit 
selected items to the line, as needed.  When you click Save or OK, the system generates a 
Transaction Group number to associate with the multiple kitting transactions completed. 

To Kit All components to the Line: 

1. Enter a quantity to release. The system will explode the current BOM to list the parts needed 
to complete the kit. You can add, edit and delete requirements/shortages to the PO if needed. 
The system will adjust quantities as you kit.  The actual kitting won’t be applied until you click 
Save on the toolbar or the OK button.  This allows you to “test pick” different orders. 

2. Click All to kit the entire quantity of all components. Quantities kitted complete will change to 
“0” on the Required/Short Tab and the issued quantities will be listed on the PIP Issues Tab, 
the default stockroom and locations will be relieved first, if insufficient inventory is available in 
the default stockroom and location, the system will continue to pick from other “Nettable” 
stockrooms and locations until the entire requirement is satisfied.  

3. When you change a quantity, a check mark indicates a change has occurred.  If you add to 
the release quantity from the PO line item, additional components may be added to the 
required list.  A plus sign next to the line indicates the system added these components. 

To kit a single component to the line: 

1. In the PO Kits transaction form, enter a PO Number to kit.  
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2. Select the line you wish to kit.  You can kit a partial quantity, or modify the release quantity as 
described earlier.  Click Kit Line.  A pop-up window will display the stockroom and location 
being relieved. You may change the stockroom and/or location if required. Quantities kitted 
complete will change to “0” on the Required/Short Tab and the issued quantities will be listed 
on the PIP Issues Tab. 

PIP Issues Tab 

After you select items to kit, click PIP Issues to see what departments and stockrooms the system 
will issue the stock from. From here, you can add more items if needed, or select a line and click 
Edit to change a quantity, stockroom, or location. 

 

When you have finished kitting, do one of the following: 

Click the Add button on the left side of the tab to add a part or create a shortage. (See 
Creating Shortages in the next section.) 

Click OK to accept the kit and exit the PO Kits data entry form. 

Click Save on the toolbar to kit this order and leave the form open. 

Click Add on the toolbar to kit another purchase order. 

NOTE: 

CURRENT BILL OF MATERIALS 

Because bills of materials change from time to time, the system recognizes the Current 
Bill of Materials at the time of the kitting transaction.  If you kit a WO on Monday, 
add a part to the BOM on Tuesday, then DeKit the work order on Wednesday, the 
system will DeKit according to the BOM configuration when the kitting transaction 
took place.  
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Creating Shortages 

You may have occasion to create or add a shortage to a purchase order kit.  You can do this 
quickly from the PO Kits, Required/Short tab data entry form. 

Click the Add button on the left side of the Required/Short tab. The PO Shortages entry form 
opens.  

 

1. The PO Number, Line Number default from the PO Kit screen. The Transaction date defaults 
to “today,” however, you can change it. 

2. Enter a Part number, quantity and UOM for the shortage.   

3. Click Close to save the entry and return to the Required/Short tab.  The shortage is added. 
Click OK, Add, Save as needed. 

NOTE: 

If some parts are unavailable, the amount remaining unreleased will continue to appear in 
the Required/Short tab as a shortage.  MRP will continue to consider these 
quantities in planning, and they will appear on the shortage report against the work 
order. 

Dekitting Sub-contract Purchase Orders 

It may become necessary to remove components from a kit; for example, you may discover that a 
batch of components parts are defective.  You can dekit them to a scrap stockroom and create a 
shortage so MRP will plan their requirements. Or, you may decide to dekit components and return 
them to inventory.  If you have kitted a purchase order but have not yet clicked Save or OK you 
are free to change quantities and dekit at your discretion. However, if you have already accepted 
the kit (clicked on Save or OK), you must dekit as a separate transaction. 

Select Supply>Dekitting.  From here you have the option to dekit a subcontract PO item, or a 
work order.  The PO Dekit window will open to the PIP Issues tab, access any items that have 
been kitted to the order, and perform a dekit as described in the following sections. 
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To dekit a Purchase order line: 

Select Supply>Dekitting>Sub-contract PO Item.  The PO Dekit transaction form opens. 

 

1. Enter a purchase order and line number.  The Quantity Released to the order will display. 

2. You can dekit any amount of the Released quantity that has not been received or completed 
to inventory.  Enter a quantity in the Reduce Release Quantity By field.  The Quantity 
Released will change accordingly.   

Using the Un-Release Order button 

The Un-Release Order button acts differently, depending on the quantity entered in the Release 
Quantity By field and the original order quantity released.  

Adjusted order quantity equals zero - When the quantity entered in the Reduce Release Quantity 
By field equals the original order released quantity, this action will remove ALL issues and ALL 
shortages.  The only exception would be issues that contain scrapped parts; which must be 
retained to preserve the scrap cost on the order. 

Adjusted order quantity is greater than zero - When the order quantity released is greater than 
zero after being adjusted by the value entered in the Reduce Release Quantity By field, this 
action will use the current exploded bill of materials to get a list of requirements for the Reduce 
Quantity By value.  First, it will remove any shortages up to the amount required by the exploded 
bill.  After shortages are removed, issues will be dekitted.   

PIP Issues Tab 

In the PIP Issues tab, click All to dekit all components, or select a component and click Dekit Line 
to dekit one item at a time.  
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PO Dekits Tab 

In the PO Dekits tab, you can review, change, or delete the quantity, stockroom, location, SN/Lot 
Number or Scrap the part. Each dekit is assigned a unique Issue ID number to track issues that 
would otherwise be identical. 

To Edit lines in the dekit: 

In the PO Dekits tab, select the component you wish to edit. 

 

1. Click Edit on the left side of the tab to open the PO Dekits form. From here, you can edit the 
Stockroom, Location, SN/Lot Number, Job Number, or Quantity; tag the dekit for a shortage 
or to scrap. 
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2. Select Create Shortage if you want MRP to plan to replace the dekitted parts.  It is not 
necessary to use this feature when you use the Un-Release button on the PO Dekits form 
(see the next section). 

3. Select Scrap Part to flag the system to associate the cost of the scrapped part to this 
particular order. You can dekit a part to scrap and specify a location without checking this 
box; however, the cost of scrap will not be tracked to this particular purchase order. 

4. Click Close to accept the dekit and return to the PO Dekits tab. Click OK, Add, Save as 
needed. 

Dekitting Parts to Scrap 

You have the ability to dekit components to scrap and create replacement requirements 
(shortages).  For example, if you are notified that a component is defective, you can dekit the 
affected sub-contract order assigning the component to a stockroom designated for scrap and 
create shortages to replace the components. 

To dekit a part to scrap: 

1. In the PO Dekits tab, select a component and click Edit. 

2. The PO Dekits form opens for the Issue ID selected in the tab.   

3. Select the Stockroom location for scrapped items. 

4. Select the Location for the scrapped item. 

5. Edit the quantity if needed. From here, you can edit the Stockroom, Location, SN/Lot 
Number, Job Number, or Quantity. 

6. Select Create Shortage if you want MRP to plan to replace the dekitted parts.  It is not 
necessary to use this feature when you use the Un-release button on the PO Dekits form. 

7. Select Scrap Part to flag the system to associate the cost of the scrapped part to this 
particular purchase order. You can dekit a part to scrap and specify a location without 
checking this box; however, the cost of scrap will not be tracked to this particular work order. 

8. Click Close to accept the dekit and return to the PO Dekits tab. Click OK, Add, Save as 
needed. 

Processing Scrap  

There are four basic ways to handle WO and SCPO scrap. They can be used to handle different 
situations. 

1. Dekit components to a scrap stockroom. Optionally, relocate inventory from the scrap 
department to an expense account upon disposal. By dekitting the components you will 
remove them from WIP. By relocating to an expense account you can make the 
corresponding adjustment to your accounting package. 

2. Dekit components to a scrap stockroom and choose the “Scrap Part” checkbox on the dekit 
detail screen. This will work like option #1 but will continue to track the cost of scrapped 
components to the work order. 

3. Complete finished goods to a scrap stockroom (later moving this inventory to an expense 
account). By completing units to a scrap stockroom you will reduce WIP and still be able to 
track the scrap expense. 
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4. Only complete finished goods (without scrap). This will leave all scrap expenses in WIP. You 
can periodically print the WIP report to get the current cost of WIP. You can then make an 
accounting journal entry to balance the WIP. The difference between the Alliance/MFG WIP 
and the accounting package WIP can be moved to a Material Usage Variance Account 
(expense account). 

Options 1 and 2 will track scrap at Component Cost only, while options 3 and 4 will include labor 
and burden. Some consideration to how far along in the manufacturing process the scrap is 
occurring is useful.  

Choosing the best options really depends on your situation. The following questions may help you 
determine the best route:  

• Will you re-issue material to replace scrapped components? If so then you should choose 
options 1 or 2. 

• Are components being scrapped? Or are fully built assemblies (containing all 
components) being scrapped? If only components are being scrapped then options 1 or 2 
should be used. For assemblies you should use 3 or 4. 

• Do you need to track the costs of scrapped components (e.g. Job Costing)? If so you 
should choose option 2. 

• Are variable quantities used? (e.g. mixing variable amounts of chemicals). If so then 
option 4 will probably work best. 

A variance adjustment is probably needed for any situation where: 1) a dekit has occurred but no 
material has been issued to replace it, and the order is completed at the full quantity, OR 2) a Kit 
was made for the full amount, but the Completion was made for a partial amount of the released 
quantity (and the WO has been closed). 
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Work Order Completions 
There are three (3) methods for performing work order completions within Alliance/MFG. 
Standard and Serialized method of completions are described in this section. Work Order 
Backflushing methods are described in the following section. 

Standard Work Order Completions 

To Complete a Work Order using the Standard method: 

You can perform either a full or a partial completion A transaction that is used to record the number of items 
completed against a specific work order and that are now available to inventory. of a work order. You may only 
perform completions against a work order that has been Released to production. Releasing a 
work order involves the act of kitting The process of removing components of an assembly from the stock room 
and sending them to the assembly floor as a kit of parts to make a work order's demanded assembly. This action may 
take place automatically whenever a full set of parts is available and/or it may be done only upon authorization by a 
designated person. /issuing components to the manufacturing department of the work order. 

Select Supply>Complete a Work Order to open a WO Completions form (opens at the Completed 
tab). 

 

5. Enter a WO Number or select one using the WO Number hyperlink. When you enter a 
WO, the part number displays in the header along with the Quantity Required, Quantity 
Released, and Default Stockroom and location, SN/Lot and Job Number, if applicable. 

6. In the Completions tab, enter a valid Quantity completed; that is, the quantity cannot be 
greater than was released. 

7. The completion transaction will now be listed when you select WO Completions View. 

8. You can change the stockroom and location, if needed.  

9. Click the Notes tab to enter any additional information. 
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10. When you are finished, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. 

Click Add on the toolbar to complete another work order.  

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving any entries not applied or saved. 

Serialized Work Order Completions 

To Complete a Work Order using the Serialized method: 

If Finished Goods or Sub-assemblies manufactured in-house are serialized (unique Serial 
Numbers assigned to each Quantity of One completed), the “Serialize Work Order Completions” 
process can be used. This will allow you to generate individual Work Order completions for a 
quantity of one (1) and to automatically generate and assign Serial Numbers to those individual 
completions.  

NOTE: 

Average Costing methodology does not allow for Partial Completions against a Work 
Order.  Because the “Serialize Work Order Completions” function is by its nature 
generating multiple Partial Completions, it cannot be used when Average Costing 
is selected in Preferences.  The screen will be available, but results will not be able 
to be saved. Additionally, Unit of Measure conversion will not work with the 
Serialize WO Completions function.  At the time “Save” or “OK” is pressed, any 
UOM conversions will cause the transaction to error out with the message “UOM 
Conversions Exist”. 

To insure that all transactions for a part number include a Serial/Lot number go to the Part 
Master>Inventory Codes tab. 
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11. Check the Require SN/Lot checkbox.  

12. You may also specify the SN/Lot Format. This can be any combination of letters and 
numbers up to 10 characters. Any part of a date (Month, Year, Day) may be included in 
the auto-generation by entering  *M, *Y, or *D in any combination. Sequential numbering 
fills in the remaining numbers. For example, the serial number SN03091847, would be 
the 47Th serial number automatically generated on September18, 2003 in the format 
“SN*Y*M*D”.  

13. If you do not wish to use 10 characters, enter your preferred format, then insert “#” for the 
number of characters you wish to use.  The system will increment those numbers.  In the 
example, the system has been set up to create serial numbers with a four-digit number 
that increments by 1. 

Select Supply>Serialize Work Order Completions 

The screen contains three sections.  The top section displays the work order and selected work 
order information; the middle section defines the quantity to complete, the serial number format, 
default SN/Lot Information and other common work order completion fields; the bottom section 
will display the serialized results in a list format, with buttons along the left side of the screen to 
add, edit or delete the records in the view, (much as other Transaction detail screens). 
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Work Order Section  

14. Enter a WO Number or select one using the WO Number hyperlink. When you enter a 
WO, the part number displays in the header along with the Quantity Required, Quantity 
Released.  

15. Click the Close Order checkbox if you wish to close the order with the completion. The 
work order selected for generating completions will be automatically closed if the 
completed quantity is equal to or greater than the required quantity. 

NOTE: 

The total quantity being completed will be validated at the time the transaction is “Saved” 
to allow for generating additional serial numbers. Many companies keep track of 
their serial numbers in a Log Book or spreadsheet (highly recommended). When 
serial numbers from this Log are used, they are marked off in the log book. If a 
serial number becomes unusable due to a damaged tag or another reason, then 
the next sequential serial number can be assigned. Alliance/MFG allows you to 
generate more serial numbers than are needed, and only validates the total 
quantity to complete at the time the transaction is applied, to allow you a method of 
handling this situation. 
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Generate Completions Section 

The Default Stockroom, Location, and Job Number, are displayed in the Generate Completions 
section, you may override these fields if needed. 

16. Enter the number of serial numbers to generate in the Quantity field.  No validation to the 
released or required quantities will exist here to allow you to generate serial numbers for 
more than the completed quantity, perhaps as a result of damaged serial number tags. 
 The value of this field will reset to zero (0) after the “Generate Completions” button is 
pressed.  At the time the Completion is saved, the quantity being completed will be 
validated, as mentioned above. 

17. The SN Format field defaults to the Serial Number Format on the Part Master record for 
the Part Number on the Work Order.  You can override this if needed. 

18. Enter the Starting Number. Must be greater than zero (0).  The value of this field will 
increment itself by one (1) after the “Generate Completions” button is pressed. As soon 
as at least one completion line is created (either manually or by pressing the “Generate 
Completions” button), the Work Order Number field will become disabled. 

19. Date Completed, defaults to “Today’s Date”.  You can override the date if needed. 

20. The First Serial Number and Last Serial Number will be displayed.  

21. Click on the Default SN/Lot Info button to open the SN/Lot Information screen. You can 
default an Expiration Date, Warranty Date, Maintenance Date or Notes for each of the 
SN/Lot Numbers to be generated. This step must be performed prior to step 7 below for 
any notes or dates to be included with the SN/Lot records. When you are finished click 
Close. 
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Click on the Generate Completions button to generate new Work Order Completion records for a 
quantity of one (1) each, up to the total number of completions entered in the quantity field above. 
 In this example we entered “25” and pressed the “Generate Completions” button, 25 separate 
records are created and listed in the serialized results section, appearing much like line items or 
other types of detail records.  After the completions list is built, the “Quantity” field, will reset to 
zero (0) and the “Start Number” field will increment itself by one (1) greater than the ending serial 
number. 
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Serialized Results Section 

If a serialized completion needs to be added, changed or deleted the three buttons on the left 
side of the Serialized Results section are enabled as needed. 

The Add button, will create a new serialized completion with the Work Order Number field (“WO 
Number”) disabled and un-editable.  In all other ways it functions the same as the standard Work 
Order Completions screen. 

The Edit button, will open the selected serialized completion in the standard Work Order 
Completion transaction screen. It functions the same as the standard Work Order Completions 
screen. 

The Delete button, will delete the selected serialized completion record from the list.  

If you are not sure one of the steps above was performed correctly, click on the Close button to 
discard the results and start over.  

When you are finished, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. If you did not 
generate serial numbers for the entire quantity completed, you may continue by 
starting again at step 1 above. 

Click Add on the toolbar to perform serialized completions for another work order.  

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving any entries not applied or saved.  
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Processing Scrap 

There are four basic ways to handle WO and SCPO scrap. They can be used to handle different 
situations. 

22. Dekit components to a scrap stockroom. Optionally, relocate inventory from the scrap 
department to an expense account upon disposal. By dekitting the components you will 
remove them from WIP. By relocating to an expense account you can make the 
corresponding adjustment to your accounting package. 

23. Dekit components to a scrap stockroom and choose the “Scrap Part” checkbox on the 
dekit detail screen. This will work like option #1 but will continue to track the cost of 
scrapped components to the work order. 

24. Complete finished goods to a scrap stockroom (later moving this inventory to an expense 
account). By completing units to a scrap stockroom you will reduce WIP and still be able 
to track the scrap expense. 

25. Only complete finished goods (without scrap). This will leave all scrap expenses in WIP. 
You can periodically print the WIP report to get the current cost of WIP. You can then 
make an accounting journal entry to balance the WIP. The difference between the 
Alliance/MFG WIP and the accounting package WIP can be moved to a Material Usage 
Variance Account (expense account). 

Options 1 and 2 will track scrap at Component Cost only, while options 3 and 4 will include labor 
and burden. Some consideration to how far along in the manufacturing process the scrap is 
occurring is useful.  

Choosing the best options really depends on your situation. The following questions may help you 
determine the best route:  

26. Will you re-issue material to replace scrapped components? If so then you should choose 
options 1 or 2. 

27. Are components being scrapped? Or are fully built assemblies (containing all 
components) being scrapped? If only components are being scrapped then options 1 or 2 
should be used. For assemblies you should use 3 or 4. 

28. Do you need to track the costs of scrapped components (e.g. Job Costing)? If so you 
should choose option 2. 

29. Are variable quantities used? (e.g. mixing variable amounts of chemicals). If so then 
option 4 will probably work best. 

A variance adjustment is probably needed for any situation where: 1) a dekit has occurred but no 
material has been issued to replace it, and the order is completed at the full quantity, OR 2) a Kit 
was made for the full amount, but the Completion was made for a partial amount of the released 
quantity (and the WO has been closed). 

NOTE: 

When you are completing a work order in either of the methods described above, you will 
receive a warning if an open shortage exists for that work order. This is a reminder 
to resolve any shortages prior to completing the work order. 
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Backflushing 
Backflushing differs from standard WO completions in that you do not need to create, release and 
kit a work order prior to the backflushing step. Backflushing provides a method for quickly and 
easily consuming component inventory at the time completions for the assembly are 
performed. Only the quantity of components required to complete a specific number of an 
assembly are consumed out of Inventory On Hand. 

Backflushing Work Order Completions 

Backflushing is performed through Supply>Backflush Work Order Completions. This option will 
open a window that will manage all the processes required for backflushing, including the creation 
of the Work Order, Kitting the Work Order, and Completing the Work Order.  The screen is 
divided into three sections. At each stage of the process, you have the option to edit the details 
for that step, should you need to, or simply allow each step to be processed without alteration. 
Backflushing will automatically create the two (2) separate transactions (KIT, CMP) and write 
them to the Alliance Transaction Log for processing through your accounting link. 

NOTE: 

If your company creates and uses work orders but you wish to Backflush rather than 
releasing, kitting and completing your work orders, you may select a work order via 
the Work Order Number hyperlink. See the Work Order Number paragraph below 
for details. You will not be able to take advantage of the Backflush Save All button. 

The Work Order 

When the backflush screen is opened a new blank work order will be created in the background. 
If you don’t have security rights to update the WO Required Date, WO Part Number, or WO 
Quantity fields you won’t be able to create a work order or perform the backflush function.  

 

Work Order Number 

When Auto-Numbering WO is on, but the work order has not been saved the typical “1: Auto Nu” 
will be displayed in the Work Order Number field.  When auto-numbering is off you will be 
required to enter a new WO number. 

Once the work order has been saved the work order number currently being completed will be 
displayed.  
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The hyperlink can be used to select an existing work order. By default the hyperlink will open the 
Work Order View using the “By Firm WOs” query.  Right mouse click will also offer the “All” and 
“By Part Number” queries. Selecting an existing work order via the hyperlink will also act like the 
work order has been saved and the backflush button will be disabled (see saving a work order 
below).  

Part Number 

If a work order has not been saved or selected you can enter or change the part number.   

The hyperlink will open the Part Master View using the “Is Makeable” query by default.  Right 
mouse click will offer the following additional queries: All, By Part Number, By Description. 

Quantity Completed 

Values entered into this field will be automatically entered into the Quantity To Start field on the 
Work Order created in the background. All field values entered into this screen will be 
automatically entered into the Work Order screen.  Likewise, entering a value into the work order 
screen created above will update the backflush screen. The WO screen is available to view or 
edit from the Edit Work Order button.  

 

Once you have entered valid data in these fields you may either click on the Backflush (Save All) 
button or perform each step manually. The manual option allows you to edit the individual steps if 
necessary.  

To manually backflush a Work Order 

Backflush Screen 

The backflush screen has three sections; the Work Order section, the Kit List section and the 
Completion section. Each section allows you to view, edit and save the changes prior to the next 
step. If you did not select an existing WO via the hyperlink or do not need to edit any section use 
the Backflush Save All button to save steps. 

Edit Work Order 

Prior to saving, kitting and completing the work order you can edit the work order.  This can be 
handy when extra information needs to be added (e.g. Job Number or Notes).  Click the Edit 
Work Order button to open the Work Order Header screen. After the work order has been saved, 
the button text will change to View Work Order. 

263 



Alliance/MFG User Guide 

 

Save Work Order 

The Save Work Order button saves the work order, all existing Alliance/MFG work order 
validation will apply. 

If the save fails, a message will be displayed stating the error condition.  A red X icon will appear 
next to the button indicating there is a problem. Hold the mouse cursor over the icon to view the 
error. Once successfully saved the Save Work Order button will be disabled. The text “Created 
Successfully” will be displayed in the Work Order section.  If an attempted save work order fails 
the text “Update failed” will appear.  

 

Building the kit list 

When you successfully save a Work Order or when an existing work order is selected via the WO 
Number hyperlink, a WO Kit List will be created and automatically kitted in the background.   

264 



Working with Supply 

NOTE: 

Backflushing does not use the existing Alliance/MFG Work Order Kit All algorithm. The 
existing Work Order “Kit All” algorithm will search all nettable stockrooms to find 
available inventory. If insufficient inventory is found, the Kit All routine will create a 
shortage. This is not done under the backflushing routine. The backflush procedure 
assumes that if you are backflushing, you have sufficient component inventory to 
pull and if not it is an exception and needs to be reviewed. The backflush routine 
will automatically kit all lines, pulling inventory from the components default 
stockroom/location only. If insufficient inventory exists in the default location a red 
X will be displayed in the Kit List section. You will not be able to proceed. You will 
need to click on the Edit Kit List button and manually pull inventory from another 
location for all component items indicated with a red X next to that line. You may 
delete a component line, but deleting a component with insufficient inventory will 
create a shortage.  

Edit Kit List 

The Edit Kit List button will be enabled whenever a work order has been saved or an existing 
work order has been selected via the hyperlink. Click on the Edit Kit List button to open the 
normal Alliance/MFG kitting screen. You can modify the issue list by adding new components, 
placing parts on short, or pulling inventory from an alternate location. Once a kit has been 
successfully saved the button caption will change to View Kit List. 
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Modifying the Kit List 

 

Pulling inventory from an alternate location. 

 

Save Kit List 

The Save Kit Kist will attempt to save the existing kit all existing Alliance/MFG work order kitting 
validation will apply. If the kit list is very large a status bar will display indicating the progress. 

If the save kit list is successful then the button will be disabled and the message “Kitted 
Successfully” will be displayed in the Kit List section.  If the attempted save fails the message 
“Update failed” will appear along with a message box stating the problem.  

Building the Completion 

After the kit has been saved the work order completion will be created in the background. 
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Edit Completion 

The Edit Completion button will be enabled after the work order kit has been successfully saved. 
Click the Edit Completion button to open the normal Alliance/MFG completion screen. You can 
add additional information to the completion (e.g. Job Number, Stockroom, Location, Lot Number 
or Notes),or change the completion quantity before saving if necessary.  

NOTE: 

If you change the completion quantity to less than the Backflush Quantity Completed it is 
assumed you did not complete all of the units previously kitted. The excess 
material kitted will be left in WIP.  

Once a completion has been successfully saved the button caption will change to View 
Completion. 

Save Completion 

The Save Completion button will attempt to save the existing completion. If the save is successful 
then the button will be disabled and the message “Completed Successfully” will appear.  If the 
save fails the message “Update failed” will appear along with a message box stating the problem.  
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NOTE: 

By default the work order will be closed by the backflush completion screen since the user 
is fully completing the order. Partial completions are not allowed in backflushing.  

Backflush (Save All) 

Clicking the Backflush (Save All) button will automatically perform each step: Create and Save 
the Work Order, Create and Save the Kit List and then Create and Save the Completion.  

When Auto-Numbering WO is on, but the work order has not been saved the typical “1: Auto Nu” 
will be displayed in the Work Order Number field. When auto-numbering is off you will be required 
to enter a new WO number. Enter a valid part number (ISC = Make or Phantom) or click on the 
part number hyperlink to select one. Enter the quantity being completed. The WO required date 
will be defaulted to the current system date. 

If any one of the three Save updates fail, the backflush process will stop. You will have to make 
corrections and manually continue the process. An error message will be displayed indicating any 
invalid condition. 
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Supply Reports 
The following reports are available from the Supply menu.  Predefined queries are available on 
submenus (indicated by arrows). You can preview or print a report from a predefined query, or 
create a custom query to display specific information in an Alliance/MFG standard format.  For 
more information about Alliance/MFG reports, see the Technical Reference. 

Open PO Line Items 

Past Due PO Receipts 

PO List by Part 

PO List by Supplier 

PO Totals Graph 

Purchase Commitment 

Purchase Order 

Part Cross Reference 

Production Schedule 

Pick List 

Subcontract PO Issues 

Supplier List 

WO Traveler 
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MRP Menu functions 
This chapter explains how to use the Alliance/MFG Material Requirements Planning (MRP) 
function. Once you have set up and entered all of your parts, BOM’s, suppliers and customers, 
verified your inventory accuracy and entered forecasts or customer orders, you will want to know 
what you need to order and build to meet your customers’ demands. The MRP function will help 
you achieve this goal.  
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Calculating MRP 
MRP Overview 

Material Requirements Planning provides your company with a time-phased material plan. MRP 
examines information from many sources as it undertakes the complex calculations to deliver 
your planning solutions.  

First, MRP analyzes what is required and when (Demand).  It considers all existing independent 
demands (sales orders, forecasts, safety stocks) and dependent demands (work order and 
subcontract PO component requirements, together with any existing shortages.) 

Next, it takes a detailed look at your current inventory and on order position (Supply) by reviewing 
all nettable stockroom inventories, existing purchase open orders, work-in-process, and the 
quantities and due dates associated with these parts. MRP also considers the ordering “rules” 
attached to these parts.  (Ordering rules are maintained in the Part Master for each part in the 
system.)  

Using this information, MRP calculates how long it will take to:  

Receive components 

Manufacture subassemblies 

Build the finished products 

After you run MRP, the MRP Action Parts list includes suggested actions based on existing and 
planned orders.  Planned orders are “suggested” orders generated by the MRP calculation. 
 Planned orders are created dynamically each time you run MRP. MRP will also suggest 
scheduling changes for existing orders if the delivery dates are out of phase. Each time you 
create firm/released work orders and schedule POs, the next MRP run will again recommend 
makes, buys and reschedules, level-by-level, based on the current information. 

NOTE: 

The Alliance/MFG MRP calculation is always a total regeneration of the plan based on the 
current information in the system. It is not a “net change” since the last run of the 
calculation program. 

MRP is at a minimum a four-step process: 

1 CALCULATE MRP – Run the MRP calculation for all product structure levels or top level 
products only. 

2 MRP ACTION PARTS - Review the items that require action as a result of running the 
MRP calculation. 

3 SCHEDULE – Create new orders or reschedule existing orders based on MRP 
recommendations. 

4 CALCULATE MRP AGAIN – Run the MRP calculation again to reflect the impact of your 
changes to the system and make any adjustments. 
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Calculating MRP 

You have two options when you run MRP: Run a full MRP on all product structure levels 
throughout the system, or Run a top-level MRP for finished products only. The top-level option 
can provide a quick overview of your current production’s ability to deliver existing customer order 
requirements.  MRP will assign priority codes for you to act upon based on established time 
fences, part master ordering rules and requirement due dates.  You can then review and process 
your MRP Action Parts list by priority code and schedule or change dates as required, addressing 
the highest priority first (most critical is actually lowest value).  (See Reviewing MRP Results and 
Priority Codes later in this section.) 

Running MRP 

MRP is a static system: When you create POs and WOs, or reschedule existing orders, you must 
rerun the MRP calculation to reflect the impact of your changes.  Each calculation is completely 
regenerative; it considers all transactions, not simply the net changes since the last MRP run. 

To Calculate MRP: 

Select MRP>Calculate MRP to open the MRP Planning dialog box. 

 

Select Full MRP to calculate all product structure levels; or select Top Level Only to calculate 
MRP for finished products only.  

Establish the Normal Priority Time Fence - MRP output is categorized into units of work to be 
done on the basis of priority. The Normal Priority Time Fence is a limiting date that defines the 
end of a time period for current planning.  This time fence is based on the start date of the order 
(start in current period vs. start in a future period).  MRP suggested orders with a planned start 
date between the day you calculate MRP and this “Normal” date will be given a priority code of 
“3”. These orders are considered to be “within the current time fence,” and are candidates for 
conversion to Firm PO’s or Firm WO’s (a PO placed with a supplier or a WO scheduled to start in 
production). All planned orders with a start date greater than this date (future orders) will be given 
a Priority Code of “6”. See Priority Codes later in the MRP Action Parts section for more 
information about priority codes. 
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The system default date for the normal priority fence is one week (7 days) ahead. You may want 
to establish your normal priority fence differently, depending on how frequently you calculate 
MRP, or according to other factors that influence your production schedule.  

Minimum number of days to reschedule -  This parameter establishes the minimum number 
days that MRP will use to generate Reschedule messages (Priority = 4). This will help reduce the 
erroneous “move it in 1 day, then move it out 1 day” messages and will also aid in limiting your re-
scheduling efforts with suppliers and production. For example, if you set the minimum number of 
work days for reschedule to “5,” there will be no reschedules messages of less than five work 
days generated.  An exception to this is late orders, if an order will be late (could impact 
production schedules or customer shipments), MRP will generate an Expedite notice (Priority = 
5). 

CAUTION! 

 When MRP recommends rescheduling a firm Work Order, it will continue to plan 
the components on the current WO start date until you reschedule the order, 
including both start and complete dates, and subsequently rerun MRP.   
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MRP Action Parts 
After you run MRP, the MRP Action Parts list includes suggested actions based on existing and 
planned orders.  Planned orders are “suggested” orders generated by the MRP calculation. 
 Planned orders are created dynamically each time you run MRP. MRP will also suggest 
scheduling changes for existing orders if the delivery dates are out of phase. Each time you 
create firm/released work orders and schedule POs, the next MRP run will again recommend 
makes, buys and reschedules, level-by-level, based on the current information. 

After you calculate MRP, Alliance/MFG gives you several options to access the results.  Select 
MRP>MRP Action Parts to review MRP recommendations.  

 

Reviewing MRP Action Parts 

The records displayed in the MRP Action Parts View depend on the query you select. Select 
MRP>MRP Action Parts>Current Action Parts (only those with current or past due action 
recommendations), or MRP Action Parts>All (all parts regardless of action), or By Part Number, 
or By Buyer/Planner, or By Job Number or use a predefined query and wild cards to locate 
specific action parts.  In the following example, we selected the MRP Action Parts All query to 
open the list. 
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The MRP Action Parts View displays the following information:  

Priority - Displays the MRP Priority Code for the line item (Priority Codes 1-7). MRP Action Parts 
lists are displayed in Priority Code sequence by default; however, you can click on column 
headers to change the sort order. 

Part Number - Part number of item requiring MRP action. 

ISC - Inventory Source Code (Make or Buy from the Part Master). 

OMC - Order Method Code (How to order/build from the Part Master).  

Employee ID – The Buyer/Planner Employee ID. 

Last Name - Name of employee responsible for make/buy decisions for this part (A buyer/planner 
can be associated with a commodity code which can be assigned to individual or groups of parts 
in the Part Master). 

Description - Part Master description of the part. 

Department Code – Part Master department number associated with the part. 

Stockroom Code – Part Master default stockroom assigned to the part. 

Commodity Code – Part Master commodity code assigned to the part. 

Priority Codes Definitions 

If more than one (1) MRP Action item is generated for a given part number, the priority code 
displayed in the action parts list is the highest priority (lowest number = most critical) generated 
during the MRP calculation for that part. 

NOTE: 

Priority Codes 1 and 2 are the most urgent; however, it is possible for additional priority 
codes (other actions) to exist for part numbers assigned priority codes 1, 2, or 3. 
Be sure to review all MRP suggestions for each part. 

1  = Past Due - The completion date for a recommended order is prior to the MRP run date 
(urgent, this part should have already been received into inventory) . 

2  = Past Due - The start date for a recommended order is prior to the MRP run date (urgent, this 
part should have already been started in production or ordered from a supplier). 

3  = Within Normal Fence - The start date for the recommended order is normal or current 
(within the MRP “Normal Time Fence” you established above). You should be scheduling these 
orders to start in the current scheduling period. 

4  = Reschedule - This order is out of phase and requires rescheduling: either a move-in, a 
move-out, or a delete. You may limit the number of reschedule messages (Priority = 4) generated 
by establishing a Minimum number of days to Reschedule during MRP.  

5  = Expedite - This order’s required date is within the parameter for skipping a reschedule 
(minimum number of days to reschedule), but the order will be late and should be expedited. 

6  = Future - Start date is beyond the current period (future start) and no action need be taken at 
this time. 

7  = No Action Required - No action required at this time.  The part has no MRP activity in the 
current schedule, the part’s existing schedule is in phase, the recommended action is to skip a 
minor reschedule, or lastly the part has an OMC of  Manual (Do not plan in MRP). Note: Do not 
plan in MRP does NOT mean do not review, requirements may exist for this part. 
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MRP Action Details 

Highlight a part in the MRP Action Parts View then press the Enter key or double click to open the 
MRP Detail View.  

In addition to the information displayed on the MRP Detail View, the header displays part 
inventory information including the Job Number (if any), quantity on hand when MRP was run, 
any safety stock defined for the part, any specific order quantity and/or order multiple, scrap or 
yield factor, and the manufacturing or procurement lead time.

Note: 

The safety stock for parts with the Inactive flag set will appear and be treated as zero (0) 
by the MRP calculation. 

  

The MRP Detail View grid contains information in the following columns: 

Action - There are five (5) types of MRP Action: 

1. Blank - No action required 

2. Delete - The current MRP plan does not require this order 

3. Create - MRP recommends a new PO or WO should be created. Examine the Start Date 
to see when; the Schedule button will be activated if the item is highlighted. See 
Scheduling purchase orders and work orders from MRP, later in this chapter 

4. Move In - MRP recommends a reschedule, the recommended move in to date will 
appear in the Move Date column; the Schedule button will be activated if the item is 
highlighted. See Scheduling purchase orders and work orders from MRP, later in this 
chapter 
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5. Move Out - MRP recommends a reschedule, the recommended move out to date will 
appear in the Move Date column; the Schedule button will be activated f the item is 
highlighted. See Scheduling purchase orders and work orders from MRP, later in this 
chapter 

Start Date - Date on which order is scheduled to begin (based on lead time offset from required 
date, and on your company’s Holiday Schedule).  On Demand grid lines that subtract material 
from inventory, such as kitting a Work Order or shipping a Sales Order, this field will be blank. 

Required Date - Date that the order is required by or scheduled to be completed by based on 
MRP. 

Move To – The date MRP recommends an order be rescheduled to. 

Reference/Reference Line - Work Order, Sales Order, Purchase Order, or MRP Planned Order. 
Reference Number.  The MRP Planned Order Reference is a unique sequential number assigned 
by MRP. The number “0000000001” represents the first planned order generated by MRP during 
this MRP calculation. 

Start Quantity - Quantity based on the ordering rules established in the inventory record for the 
product and/or calculated by MRP.  (The quantity required is multiplied by the yield factor.) 

Required Quantity - Quantity required calculated from MRP demand (independent or 
dependent).  The calculation uses the appropriate ordering rules from the inventory record. 

Balance - The quantity available on that date should all MRP actions be implemented. If safety 
stock is used, this will be the quantity available on that date less the safety stock. (Note: Safety 
stock will not be deducted until the current period/date). 

Pegging - The dependent demand part number (next level sub-assembly or assembly ) that 
created the requirement.  

Part Number - The part number involved with the action. 

Job Number - The job number involved with the action. 

Post Type - There are eleven (11) MRP Post Types: 

1. Firm PO, an open purchase order (Supply). 

2. Firm WO, an open work order that has been released (Supply). 

3. WO Shortage, a work order kit requires this part (Demand). 

4. PO Shortage, a sub-contract purchase order kit requires this part (Demand). 

5. Sales Order, an open sales order requirement (Demand). 

6. Forecast, a forecast requirement (Demand). 

7. Currently not used. 

8. Planned PO, an MRP recommended purchase order (Planned Supply). 

9. Planned WO, an MRP recommended work order (Planned Supply). 

10. Planned Kit, an MRP recommended order kit (Planned Dependent Demand). 

11. Safety Stock, an inventory replenishment requirement (Demand).
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Scheduling PO's & WO's from MRP 
Alliance/MFG makes it easy to schedule POs and WOs directly from the MRP Detail View without 
having to navigate through the menu system to the Supply function.  

Scheduling Purchase Orders and Work Orders from MRP  

Select a part from the MRP>MRP Action Parts form, double click to display the MRP Detail View, 
then simply select a “Create” line recommended for scheduling and click the Schedule button. 

or  

At the MRP>MRP Action Parts form, use the Query button in the toolbar to filter the planned 
purchase orders for a particular Buyer/Planner ID. Then select a part from the MRP Action Parts 
form, double click to display the MRP Detail View, then simply select a Create line recommended 
for scheduling and click the Schedule button. 

The MRP Action Parts scheduling form opens for the part selected. The options available depend 
on whether you are creating a Work Order or a Purchase Order. 

Schedule a Purchase Order from MRP Detail View 

Alliance/MFG gives you lots of flexibility when scheduling purchase orders from the MRP Detail 
View. You can decide whether to use the dates and quantities suggested by MRP, to edit the 
planned orders, or combine quantities and dates based on your knowledge, experience and the 
current plan. You may also select a supplier (see Part Cross Reference, Chapter 4, Products), 
display a list of that supplier’s open purchase orders and then decide whether to create a new 
purchase order or add a line item to an existing open order.  

MRP Action Parts Purchase Order: 

1. Select a planned order for a part from the MRP Action Parts list. 

2. Click Schedule to open the MRP Action parts form for the part selected.  
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The Part Number and description display at the top of the form. 

From here you can either add the requirements to any existing PO or create a new one. 
To create a new PO: 

1. In the Schedule Selected Lines box, select the Planned Order quantity you wish to schedule 
as one PO line item. If you wish to combine two or more quantities, hold down the shift key 
and highlight all lines to be combined. If you don’t want to schedule all the recommended 
quantity, change the quantity in the Quantity box, the Required Quantity will display the 
quantity remaining to be scheduled, which may then be added as a second line item with a 
different delivery date or purchased from another supplier.  

2. Enter a Supplier/OEM part number or click the hyperlink to choose one from the list. If no 
Supplier/OEM part number exists for this part, click the Supplier ID hyperlink to choose a 
supplier from the list. 

3. Click the Create PO button at the bottom of the form to create a new PO. 

To add to an existing PO: 

1. In the Schedule Selected Lines box, select the Planned Order quantity you wish to schedule 
as one PO line item. If you wish to combine two or more quantities, hold down the shift key 
and highlight all lines to be combined. If you don’t want to schedule all the recommended 
quantity, change the quantity in the Quantity box, the Required Quantity will display the 
quantity remaining to be scheduled, which may then be added as a second line item with a 
different delivery date or purchased from another supplier. 

2. Enter a Supplier/OEM part number or click the hyperlink to choose one from the list. If no 
Supplier/OEM part number exists for this part, click the Supplier ID hyperlink to choose a 
supplier from the list. 

3. Click the Add to PO hyperlink to open the Purchase Order View listing all open POs for that 
supplier. 

4. When you reference an existing PO in the Add to PO field, the Create PO button changes to 
Update PO.  Click the Update PO button, the Purchase Order form for that PO will be 
displayed. 

5. Either way, a purchase order form for the part selected will open. Add any additional 
information required and adjust the due dates as required. Verify the Purchase UOM is 
correct. Save the information just as if you were creating or editing a PO from the Supply 
menu.  (See Supply, Purchase Orders) 

6. You can continue to select lines from the Schedule Selected Lines box and update or create 
new POs until you have taken all the actions necessary. To complete the purchase order, do 
one of the following: 

Click Save on the toolbar to save the purchase order and leave the form open. 

Click OK to accept the new purchase order as is, exit the form and return to MRP. 

Click Close to exit the form without saving. 

Click Close to exit the MRP Action Parts form.  From here, you can do one of the following: 

1. Select another MRP item and continue to schedule POs (or WOs). 

2. Click Close to exit the MRP Detail View. 

Schedule a Work Order from MRP Detail 

Work orders can be scheduled from planned orders. You decide whether to use the dates and 
quantities suggested by MRP or enter your own specific quantities and dates.   
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MRP Action Parts Work Order: 

1. Select a planned order from the list. The Schedule button is activated on the bottom of the 
Action Parts dialog box. 

2. Click the Schedule button to open the Work Order data entry form.  If you have Auto Number 
set as a Preference, the Work Order Number will fill in with the next generated number when 
you click Save or OK. 

3. The WO Detail tab data will default from the line item selected on the MRP Detail View. 

4. To finish the work order, do one of the following: 

Click Save on the toolbar to save the work order and leave the WO form open. 

Click OK to accept the new work order as is and return to the MRP Detail View form to 
continue scheduling this part. 

Click Close to exit the WO form without saving. 

To exit the MRP Detail View form click Close   From here, you can do one of the following: 

1. Select another MRP item and continue to schedule POs (or WOs).  

2. Click Close to exit the MRP Action Parts form. 

Reschedule 
Reschedule a PO or WO from the MRP Action Parts screen: 

Work orders and Purchase Orders can be rescheduled directly from the MRP Action Parts 
screen. You must decide whether to use the dates suggested by MRP or enter your own specific 
dates.  If you do not use the dates suggested by MRP, the next time MRP is calculated the order 
will receive the same reschedule message if it is still required. You must notify the buyer/planner 
at the requirement level if you are unable to meet the suggested date.  

To reschedule an order from the MRP Action Parts form: 

1. Highlight the order in the list. The Schedule button is activated on the bottom of the Action 
Parts dialog box. 

2. For a Work Order, click the Schedule button to open the order’s data entry form.  

3. For a Purchase Order, click the Schedule button to open the order’s data entry form. Select 
the PO Lines tab, and then click the Edit button to open the correct PO line item. 

4. The proposed reschedule dates will be defaulted to the orders date fields. 

5. To finish rescheduling the order, do one of the following: 

Click Save on the toolbar to save the order and leave the form open. 

Click OK to accept the new order as is and return to the MRP Action Parts form to 
continue scheduling this part. 

Click Close to exit the form without saving. 

Click Close to exit the MRP Detail View form.  From here, you can do one of the following: 

1. Select another MRP item and continue to schedule POs (or WOs). 

2. Click Close to exit the MRP Action Parts form. 

Demand Pegging 

Using Pegging to review the MRP Action for the Demand 
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NOTE: 

Alliance/MFG uses single-level pegging to facilitate the audit trail that identifies the origin 
of a given requirement.  

Highlight a row with a Post Type of Planned Kit, the Pegging column displays the origin (Demand) 
part number of the requirement. 

 

To review the MRP Action View for the origin (Demand) part number, go to the Sidebar and click 
on MRP By Pegging.  
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The MRP Action Parts view for the Demand part number is displayed. You are now able to review 
and decide if the entire requirement quantity is actually needed or is a lot size (build quantity) and 
could perhaps be reduced. 

 

IMPORTANT MRP TIP: 

Because MRP is a powerful dynamic planning tool, Firm WOs should be scheduled only 
as they are about to be sent to the factory floor.  This is a function of the “Normal 
Time Fence”, and requires careful attention when establishing your MRP policies 
and procedures. This will allow MRP to generate new planned orders and minimize 
the need to reschedule released work orders.  It is important to process all deletes 
and reschedules first, then rerun MRP, continue this process level by level until the 
action item list is free of deletes and reschedules, the last step is to create new 
WOs and POs. Remember, if you cannot satisfy a required date, you must inform 
the buyer/planner of the part creating the demand. 
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MRP Reports 
Material Requirements Planning reports can be printed at any time; however, they will reference 
the last MRP calculation. For accurate reporting, it is advisable to calculate MRP and then 
request relevant reports.  Use the standard reports available from the Reports menu, or create a 
custom query.  For more information about Alliance/MFG reports and custom queries, see the 
Alliance/MFG Technical Reference.  Standard reports available from the MRP menu are:  

Exception Report 

Manual Parts List 

Planned Orders 

PO Commitment Graph 
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Inventory Menu Functions 
Inventory Control Overview 

Alliance/MFG Inventory Control tracks stock information about all of your parts. Initially, parts are 
entered in the system by Engineering or those responsible for product design and bills of 
material. Once entered part records are available to the Inventory Control functions via the 
Inventory>Part Maintenance menu.  Here you can assign manufacturing information, track 
serial/lot numbers, enter and update part costs, perform product structure cost roll ups; and 
perform physical inventory counts and ABC analysis.  The Inventory Control menu contains all 
the tools you need to maintain detailed information about stock, quantities on hand, ordering, and 
manufacturing information; and perform miscellaneous inventory transactions at your discretion.   

Order methods, inventory source codes, lead times, order quantities, order multiples, safety 
stock, and yield factors entered in the MRP Planning tab of the Part Maintenance data entry form 
give MRP the information it needs to plan to meet your demands on time.  Assign various 
categories to parts, such as Commodity Codes, Departments and Stockrooms, and ABC codes in 
the Inventory Codes tab. 

Once your system is up and running, you can access statistical information about every part in 
the system from the Part Master Statistics tab. 

Tasks described in this section assume familiarity with the basic use of Alliance/MFG data lists, 
data entry forms, dialog boxes, queries, and finding and sorting features.  If you need more 
information about how to use these features, review System Overview. 
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Part Maintenance 
Inventory Part Maintenance defines additional information about your parts manufacturing 
attributes.  From here you can enter codes and parameters that affect MRP Planning; assign 
product revenue codes, and alternate unit of measures; calculate lead times, maintain cost 
information; and review part statistics such as when a part was added to inventory, the date of the 
last cost revision, and year-to-date usage.  

Maintaining Part Information 

Select Inventory>Part Maintenance>Edit and enter a part number  to open the Part Master data 
entry form for the part.  The Part Number displays in the header, along with the revision and 
description entered with the part number. The Engineering Tab contains the initial data set up by 
your product designer/engineers. If information on the Engineering Tab needs to be completed, 
see Setting Up Your Products>Part Master for details. 

Part Maintenance information is added in the MRP Planning, Inventory Codes, and Part Costs 
tabs.  Enter information in the fields as described in the following sections.  

MRP Planning Tab 

MRP Required Fields 

The MRP calculation uses information entered here to determine what type of order to 
recommend when it encounters demand for the part—either a purchase order, work order, or 
subcontract purchase order.  You must enter an Inventory Source Code and an Order Method 
Code if you want MRP to plan for this part.  The default inventory source code is “Buy” and the 
default planning method is “Include in MRP”. Click the down arrow next to the field to select 
another option. 
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Inventory Source Code (ISC)  

The Inventory Source Code identifies which parts you will make, which parts you will buy, and 
which parts are phantom assemblies (make-ons), bulk and non-inventory items. The MRP 
calculation uses this information to determine what type of order to recommend when it has 
unsatisfied demand for the part. 
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ISC Code Definitions 

Buy Part - Purchased parts 

Free/Bulk Stock - A buy part that is a component on a BOM and included in MRP 
planning, but not issued via work order kitting. These stock items are typically issued to the 
floor via a Misc Issue in bulk.  For example, a bin of insulation material or a bucket of 
nuts/bolts/screws could be coded Free/Bulk Stock because they are used on numerous 
parts but not generally kitted individually on each work order.    

Make Part – Components manufactured or assembled in house. 

Non-Stock Part - Items not part of normal production stock (office supplies, expense, 
capital items). These items would not be considered in MRP planning. 

Phantom Part - Blow Through/Make on items - Not planned or stocked; when these parts 
have demand, MRP plans their components. (For more information about Phantom parts, 
see Chapter 4: Products.) 

Subcontract Part – These parts are typically purchased on a PO. They may have a BOM 
and be kitted then sent out for assembly or they may require an added service, such as 
plating, machining, and so on.  

Order Method Code (OMC) 

The Order Method Code determines how MRP includes a part in the planning schedule or 
whether to consider the part in its calculation at all. Click the down arrow next to the field to select 
an option. 

 

OMC Code Definitions 

As Required, Plan Lot for Lot - Uses the order quantity as a lot size. For example, if your 
order quantity is 100, and you need 90, MRP will recommend an order of 100; if you need 
105, MRP will recommend two orders of 100 each. 

Job Tracking, Plan by Job - MRP generates discrete POs and plans discrete WOs for 
parts required by sales orders assigned a Job Number. Each Job number will generate a 
unique set of MRP action items and a summary action item will be created for all non-job 
activity. Job tracking uses order quantity and order multiple to determine planned orders. 
 (See MRP Planning for more information about accessing MRP Actions for Job coded 
parts.) 
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Manual, Do not plan in MRP – These orders will appear on MRP, but no automatic action 
will be taken. Be sure to review all manual parts. 

Include in MRP Calculation - Uses all ordering rules and quantities to determine planned 
orders. Review each quantity field below to determine how each will affect the number of 
orders and order sizes generated. 

NOTE: 

If you are importing your parts to reduce your initial setup time. The Import/Export routine 
requires a single digit code for both ISC and OMC. The codes are listed below: 

 ISC Codes                                   OMC Codes 

B = Buy                                     A = As Required (Lot for Lot) 

F = Free                                    J = Job Tracking 

M = Make                                  M = Manual, Do not plan 

N = Non-stock                          P = Include in MRP 

P = Phantom 

S = Subcontract 

MRP requires additional information to plan your parts correctly, minimally this includes a 
Department, a Stockroom, a Location, a purchase or manufacturing Lead Time, and an Order 
Quantity.  

LINK NOTE: 

 If you use an Accounting Link, refer to your Link documentation before setting up 
departments, stockrooms, accounts and locations. 

Department Code 

A department identifies a specific cost center in the manufacturing process. Each department 
number is assigned a corresponding General Ledger account number.  Manufactured parts are 
usually assigned a department number that represents a work in process cost center; purchased 
parts do not require a department code unless they are "Subcontract Parts" that have component 
material kitted and sent to the supplier for processing/assembly.  Enter the Department number, 
the department description will display to the right of the code.  

Stockroom and Location 

Each and every Alliance/MFG inventory transaction such as a PO Receipt or PO Return, a WO 
Kit or Dekit, a WO Completion, a WO Backflush, or a SO Shipment or SO Return use stockrooms 
and locations to track inventory movement in the system. All part numbers must be assigned a 
stockroom, and a location within that stockroom, to describe its physical warehouse location.  You 
can also set up corresponding General Ledger accounts for each stockroom.  Once a code 
selected and entered the description of the stockroom and location will display to the right of the 
codes.  

Kit From Stockroom and Location 

You can also assign a default “Kit From Stockroom” and “Kit From Location” separate from their 
default “Stockroom” and “Location”, which are used for receiving and completion transactions. 
 The “Kit From…” defaults are used in Backflushing, Work Order Kitting, and Sub-Contract PO 
Kitting to control where Inventory is pulled from.  Inventory will pull in the following sequence 
when these fields are filled out: 
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1. Job-assigned material 

2. Kit-from Stockroom and Location 

3. Ignore all other inventory 

If the “Kit From…” fields are left blank, Kitting will behave as normal. 

Lead Time 

MRP uses this number to calculate the number of working days needed to process and receive or 
manufacture parts to meet a required date.  For example, if you specify a 10 day lead time for a 
part, MRP will create a work order or purchase order with a suggested start date 10 working days 
prior to the required date.  Be sure to include order processing, transit, inspection and dock to 
stock times in this number.  

Defining Lead Times 

Lead Time is one of the most critical pieces of information used in the MRP calculation. A lead 
time must be defined in the Part Master for every part in the system. The lead time determines 
the date MRP recommends you start orders for required parts.  For example, if your company 
manufactures Red Widgets, you might use lead times as shown in the following product structure:  

Red Widget: ISC: Make Part, Lead Time 5 

Red Paint: ISC: Buy Part (1 per Red Widget), Lead Time 3 

Widget: ISC: Make Part (2 per Red Widget), Lead Time: 6 

Wood: ISC Buy Part (2 per Widget, or 4 per Red Widget), Lead Time: 3 

You need not account for the lead times of component materials when determining the lead time 
for manufactured parts (all parts carry their own lead time); the MRP calculation accumulates and 
offsets lead times automatically. In the example below, the lead time for the Red Widget is five 
days. This is the number of days it takes to make Red Widgets assuming the component parts 
(the paint and widgets) are in stock. 

MRP uses backward scheduling. Therefore, it subtracts the lead time from the required date to 
determine the start date for an order, calculating only the days your company is scheduled to be 
open (as established in your Company Preferences and Calendar).   

For Example: 

You receive an order for 100 Red Widgets due to ship on Monday, July 21, 200X. Assume that 
you have zero inventory on-hand and an Order Quantity of one for each part. You run the MRP 
calculation. 

MRP would plan an order for Red Widgets to be completed Friday, July 18th (one production day 
before it is scheduled to ship) and subtracts the lead time: 5 days. MRP will calculate the start 
date of the work order to be Monday, July 14th.  
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Because it is a Make part, MRP then explodes the Red Widgets Bill of Materials and determines 
that you need to have 100 units of Red Paint available for use on Monday, July 14th (the day the 
Work Order will begin).  Because it is a buy part, MRP will suggest a Purchase Order for 100 
units due Friday, July 11, and will recommend you place the order on Wednesday, July 9th: 3 day 
lead time. MRP also determines that you need 200 widgets ready for use on Monday, July 14 
(MRP utilizes the quantity per on the BOM of the assembly). It again calculates the required date 
as Friday, July 11th, then backs off by the lead time to Friday, July 4th, 6 day lead time. MRP 
recommends the start date on the July 3rd, because the 4th is in the company calendar as a 
holiday, (Remember, the MRP calculation counts production days only). Finally, it determines that 
you need 400 pieces of wood, and recommends a Purchase Order that starts on Monday, June 
30, with a required/due date of Wednesday, July 2nd.  The following calendar illustrates this by 
date. 

 

In summary, lead time should be calculated from the moment the requirement is recognized to 
the time the parts are available for use in the stockroom.  Lead time therefore includes 
administration time, process and manufacturing time, in-transit time, and inspection time. 

MRP Optional Fields 

Order Quantity 

The order quantity is the minimum number of parts you want to order. This may vary part-by-part, 
depending on your purchasing and manufacturing requirements.  For example, you might get the 
best price for ordering springs in lots of 100,000. This is where you configure your ordering rules 
to help you take advantage of this price break.  

If the OMC for this part is set to either Include in MRP Calculations or Job Tracking, Plan by Job, 
MRP will recommend this quantity as a minimum order whenever this part is ordered. For 
example, if you require 900 parts but you enter 100,000 in this field as your order quantity, MRP 
will recommend a planned order for 100,000. MRP only recommends, you may override MRP and 
order 900 or any other quantity. If the part is still in an ordering position (negative availability) the 
next time MRP is run, it will recommend another order.  

If the OMC for this part is set to As Required, Plan Lot-for-Lot, MRP will recommend orders in lot 
sizes equivalent to the order quantity. For example, if you need 900, and your order quantity is 
1000, MRP will recommend 1000. If you need 1200, MRP will recommend two orders for 1000 
each.  

This quantity is based on the stocking unit of measure.
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Costing EOQ 

This field allows you to separate the “Order Quantity” value for Material Planning from the 
calculation of Setup Cost per Unit.  For example, you may wish to have MRP always recommend 
exact quantities to match demand by setting your “Order Quantity” to one, while amortizing the 
Setup Cost across an average production lot size of 200 units. 

Yield Factor 

The percentage yield The ratio of usable output completed from a process to the materials input to the process. 
Yield is usually expressed as a percentage and may be in terms of total input or of a specific raw material. (or loss) for 
a part. MRP multiplies the quantity required for a part by yield factor to calculate the start 
quantity The required quantity multiplied by the scrap factor (yield). .  The default is 100 (100%), MRP plans 
for the exact amount. For example, if you must start 200 to complete 150, enter 133 in this field. 
(This number must be greater than or equal to 100.) To determine the factor, divide the quantity 
to start by the required quantity, and convert to a percentage.  

Order Multiple 

Every order of this part must be a multiple of this number.  For example, if you can only buy eggs 
by the dozen, every egg order must have an order multiple of 12.   

Safety Stock 

The number of parts you keep on-the-shelf as a cushion (in the Stocking UOM). MRP considers 
forecasts, sales orders and safety stock when calculating demand.  When a parts inventory falls 
below the specified safety stock quantity, MRP recommends a planned order to replenish the 
safety stock. This entry can also be used as a reorder point if you add lead time coverage to the 
safety stock quantity. 

CAUTION! 

Safety stocks distort MRP priorities and increase inventory; use them sparingly! 
For parts with the Inactive flag on the safety stock will appear and be treated 
as zero (0) by the MRP calculation.   

Remember, MRP is your tool, not your master.  Its ultimate goal is to keep both costs and 
inventory low; however, you are always free to modify and/or interpret its recommendations.  For 
more information see Material Requirements Planning. 

Inventory Codes Tab 

You can further define parts in inventory by applying additional codes in the Inventory Codes tab. 
 For example, you can apply a Product Class code to a part and assign a general ledger account 
to track revenue and expense information.  Or you can assign an ABC code to define the part 
value relative to other parts in the system via the ABC analysis.  The following paragraphs 
describe how each code is utilized by Alliance to help you control your parts. 
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Commodity Code 

Commodity codes categorize your parts by related type. Depending on how you set up your 
commodity codes, you associate a buyer/planner with that commodity.  For example, if one buyer 
purchases all machined parts, assign a commodity code for the buyer associated to those parts. 
 Now you can display  MRP Action parts by Buyer/Planner.   

Pur/Mfg UOM 

If you purchase or manufacture in a different unit of measure than the stocking unit of measure, 
enter the alternative here. MRP uses this unit of measure to compute the number of parts 
required when generating work orders and purchase orders. You must have defined a UOM 
conversion between this UOM and the Stocking UOM in your Company Preferences and in your 
Codes Tables. See Setting up your Company for more information. 

Product Class Code 

The product class code can be used to assign General Ledger accounts to part numbers for 
reporting or tracking the revenue/expense accounts for this part when it is shipped.   

LINK NOTE: 

If you use an accounting link, this information will be passed through the link. Enter a 
Product Class Code, or use the hyperlink to choose from Product Class Code list. 
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System Used On Code 

You can categorize parts by product line.  This data is not used in any MRP calculation; it simply 
provides an additional way to group or identify your parts.  For example, if you manufacture red 
and blue pens, you can separate parts used on red pens from parts used on blue pens and view 
data separately for each.  

Product Discount Code 

The Product Discount Code Assigns a price type and description to a specific part for list price discount 
application. in combination with the Customer Discount Level will be used in establishing your Price 
Break Structures. You can apply different discounts for red pens versus blue pens on a per 
customer per order quantity basis. See Setting up your Company>Codes for more information.  

ICN Code 

If you use Intrastat Reporting Tracks, use this field to define ICN material type for this part.  This 
information will then be used for Intrastat Reporting features. 

ABC Classification 

You can assign an ABC classification here, or if you run an ABC Analysis, the system will update 
it.  When you run the ABC analysis, Alliance can classify your parts in relative value of 
importance according to the value category/type you assign.  

Require SN/Lot 

To insure that all transactions for a part number include a Serial/Lot number, check the Require 
SN/Lot checkbox. You may also specify the SN/Lot Format. This can be any combination of 
letters and numbers up to 10 characters. Any part of a date (Month, Year, Day) may be included 
in the auto-generation by entering  *M, *Y, or *D in any combination. Sequential numbering fills in 
the remaining numbers.  

For example, the serial number SN03091847, would be the 47Th serial number automatically 
generated on September 18, 2003 in the format “SN*Y*M*D”.  

If you do not wish to use 10 characters, enter your preferred format, then insert “#” for the number 
of characters you wish to use.  The system will only increment that number of characters.   

Average Catch Weight 

Enter the average weight of the product when shipped in the Catch Weight UOM. The sales order 
shipping transaction screen will require the shipping clerk to enter the actual weight of the 
shipment. This average weight will be used to calculate the actual cost of the shipment when 
variable weight products are shipped.  

Catch Weight UOM 

Enter the Catch Weight UOM. The sales order shipping screen will require the shipping clerk to 
enter the actual weight of the shipment in this unit of measure.  

The actual catch weight when compared to the average catch weight will be used to calculate the 
actual cost of the shipment when variable weight products are shipped.  

Standard Hours 

Enter the number of hours required to produce one unit of this part. This cost can be maintained 
and updated via your Labor Router and the Update Labor Standards feature. 
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Part Costs Tab 

The Parts Costs Tab will be detailed in the Cost Maintenance section. 

Statistics Tab 

The Statistics tab displays up to date information about this part.  From here you can quickly see 
who entered the part into the system and when; the date of the last cost revision, the date of the 
last cycle count, and the date of the last transaction; and the quantity on hand, the quantity on 
order, and promised sales. The net year-to-date usage of the part is calculated using Misc. 
Issues, WO Kits and Dekits, PO Kits and Dekits, SO Shipments and Returns. 

 

Accessing Part Maintenance Data 

Once all part and inventory information is entered into the system, Alliance/MFG gives you 
several options for accessing the data. 

From the Inventory Menu 

Select Inventory>Part Maintenance from the main menu.  From here you can use the submenus 
to go straight to a blank data entry form to enter new part information, edit existing data; or use 
predefined queries and wild cards to locate specific records. 

Part Maintenance View 

Records displayed in the Part Maintenance View depend on the menu option you select.  
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From here you can add, or delete a record, or via the sidebar or Links button you can edit, drill 
down or access related data; such as the cost of parts, where a part is used in production; or 
preview or print a report.  

Sorting and Finding Part Maintenance records – If your parts list is large, it may be helpful to sort 
the list. Click in a column header to sort by the information in that column.  Click the Filter button 
in the top of the view to activate an incremental filter/find search on the list. You may perform a 
filter on any column, the specific record or range of records will display as you type. 

Accessing Inventory On Hand Data 

If the Part Maintenance view is currently open, click on the appropriate sidebar related link. From 
either the Inventory Summary or Inventory Details Menu select View All Inventory.  

 

296 



Inventory Control 

Inventory Summary 
The Inventory Summary menu provides a summarized view of all part numbers in inventory, 
along with their Part Number, Quantity, Stockroom, Nettable and Quarantine Flags. From here 
you can select a part number and drill down to inventory details such as serial, lot and job 
numbers, or view maintenance, expiration and warranty dates. To drill down to inventory details 
double click on a summary line or click the Edit button. 

Inventory Summary Menu 

The Inventory Summary menu provides a summarized view of all part numbers in inventory, 
along with their Part Number, Quantity, Stockroom, Nettable and Quarantine Flags.  

 

From here you can select a part number and drill down to inventory details such as serial, lot and 
job numbers, or view maintenance, expiration and warranty dates. To drill down to inventory 
details double click on a summary line or click the Edit button. 

 

 

297 



Alliance/MFG User Guide 

Inventory Details 
The Inventory Details function provides access to all part quantities in stock, along with their 
Department, Stockroom, Location, Serial Number, Lot Number, Cost and Job Number 
information. All information is displayed in the Inventory Lots View list.  This menu selection also 
gives you access to the Misc. Issue, Misc. Receipt, and Relocate Inventory transactions. 

Inventory Details Menu 

The Inventory Details menu provides a view of all part quantities in stock, along with their 
 Stockroom, Location, Serial Number, Lot Number, Expiration Date, Job Number and Cost 
information.  

 

From here you can select a part number and maintain expiration, maintenance and warranty 
dates by clicking the SN/Lot Tracking in the Related Views sidebar.   
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From the Inventory Lots View  

The records displayed in the Inventory Lots View depend on the query you select. You can 
display inventory by buyer, serial/lot number, commodity code, job number and other categories. 
From here you highlight an item and click on the Related Edits sidebar section to relocate 
inventory from one department or location to another, and perform miscellaneous issues and 
receipts.  

TIP: 

You can create a view of specific inventory based on your criteria and add it to your 
Favorites Section in the Sidebar. 

The Inventory Details menu selection also gives you access to the Misc. Issue, Misc. Receipt, 
and Relocate Inventory transactions. 
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Miscellaneous Issues and Receipts 

Miscellaneous issues and receipts can be used to issue parts non-routinely to stockrooms and 
departments; or receive parts into inventory from a department. For example, you may want to 
issue and return to stock an assembly that was temporarily used by the Engineering department. 

Misc. Issues and Receipts can be performed from the Inventory Lots View window using the 
Related Edits sidebar section, or select Misc. Issues or Receipts from the Main Menu Inventory 
Details submenus. 

Miscellaneous Issues  

Select Inventory>Misc. Issue to open a blank Misc. Issue form.  You must enter the Part Number 
and Stockroom. If there is inventory in the selected stockroom the system defaults the current 
inventory location, and any SN/Lot Numbers or Job Number that may apply, and the quantity in 
that stockroom and location. 

If you access the Misc. Issue transaction form from the Inventory Lots View, you can select the 
part number first, then use the Related Edits section to open a Misc. Issue form for the part you 
selected. The system defaults the current stockroom and location, and any SN/Lot Numbers or 
Job Number that may apply, and the quantity in that stockroom and location. 

 

At the bottom of the form, enter the “To Department Code.” The description displays next to the 
field. Enter the quantity you wish to issue. The Transaction Date defaults to  “today’s” date; you 
can use the calendar box to enter a different date if needed. 

When you are finished, do one of the following: 

Click Save on the toolbar to save the issue and leave the form open. 

Click OK to save the issue and exit the form. 

Click Close to exit the form without saving. 
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Click the Refresh button on the toolbar to view the parts adjusted inventory, the transaction is 
also recorded in the Transaction Log. 

Miscellaneous Receipts 

Select Inventory>Inventory Details>Misc. Receipts to open a blank Misc. Receipts form.  You 
must enter the Part Number, From Department, Quantity Received, and any SN/Lot Numbers or 
Job Number that may apply. The system defaults the current inventory cost, the default 
Stockroom and Location. 

If you access the Misc. Receipts transaction form from the Inventory Lots View, you can select 
the part number first, then use the Related Edits section to open a Misc. Receipts form for the 
part you selected. The system defaults the selected part number, you must enter the From 
Department, Quantity Received, and any SN/Lot Numbers or Job Number that may apply. The 
system defaults the current inventory cost, the default Stockroom and Location..  

 

The Transaction Date defaults to  “today’s” date; you can use the calendar box to enter a different 
date if needed. 

When you are finished, do one of the following: 

Click Save on the toolbar to save the receipt and leave the form open. 

Click OK to save the receipt and return to the Inventory Lots View. 

Click Close to exit the form without saving. 

Click the Refresh button on the toolbar to view the parts adjusted inventory, the transaction is 
also recorded in the Transaction Log. 
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Relocating Inventory 

If your company uses an Incoming Inspection or Quarantine process you can use the relocate 
transaction to move the material to an inventory location after it has passed inspection or the 
quarantine time line. You can also use the relocate transaction to correct inventory location 
errors, scrap obsolete parts, etc. and the system will track the inventory movement. If you alter 
critical data such as serial or lot number you will terminate the Alliance/MFG ability to track those 
serial or lot numbers. Be sure to add information about the reason for the relocation to the Notes 
on the relocation transaction.  

NOTE: 

When the Require SN/Lot Number flag in the Part Maintenance>Inventory Codes is 
checked for a given part number, you will NOT be able to use the Relocate 
transaction to alter/change serial/lot numbers for that part. 

To Relocate inventory: 

From the Inventory Lots View, select the line that represents the part number, stockroom, 
location, and quantity you wish to relocate.  You can relocate any amount of the quantity. The 
following example was displayed by entering a part number in the By Part Number query. 

 

Click Relocate in the Related Edits sidebar section to open the Relocate Inventory form. The part 
number, From Stockroom and From Location with current From Inventory Quantity displays in the 
top of the form.   
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In the bottom half of the form, enter the “To Stockroom Code.” The description will display next to 
the field. Enter the “To Location Code”, a SN/Lot Number or a Job Number, if needed. Add any 
notes to retain critical information. Enter the quantity you wish to relocate.  This can be any 
amount of the current “From” quantity. The Transaction Date defaults to “today’s” date; you can 
use the calendar box to change it at your discretion. 

When you are finished, do one of the following: 

Click Save on the toolbar to save your entries and  leave the form open. 

Click OK to save the relocate and return to the Inventory Lots View. 

Click Close to exit the form without saving. 
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Serial Number/Lot Tracking  
If your business requires that all transactions (all material movement within Alliance/MFG) for a 
given part number include a serial or lot number, you may indicate so in the Part Maintenance 
record by clicking the “Require SN/Lot Number” flag on the Inventory Codes tab. It is not 
necessary to set this flag to be able to enter a serial or lot number during transactions, but if you 
do set this flag, you will NOT be able to complete any transaction without a serial/lot number.  

Serial number and lot information can be maintained via the SN/Lot Tracking menu selection or 
preferably will be entered during the following transactions; Purchase Order Receipts, Work 
Order Completions, or Misc. Receipt. These are transactions into stockrooms (inventory). You 
can optionally assign additional information such as Expiration, Maintenance and/or Warranty 
Dates for these items. If a serial or lot number assigned is NOT unique for that part number, it will 
be combined with like serial or lot numbers existing in inventory. Serial and lot numbers in 
inventory may also be transferred or moved between departments and stockrooms using the 
Relocate transaction.  

NOTE: 

When the Require SN/Lot Number flag is checked for a given part number, you will NOT 
be able to use the Relocate transaction to alter/change serial/lot numbers for that 
part. If a serial/lot number requires changing you will need to use the Unplanned 
Issue under the original serial number (issue from a stockroom to a department) 
and then use an Unplanned Receipt (from that same department back into a 
stockroom) under the new serial number. Use the Notes field to indicate why the 
transactions were necessary as the Alliance/MFG SN/Lot Tracking audit trail will 
cease to exist. 
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All Serial Number and Lot Number information is retained in the system, even if the inventory has 
been depleted.  For serialized work order completions you can establish the SN/Lot Number 
Format. For using Serialized Work Order Completions see Supply>Work Order Completions.  

To add a SN/Lot Number for a part during a transaction: 

Perform either a purchase order receipt, unplanned receipt, work order completion or serialized 
work order completion transaction. Add the serial or lot number to the transaction record. If 
required, click on the SN/Lot Information button to enter a expiration, warranty or maintenance 
date. The serial/lot number and information will be added to the SN/Lot Tracking and the 
transactions tables.  

NOTE:   

A lot may be received in partial receipts and have several transactions, however, only one 
expiration date is valid for each unique lot number. 

To create or modify a SN/Lot Number record for a part: 

Select Inventory>SN/Lot Tracking>New to open a blank SN/Lot Tracking data entry form. 

 
1. Enter a part number. 

2. Enter an SN/Lot Number to uniquely identify either the part or the lot. 

3. Enter Notes or an Expiration, Maintenance or Warranty date if needed. 

NOTE:   

A Serial/Lot number created and added through this method will not contain a reference to a 
purchase order or work order. You must add any reference information to the SN/Lot Notes field. 

When you are finished, do one of the following: 

Click Save on the toolbar to save your entries and  leave the form open.  

Click OK to save the receipt and exit the form. 

Click Close to exit the form without saving. 
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Tracking SN/Lot Numbers  

Once you have assigned SN/Lot numbers to parts, you can track them through the system. 
 Alliance/MFG gives you several options for tracking the data.   

From the SN/Lot Tracking Submenus: 

Select Inventory>SN/Lot Tracking from the main menu.  From here you can enter new SN/Lot 
Numbers, edit existing records; or use a predefined query to locate and track specific records.  

To track a range of serial numbers, select the Query By Serial Number option, enter the 
beginning and ending serial numbers. To track a specific serial or lot number enter the same 
number as both the beginning and ending numbers. 

 

From the SN/Lot Tracking View: 

The records displayed in the SN/Lot Tracking View depend on the query you select. 

 

From here via the sidebar or Links button you can drill down or access related data; preview or 
print a serial/lot number tracking report. 

From the Serial Number Locations Report 

You may query and run the Serial Number Locations Report to identify the location of all 
inventory for a serial or lot number. You will be able to track which serial or lot number was 
received on which PO, and was then kitted to which Work Orders, and then completed into 
finished goods and were ultimately shipped on which customer orders. The report will list all stock 
locations, sub-assemblies and finished goods items containing that serial/lot number.  
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From the SN/Lot Production History Report 

By selecting a manufactured or subcontract part number and the lot number assigned to it, you 
will be able to track which serial numbers or lot numbers were kitted to this Work Order.  
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Cost Maintenance 
There are two “primary” methods of maintaining your costs.  One that is used for entering costs 
for “New” parts, and one used for changes and/or cost revisions on existing parts.  Both methods 
are described below: 

Entering Costs for New Parts 

All part cost information is maintained on the Parts Costs tab on the Part Master form.  Here you 
will enter and maintain the pending part costs for both new and existing parts. You can enter a 
Default PO Cost for purchased items and a list price for each part you intend to sell. You can 
additionally specify a Commission Rate, and Tax Code to be applied to a part.   

Part Costs Tab 

Standard Costs are generated by the Update Standard Costs utility along with the date of the last 
cost revision and the current inventory cost.   

 

Average, Standard Costs and Current Inventory Cost along with other costs and prices entered 
here will be used in value calculations throughout the Alliance/MFG system and may be 
processed through an accounting link to your accounting package.  
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To enter Pending Costs: 

Enter Pending Costs for Material, Labor, Burden, Setup, and subcontract costs associated with 
this part.  The total pending costs will display at the bottom of the Pending Costs box.  You can 
enter this information manually, or use the Cost Roll Up and Update Standard Costs functions 
(described later in this section). 

Material Cost - This cost can be entered manually or for assemblies and subassemblies it can be 
calculated and entered by the cost roll up. Material Cost should be the cost of materials for a 
single part per stocking unit of measure.  For example, if the unit of measure is feet, the material 
cost would reflect the cost for one foot of the part.   

Buy Parts - The material cost is the cost you pay for each part. If you use an 
accounting link and receive a purchase order for an amount other than the Standard 
Cost, the appropriate variance (PPV) information will be generated.  (See your Link 
documentation for more information.) All Buy parts should have an entry in this field. 

Make Parts - The material cost can be manually entered here for an assembly or 
subassembly or calculated. The calculated cost on an assembly is entered when you 
run a cost roll up.  This calculation enters the Total Cost of all the parts components 
(Total Cost = Material Cost + Setup Cost + Burden Cost + Labor Cost + Subcontract 
Cost) as the Material Cost of the assembly.   

NOTE: 

When you change the cost of a component used in an assembly, you must run a cost roll 
up on that assembly, to update the cost of the parent assembly. 

Labor Cost - Enter the labor cost to make a single part, or run Update Labor Standards 
which will calculate the labor cost from the parts labor operations, and work center wage. See 
Update Labor Standards in CRP. 

Burden Costs - The Burden Cost can be entered manually or calculated via the Cost Roll 
Up. The Burden Cost should be based on a single unit.  It represents a portion of your total 
overhead amount to be added to the cost of this part. 

Setup Cost - Enter the setup cost. When the system calculates the total unit cost (for one 
unit), it divides the setup cost by any Costing EOQ quantity.   

Subcontract Cost - Enter the cost associated with the manufacture of one unit by a 
subcontract supplier.  This may or may not include material issued by you. 

Total Pending Cost - The System displays the sum of the Material, Labor, Burden, Setup, 
and Subcontract fields. (Setup cost is divided by the order quantity.) 

Additional Part Cost Fields 

Default PO Cost – Enter a current purchase price which will default to the Purchase Order 
cost when the part is entered as a PO Line Item. 

Cost Revision Date – The system displays the last cost revision date. 

Current Inventory Cost – The system displays the Current Inventory cost based on either 
the Average cost or the Standard Cost, depending on your costing method selection in the 
Preferences dialog box.  See Setting Up Your Company, for more information about this 
setting. 
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Part Commission Flag and Commission Rate – Select the Part Commission Flag if the 
sale of the part is commissioned.  This is for reference only. If you select the Commission 
Flag, enter the rate.   

List Price – Enter the cost your customer will pay the next time this part is purchased from 
you. 

Taxable Flag - Select Taxable Flag to indicate whether a part is taxable.     

Tax Code - If you select the Taxable Flag and the Tax Code field is left blank, the tax rate on 
a Sales Order for this part will default to the tax rate defined in the ordering Customer’s 
Address Maintenance record.  If you use the Taxable Flag and enter a code, it will override 
the tax rate on the customer’s record.  

Cost Changes and Cost Revision Steps 

1. Update the pending costs of all raw materials.  Also update burden, setup and 
subcontract pending costs for manufactured parts (there is no need to update the 
material or labor costs on assemblies if you use the Cost Roll Up and Update Labor 
Standards functions). 

2. Run a Cost Roll Up (either of the entire system, or on selected assemblies). 

3. Review the cost changes using reports like the Standard Costed BOM and the Part Cost 
List reports). 

4. Run the “Stockroom on Hand” report to get total dollars in each stockroom. 

5. Run the Update Standard Costs routine to move the pending costs to the standard costs 
(this can be done on all parts or just on selected parts depending on the scope of your 
cost revision) 

6. Re-run the “Stockroom on Hand” report to get the new dollar amounts for each 
stockroom. 

7. Comparing the two copies of the “Stockroom on Hand” report you can see the effect that 
the cost revision had.  Generally you will want to make an adjustment to your accounting 
system to account for this revision. 

Once all parts costs are entered into the system via the Part Master, Part Cost tab; you can 
maintain costs for all parts via the Inventory>Cost Maintenance submenus.  From here you can 
drill down to detailed cost information and, if necessary, go straight to the Part Master>Part Cost 
Tab to make changes. 

Accessing Cost Maintenance Data 

From the Inventory Menu 

The main menu is your first access level.  From here you can open a cost record for a specific 
part, view all parts, or use a predefined query to go to a specific part or range of parts.  

From the Part Cost View  

The records displayed in the Cost Maintenance View depend on the query you select. 
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From here you can add, edit, or delete a record; or via the sidebar or Links button you can drill 
down or access related data; preview or print a report. 

Maintaining Standard Costs 

Standard Costs are system generated and updated via the Update Standard Costs function, then 
displayed in the Standard Costs box. See Update Standard Costs. 

Performing a Cost Roll Up 

You can perform a Cost Roll Up at any time to calculate the total cost of an assembly or sub-
assembly based on the total cost of it's components. See Cost Roll Up for additional details. 
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Cost Roll Up 
You can perform a Cost Roll Up at any time to calculate the total cost of an assembly or sub-
assembly based on the total costs of it's components. You can run a multiple Cost Roll Ups to 
test “what if” scenarios for engineering changes that introduce new parts to existing BOM's.  

A Cost Roll Up will recalculate the cost of an assembly or subassembly regardless of the number 
of BOM levels involved or the type of cost field changed. You can update the costs of labor, 
material, burden, subcontract, or setup or perform an Annual Cost Revision. The total cost of a 
subassembly in a cost roll up is assigned to the material cost of the parent assembly.  

NOTE: 

If you need to isolate and display the total material, total labor, total burden, etc. for your 
end products use the Parallel Costed Indented BOM Report. 

Understanding the Cost Roll Up Function 

Part costs are rolled up from the lowest level components to the highest, all the way to your 
finished goods.  All component level material, labor, set up, and subcontract costs are rolled up to 
the material cost of their parent assembly.  If you manually change a material cost in an upper 
level assembly and then perform a cost roll up, costs at the lower level (which may not have been 
changed) will override your manual change!  

How Cost Roll Up calculates a cost change 

The following table shows how costs are rolled up through an assembly to calculate the total cost. 
 The first table shows how costs roll up to a total cost of $12.00 for one unit of BPP-100, with the 
total material cost of component B-01 at $4.00.   

Finished Good, BPP-100, Component B-01 total material cost = $4.00, Total Cost = $12.00 

 

In this example, it is made up of three components: B-01, S-01, and a phantom part.  B-01 is an 
assembly with four components (BP-1, -2, -3, and –4). The total material cost of B-01 is the sum 
of its components ($4.00). S-01 and the Phantom part are each costed at 3.00. 

The total material cost of BPP-100 is therefore the sum of the total material cost of B-01, S-01, 
and the Phantom part, as shown in the dotted line areas of the chart.  

Additional labor, burden, and setup costs have been added at the highest level, for a total part 
cost of $12.00. 
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The second table shows how changing the cost of the component B-01, by adding burden costs 
to its components, increases the total cost of B-01, which then rolls up to a material cost of $5.00 
and a total cost of $13.00 for one unit of BPP-100. 

When we run the cost roll up, the total cost of the component elements (material plus labor, 
burden, and set up for each component) rolls up into the material cost of the parent, B-01 to 
$5.00.  The cost of all the components of BPP-100 (B-01 + S-01 + the Phantom) roll up to its 
material cost, for a total of $11.00.  Labor, burden, and set up are added at the highest level for a 
total part cost of $13.00. 

 

Using Cost Roll Up with CRP and Update Labor Standards 

It is important to run Update Labor Standards BEFORE running a Cost Roll Up.  See Capacity 
Requirements Planning, for more information on maintaining work centers and labor routers. 

Performing a Cost Roll Up 

Cost Roll Up will recalculate the cost of assemblies when any component costs have been 
changed, regardless of the number of BOM levels or the type of change. You can make changes 
to any parts material, labor, burden, subcontract, or setup cost field depending on the ISC type 
(make, phantom, subcontract, buy, or free/bulk). The total cost of a subassembly is assigned to 
the material cost of its parent assembly during a cost roll up.  If you need more information about 
how the system performs a cost roll up, see the previous section. 

CAUTION! 

If you use either of the Average valuation methods, you must select the “Use 
Current Inventory Cost” box when performing cost roll ups. 

  A cost roll up is performed in these basic steps 

• Identify and enter all component level cost changes in the Part Master record. 

• Enter any labor changes to the labor routers and run Update Labor Standards (from the 
CRP Menu). 

• Perform the Cost Roll Up for one or all parts.  

Each step is described below: 

1A. Identify component cost changes 

Begin with the low level components. If your product is fairly simple, you may already know the 
low level components in the assembly.  However, if you have complex multilevel products, you 
can print the Indented BOM report to identify the low level components in the assembly. 
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1. Select Products>Reports>Indented BOM. 

2. Enter the part number for the affected assembly.  

3. Preview or Print the Indented BOM report and review the components at all levels. 

4. Select the appropriate components. 
1B. Enter Changes in the Part Master, Part Costs tab 

Parts costs are maintained via the Part Master data entry form, Part Costs tab, Pending Costs, 
see Entering New Part Costs, under Cost Maintenance. 

From Inventory>Part Maintenance - If you’re working in the Part Maintenance View, 
highlight the part number you want to change; click Edit, and select the Part Costs tab. 
  

From the Inventory>Cost Maintenance - From the Cost Maintenance View list, 
select the part, and select Related View>Cost Details to review the current cost, 
material, burden setup, and subcontract costs.  From here you can click the Edit 
button to open the Part Master and make your changes. 

From the Products menu - If you know you are going to make changes to multiple 
component parts in an assembly, you can start from Products>Product Structure>Bill 
of Materials (by assembly). Then enter the assembly part number to open the Product 
Structure (BOM) View displaying all the component parts for the assembly.  From here 
you can select a component, click Related Edits>Component Part Master.   

Once you are at the Part Costs tab for the component selected, enter the change into the 
appropriate field or fields.  If you need more information about entering costs in the Part Cost tab, 
see Entering New Part Costs, under Cost Maintenance. 

After you change the part cost and click OK, the system returns you to the Product Structure list 
where you can continue to work your way through the components until all changes are entered. 

2. Perform Update Labor Standards 

The Update Labor Standards calculation multiplies the labor time for each labor router by the 
wage rate for the work center to determine the standard hours and labor cost to produce a single 
unit of each part.  It also computes the setup cost by lot for each part.  This information is updated 
in the Part Master Part Costs tab>Pending Costs.   

Because updating labor standards changes standard hours and affects the basis by which setup 
and labor costs are calculated, it is important to update labor standards before performing a cost 
roll up.   

To Update Labor Standards: 

1. Make all necessary labor changes. 

2. Select CRP>Update Labor Standards to open the Update Labor Standards dialog box. 

3. Select which standards you wish to update; you can select one, two, or all types.   

4. The message box displays progress and reports any failures, along with the steps to correct 
it. 
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When finished, the message box reports “calculation completed successfully.”   

See Capacity Requirements Planning, Labor Routers for more information. 
3. Perform the Cost Roll Up 

Select Inventory>Cost Roll Up to open the Cost Roll Up dialog box.  
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You have the option to roll up all parts, or roll up a single part, sub-assembly or assembly. If 
you’re rolling up a single part, you must enter the part number.  

Select Roll up Components if you want to update the cost impact in all areas of the system. If left 
blank, the Roll up will show only incremental costs for the assemblies. 

Select Use Current Cost if you wish to post current inventory cost into the Material cost. (Typically 
used with Average costing.) 

If you wish to include Burden rates in your calculation, select Calculate Burden Rates.  Use the 
check boxes to apply any Burden rates to Material, Labor, Setup, or Subcontract costs.  (For 
more information about applying Burden rates to parts, see Calculating Burden Rates in the 
following section). 
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Update Standard Cost 
Updating Standard Costs 

Standard costs are maintained by the system and are not affected by Cost Roll Ups performed on 
Pending Costs.  You will use the Update Standard Costs function to add standard costs for new 
parts or to modify/change the standard cost of a part when necessary or annually for a product 
cost revision. 

Standard Costs are displayed by part number on the right side of the Part Master, Part Costs tab. 
The Total Standard Cost per part is derived from the total of Material, Labor, Burden, Setup, and 
Subcontract costs applicable to the part.   

To Update Standard Costs 

1. Select Inventory>Update Standard Costs to open the Update Standard Cost dialog box. 

2. Select one of the following: 

All Parts - This will update standard costs for all parts in the system. 

New Parts - This will update all new parts. New parts are parts added to the Part 
Master since the last time you ran “Update Standard Costs”. If required, be sure to 
update labor standards and perform a cost roll up prior to updating standard costs. 
Once a part has been updated it will no longer be considered new. 

One Part - Enter the part number to update. Only this part will be updated. 

 

 

 

 

 

 

 

 

317 



Alliance/MFG User Guide 

Transaction History 
Transactions 

All movement of parts and materials in Alliance/MFG is recorded as an inventory transaction. 
 Whether you receive parts form a supplier, ship parts to a customer, or simply move stock from 
one location to another, a transaction record will be created and posted to the Transaction 
History. 

The Transaction History records every activity performed that affects the quantity or movement of 
inventory.  This file records any transaction that causes an item’s on-hand quantity in any stock 
location to increase or decrease.   

NOTE: 

If you use an Alliance Manufacturing Accounting Link, transactions will be passed through 
to your accounting package via this log.  (See your Accounting Link documentation 
for more information about your particular product link.) 

If you are a member of the EMU, the Transaction History stores information you need for Intrastat 
Reporting. 

Accessing Transaction History data 

Once you begin operating the system, it begins accumulating Transaction History. Alliance/MFG 
gives you several options to access the data.   

From the Inventory menu 

Select Inventory>Transaction History>All to open the Transactions View for all transactions, or 
use a predefined query to locate specific records. 

From the Transactions View 

The records displayed in the Transactions View depend on the query selected.  The following 
sections describe the origin of data in each column. 
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Transaction View Column Definitions 

Tran Group  

The system assigns a sequential Transaction Group number to all simultaneous transactions. 
 For example, when you Receive All on a purchase order with eight different line items, the 
transaction log assigns the same Transaction Group number to each part received in this 
transaction.  The individual parts received will be assigned unique, sequential Transaction ID 
numbers, which you can see in the Transaction Detail View. 

Tran Type 

The transaction type is read from the transaction form where the transaction is recorded.  For 
example, when you ship a purchase order, the Transaction Log records a SHP transaction type. 
 When you kit a work order, the Transaction Log records a KIT transaction type.  The following list 
defines the transaction types and source transactions for all transactions performed in 
Alliance/MFG. 

   

 

Audit Date/Time 

The audit date and time is read from the input form when the transaction was recorded.  This will 
be the time and date at the machine used to perform the transaction. 

Reference 

The reference is read from the input form used to perform the transaction.  For example, a KIT 
transaction will display the related work order number. 

Entered By 

The Entered By is read from the login ID on the computer where the transaction was performed. 
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Tran Info 

You can add up to 60 characters of additional information about the transaction in this field (you 
can record and track serial numbers here).  This information will display on the Transaction Detail 
form. 

Transaction Group and Detail Display 

You can display Transaction Group and Transaction Detail in a form rather than a view. Select a 
Tran Group from Transactions View and select Display Transaction Header in the Related Views 
sidebar section to display the header form. All Transaction group information is displayed in the 
form.  In addition, you can click the notes tab to add any information about the transactions. 

 

Select Display Transaction Detail in the Related Views sidebar section to display the Transaction 
Detail View. There may be multiple detail records for the selected header. 
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Transaction Detail View 

Because the Transaction Log records all movement of inventory, it creates a very large body of 
data.  Alliance/MFG gives you a number of options for narrowing the categories of data displayed 
from the Transaction Log.  

 

Transaction Detail includes the part number and description, quantity, transaction ID, to and from 
department and location information; any SN/Lot numbers applicable; and cost information 
including the invoice cost, invoice line, if applicable.  From here via the sidebar you can drill down 
or access related data; preview or print a report. 

You can also display the Transaction Detail in a form rather than a view. Highlight a Transaction 
in the view and double click to display the Transaction Detail Form.  
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Intrastat Reporting 
If you do business within the European Monetary Union, the VAT (value added tax) feature will 
help you track payment and receipt of VAT by region/country and ICN Code.  With this feature, 
you can print reports that summarize payments and receipts by country/region, commodity type, 
and vendor or customer. Once you enable and complete transactions in the system, you can 
access the Intrastat Reporting View from the Inventory>Transactions submenu.  The following 
sections explain how to set up your system to use the Intrastat Reporting feature. 

Intrastat Reporting Setup 

VAT tracking is optional and will only be enabled when you set it up in Company Preferences.  To 
use Intrastat Reporting Tracks Value Added Tax payments and receipts. , you must first enable the 
feature, then tell the system what regions and countries you regularly deal with, what commodity 
types are used, enter region/country codes for suppliers and customers, and enter a VAT type for 
each part in your inventory.  To do this, set up the following elements.  (If you need more detailed 
information about setting up codes tables, see Setting Up Your Company.) 

Enable Intrastat Reporting: 

1. Select File>Company>Preferences. 

2. Click the Accounting tab. 

3. Select Require Intrastat. 

Set up ICN Codes: 

1. Select File>Codes>ICN Codes>New. 

2. Enter ICN Codes and Descriptions for each material type you plan to sell or buy. 

Set up Tax Codes: 

1. Select File>Codes>Tax Codes. 

2. Enter Tax Codes, Tax Rates, Description and Liability accounts for the regions you will do 
business with. 

Set up the VAT Region/Country Code: 

1. Select File>Codes>Region/Country codes. 

2. Enter all regularly used regions and countries into the table. 

Set up Intrastat Rates Codes: 

1. Select File>Codes>Intrastat Rates>New. 

2. Select the ICN Codes, Region Codes and Tax Codes that apply. These codes will now 
appear in tables for entry in Customer and Supplier data entry forms. 

To set up a customer for VAT Reporting 

1. Select Demand>Customer and whatever option you choose to open the Customers data 
entry form. 

2. In the Customer tab, enter a VAT Registration number and VAT Branch ID. 
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3. In the Default Codes tab, enter a Region Code. 

To set up a supplier for VAT Reporting: 

1. Select Supply>Supplier and whatever option you choose to open the Supplier’s data entry 
form. 

2. In the Default Codes tab, enter a Region Code or double-click on the field to choose from the 
Region Code table. 

3. Enter a VAT Registration #. 

Set up the Inventory for VAT Reporting: 

1. Open the Part Master data entry form for the part you wish to track.  

2. Click the Inventory Codes tab. 

3. Enter the ICN Code or use the hyperlink to select a code from the ICN Code View. 

Using the Intrastat Reporting Feature 

Once you have set up all Intrastat Reporting elements, the system is ready to access the data 
and record VAT values. 

When you create a purchase order, the supplier’s region code field will display the default setup 
for that supplier (this may be overridden at your discretion).  The purchase order detail shows the 
tax rate for that region and the commodity type. 

When you receive or return a purchase order, or ship or return a sales order, select 
Inventory>Transactions>Intrastat Reporting and select a date to review a summary of all 
transactions for Intrastat Tracking on that date.  

 

From here via the sidebar or Links button you can drill down or access related data; preview or 
print a report. 
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Shortages 
Shortages are created automatically by the system whenever available inventory is insufficient to 
fully kit a WO or subcontract PO. You can also manually create, edit, or delete shortages at your 
discretion. All shortages, whether generated by the system or created manually, can be reviewed 
from the Inventory>Shortages submenus. 

To add a new PO Shortage: 

Select Inventory>Shortages>PO Shortages>New to open a blank Purchase Order Shortages 
data entry form. 

 

1. Enter a PO Number. 

2. Enter the Part Number you wish to short. 

3. The Transaction date will default to “today’s” date, or you can use the calendar box to select 
a different one. 

4. Enter a quantity for the PO shortage. 

5. When you have completed your entries, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open.  

Click OK to save your entries and return to the Shortages View. 

Click Close to exit the form without saving. 

To edit an existing PO Shortage: 

1. In the Purchase Order Shortages view list, select a part to open the Purchase Order 
Shortages form for that part. 

2. Change the information in the fields as described in the previous paragraphs. 

3. When you have completed your entries, do one of the following: 

Click Save on the toolbar to save your entries and  leave the form open.  

Click OK to save your entries and return to the Shortages View. 

Click Close to exit the form without saving. 
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NOTE:  

The shortage transaction is also available through the Work Order Kitting and 
Subcontract Purchase Order features. There, you may partially or completely 
relieve a shortage for specific orders.  (See Supply, for more information about how 
shortages are created in WO and PO kitting.) 

Accessing Data from the Shortages submenus 

Once shortages are in the system, Alliance/MFG gives you a number of ways to access the data. 
You can create or review shortages for POs or WOs from the same menu. 

From the Inventory Menu 

Select Inventory>Shortages to access the Shortages submenus.  From here you can go straight 
to a blank data entry form to create a shortage manually, review existing shortages, or use a 
predefined query to locate specific records. 

From the PO Shortages View 

The records displayed in the PO or WO Shortages View depend on the query you select. 

 

From here you can add, edit, or delete a record; or via the sidebar or Links button you can drill 
down or access related data; preview or print a report. 

From the WO Shortages View 

The records displayed in the WO Shortages View depend on the query you select. 
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From here you can add, edit, or delete a record; or via the sidebar or Links button you can drill 
down or access related data; preview or print a report. 

To create a new WO Shortage: 

Select Inventory>Shortages>WO Shortages>New to open a blank Work Order Shortages data 
entry form. 

 

1. Enter a WO Number. 

2. Enter the Part Number you wish to short. 

3. The Transaction date defaults to “today’s” date, or you can use the calendar box to select a 
different one. 

4. Enter a quantity for the shortage. 

5. When you have completed your entries, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. 

Click OK to save your entries and return to the WO Shortages View. 

Click Close to exit the form without saving. 

To edit an existing WO shortage: 

1. 1 In the Work Order Shortages View, select a part and click the Edit button to open the Work 
Order Shortages form for that part. 

2. 2 Change the information in the fields as described in the previous paragraphs. 

3. 3 Click Close, OK, or Save as appropriate. 

NOTE:  

The shortage transaction is also available through the Work Order Kitting and 
Subcontract Purchase Order features. There, you may partially or completely 
relieve a shortage for specific orders.  (See Chapter 6: Supply for more information 
about how shortages are created in WO and PO kitting transactions.) 
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Negative Inventory 
Negative Inventory allows Alliance Remote Data Collection System users additional flexibility 
when remotely performing kitting operations. This feature allows the RDC device user to kit 
component items found in inventory even if the current on-hand balance is less than the quantity 
kitted.  

Example: A PO receipt for component XXX has not yet been entered into the system, but the 
Work Order requiring those components is being remotely kitted and component XXX is 
physically found and issued. Instead of rejecting the kit transaction back to the remote device 
user the transaction will be accepted and processed. The negative inventory table will record and 
track all RDC kitting exceptions for subsequent resolution. This allows the kit to be created, sent 
to the floor and work to begin while the exception is cleared later (by a supervisor?).  

Negative Inventory 

Select Inventory>Negative Inventory to open the Negative Inventory form. 

When the Negative Inventory screen is first opened a toolbar icon is displayed above the window. 
To view and open the Negative Inventory menu item users must have Read rights. To enable and 
use the Update Inventory icon users must have Read/Write security rights.  

 

This form is used to view and cleanup negative inventory records.  Negative inventory is created 
when a transaction “consumes” more inventory than exists in Alliance/MFG.  The assumption is 
that these problems occur because inventory movements are recorded out of sequence (e.g. you 
kit before processing a receipt). 

 

When an RDC Kit line goes negative it is added to the Negative Inventory table. The system is 
allowing for paperwork processing lags and allows the employee performing the remote kitting 
function to complete the transaction. The first action should always be to click on the Update 
Inventory Toolbar. This will update the Inventory On Hand stock quantity and clear all negative 
records displayed in the view that were received and the transaction has since been posted. 

If any Negative records remain; 
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Highlight a record in the view, the On Hand Inventory, all open work orders the part was kitted to, 
all open purchase orders for that part along with the actual kit transaction will be displayed on the 
bottom of the form. Click the associated hyperlink to expand the details and perform the 
necessary research to correct the exception.  

 

Open Work Orders – Opens View WO Header showing all open work orders for the selected part 

Open Purchase Orders – Opens View PO Header showing all open purchase orders for the 
selected part  

Inventory On Hand – Opens View Inventory Lots showing all inventory for the selected part 

Transaction – Opens Display Transaction Detail queried by the selected transaction ID. 

In this example click the Update Inventory button in the Toolbar and the negative condition should 
be corrected. If it does not correct the condition, more investigation is required. Verify the correct 
part was issued to the work order and that all work order completions or purchase order receipts 
have been processed. A cycle count may be required to correct the problem. 

328 



Inventory Control 

Physical Inventory 
Physical Inventory and Cycle Counting 

Some companies can perform a full physical inventory in one day or maybe over a weekend, 
unfortunately, others may require a plant shutdown for numerous days resulting in a costly 
interruption to business.  Some companies have no alternative, other than a shutdown, due to 
external audit requirements, legal reasons, or simply unacceptable inventory accuracy. It is 
generally suggested that a full physical inventory verification be performed when first 
implementing Alliance/MFG or any other inventory control software.  

You may be able to avoid additional annual plant shutdowns while maintaining or even improving 
your inventory record accuracy if your CFO and/or Company Auditors agree to accept periodic 
cycle counting (with a predetermined “acceptable” variance tolerance and counting schedule) in 
place of the full physical inventory.  

Periodic cycle counting can be done using numerous methods. For example, you may plan to 
count all parts in inventory per a set schedule (monthly, semi-monthly, weekly, etc.) or you may 
want to count parts by commodity code, product code, source code, ABC Code, etc. You may 
elect to use the ABC Analysis to classify your parts based on either On-Hand Value, $ Usage or 
Part Cost and count by classification (See ABC Analysis). The ABC Analysis will analyze and 
classify your parts based on the criteria you select. Additionally, it will update the Part Master 
ABC Code field with the assigned code. You might then establish a cycle counting schedule to 
count all of your A Parts quarterly, B Parts semi-annually and C Parts annually. The generate 
count tags feature can utilize the ABC code to generate tags based on your schedule. If the year-
end variance recorded by the cycle counts is within the agreed to tolerance at year end, perhaps 
a costly plant shutdown can be eliminated. 

Establishing Procedures 

Before you begin, it is important to establish a detailed policy and procedure to support your 
Physical Inventory and Cycle Count functions, not only for your initial physical inventory 
validation, but for every count thereafter to ensure consistency and record accuracy. You must 
freeze all inventory movement during any physical inventory counting.  Therefore, it is important 
to schedule your inventory counting period when it will have the least impact on your material 
movement (PO Receipts, WO Kitting, WO Completions, SO Shipments, etc.). Some steps, such 
as deciding whether to conduct a full physical or perform periodic cycle counting, and freezing 
inventory movement are external to Alliance/MFG and should be understood and initiated prior to 
conducting your actual inventory counting.  

Initial Physical Inventory 

During your initial implementation, you will want to perform a full physical inventory to validate 
your starting inventory balances. After you have entered all inventory data into the system, you 
can generate count tags, using the Full Physical method, and then perform a physical inventory.   

NOTE:  

You can use the Import/Export feature to import existing inventory data.  See the 
Technical Reference for more information. 

Recommended Physical Inventory Maintenance Procedure 

Your counting procedure should be documented, approved by your CFO/Accountant and 
distributed to all employees involved with the counting. 

1. Freeze all inventory movement (into and out of stockrooms). 
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2. Enter all outstanding transactions (receipts, issues, relocate, ship, kit, etc.) to bring your 
system current. 

3. Select a Inventory Counting method (Full Physical or Cycle Counting).  

4. Generate count tags. This action records the current inventory balance by part number, sn/lot 
number, stockroom and location for all items selected. 

5. Perform counts. Employees physically note the quantity for each tag generated, and 
additionally verify the SN/lot number, stockroom and location for each part number. 

6. Input counts (edit/review). Enter actual physical counts in the system. 

7. Print variance reports.  Variance reports tell you the difference between what the system 
currently shows and what the employees have physically counted. 

8. Reconcile variances.  Recount parts as necessary. 

9. Back up the system.  

10. Apply all counts.  This updates your system inventory on hand with your reconciled physical 
count data on the current count tags. 

Performing Inventory Counts 

The following sections describe how to generate tags, assign tags to employees, record counts, 
enter tags and update inventory records using the Alliance/MFG Physical Inventory features.   

NOTE: 

The Assign Tags to Employee feature is also used by the Alliance RDC (Remote Data 
Collection) system to allocate and synchronize tags with employees utilizing Mobile 
Devices (PDA's). 

Generating Count Tags 

Tag Numbering 

When generating inventory tags, Inventory>Physical Inventory>Generate Count Tags, the First 
Tag Number field will default to one number higher than the last tag generated. For example, if 
the last tag number generated was 123 then the First Tag Number will default to 124. You can 
change this number to any number you want as long as it is higher than the last tag number 
generated. There is an exception to this restriction if you are re-generating tags without applying 
the counts. Generating tags will delete any unapplied tags so you may enter the beginning 
number of the unapplied tags when the Generate Tags screen opens. If you would like to reuse 
old tag numbers you will first need to purge the existing tag file. Go to 
File>Database>Import/Export and add a Mass Delete of the “Inventory Tags View” using the “All” 
query. Once all existing tags have been purged you can enter any first tag number on the 
Generate Count Tags screen.  

CAUTION! 

Always use extreme caution and backup your database prior to running any Mass 
Delete function. 

330 



Inventory Control 

To Generate Count Tags 

Select Inventory>Physical Inventory>Generate Count Tags to open the Generate Count Tags 
dialog box.   

Click the Re-query button on the Part List tab to query the Part Master file. You can limit your 
count tags to a specific part or range of parts.  The queried parts will appear in the Part List tab 
on the right side of the dialog box. If you are performing a full physical count you may either 
select “All” from the query list or click the Full Physical button at the bottom of the screen.  If you 
clicked the Full Physical button at the bottom of the screen the tags will be generated but the part 
list will not appear on the right side of the screen. If you use ABC Codes to generate tags, click 
the ABC Tab. 

 

Select the parts to count. You may drag and drop individual parts from the list to the Selected 
Parts work area. 

Click the Add all parts on list button to add the parts to the Selected Parts work area on the left 
side of the dialog box.  Once you have added parts to the work area, you can use the buttons on 
the bottom of the Selected Parts area to further define which parts you wish to generate count 
tags for. 

Buttons 

Clear – Clears all selected parts from the left display box. 

Remove – Highlight a part and select Remove to remove one part. 

Add All Parts on List – This will include all parts from the Part List tab.   
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Add Parts from ABC – Adds any ABC parts you have defined in the ABC tab.  Please 
see ABC counts later in this section for more information about performing ABC 
counts. 

Select Full Physical to generate tags for all parts in your database.  Non-inventory 
items, ISC = N (non-stock) or ISC = P (phantom assembly), will not be included. 

Select Cycle Count to select the parts that you want to be counted during the current 
inventory period. Cycle counting intervals are determined by your company and can be 
performed as frequently as you like (daily, weekly, monthly, and so on). 

The inventory tag system reviews all stockrooms and locations and creates a Tag # and detail 
information for every part added to the Selected Parts list.   

Freeze all inventory movement 

Once tags are generated, permit no material or parts movement (receipts or issues, for example) 
until the counting is complete. To ensure data integrity, a material cutoff procedure must be 
observed.  If you receive a part after tags are generated and prior to counting that part, do not 
process or enter the receipt or the system will enter it twice: once as a receipt and once as a part 
of the count.  

Pre-Assigning Count Tags to Counters 

Select Inventory>Physical Inventory>Edit/Review Counts 

 

You can assign tags individually, one at a time, to an employee for counting or utilize the 
customization features built into the Inventory Tags Editable View to assign tags. If you want to 
assign tags to Counter 1, Counter 2 or John Doe, just type that name in the counter column.  
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NOTE: 

The absence of validation on the "Counter" field allows your company to hire temporary 
employees to assist with Physical Inventory or assign generic counter designations 
if desired. 

In the example below we will assign tags using the authorized employee list. First sort the newly 
generated tags into stockroom order by clicking on the Stockroom column header. 
File>Company>Employees>Detail Tab>Employee Functions> Inventory Accuracy checkbox is 
checked. 

 

The next step is to highlight the tags you want counted by the employee. We will select the tags 
associated with the stockrooms ENG and PENS by highlighting the first record, holding down the 
shift key, and highlighting the last record you want to assign to this employee. Highlighting is 
done by clicking in the row grid number column (far left side). 
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Next click on the Assign Counter icon  in the grid header. This will display a list of 
all employees authorized to perform Inventory Counts.  

 

Double click or highlight the desired employee and click on the Select button. This will assign the 
selected inventory tags to the selected employee. 
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Notice that the Counter column is now filled in with the employee ID. Continue to highlight tags 
and assign them to employees until you are finished.  

The Assigned Tags are now ready to be handed out to employees or synchronized with Mobile 
devices utilized in the RDC system. 
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Printing the Inventory Tags View  

To print the above Inventory Tags View for distribution to employees: 

1. Resize and move the columns to where they are easiest to read and understand. You can 
also hide (collapse) any column data you don't want the Counter to see (Frozen Quantity?). 

2. Click on the Printer icon in Inventory Tags View grid header. See Alliance/MFG Window 
Types if you are not familiar with printing directly from data views. 

 

Printing the Count Tags Report 

With the Inventory Tags Editable View open, click on the Print Tags hyperlink in the Related Links 
Sidebar, Actions section. This will open the following report. Click Print 
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Perform Counts 

Freeze all inventory movement 

Once tags are generated, permit no material or parts movement (receipts or issues, for example) 
until the counting is complete. To ensure data integrity, a material cutoff procedure must be 
observed.  If you receive a part after tags are generated and prior to counting that part, do not 
process or enter the receipt or the system will enter it twice: once as a receipt and once as a part 
of the count.  

Perform Counts 

Have inventory counters physically count inventory and record quantities. Care should be taken 
to ensure accuracy. Enter the counts during the Edit/Review process below.  

Reviewing and Editing Counts 

Edit/Review Counts 

Select Inventory>Physical Inventory>Edit/Review Counts to review the most recent count tags 
generated. The Inventory Tags Editable View allows editing directly in the grid. This replaces the 
old Inventory Tag Entry screen. Additionally you have all of the sorting, filtering, summarizing 
capabilities explained in the section on Alliance/MFG Window Types.  
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Entering counts via the Inventory Tags Editable View  

Select a tag by clicking on the Tag Number field, tab into or double click the Count Quantity field. 
Enter the Count Quantity in the Count column. When you exit the Count field the Counted 
checkbox will automatically be checked by the system.  

CAUTION! 

If you entered a zero (0) in the count field you will need to manually check the 
Counted Box. 

Tab to the Counter column, type the counter name ( you can assign tags to Counter 1, Counter 2 
or John Doe) in the counter column or enter the Employee ID or click on the eyeglass icon (right 
side of Counter column) to drill down to the authorized employee list. This will display a list of all 
employees authorized to perform Inventory Counts. File>Company>Employees>Detail 
Tab>Employee Functions> Inventory Accuracy checkbox is checked. 

NOTE: 

The absence of validation on the "Counter" field allows your company to hire temporary 
employees to assist with Physical Inventory or assign generic counter designations 
if desired. 

In the example below we have entered tags for Counter 1 and are now using the authorized 
employee list to select counters.  
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Highlight the desired employee and double click on the row number in the grid or click on the 
Select button. The Variance Quantity and Variance Cost columns will be automatically updated 
when the actual count is entered.  

When you have entered all of the counts and are satisfied the data is accurate, click on the Save 
button (always Save before Applying the count tags). 

Creating a Tag for a part not on the Inventory Tags List 

This method is used when counting is still in progress and tag counts have not been applied. With 
the Inventory Tags Grid open, click on the Create Tag hyperlink in the Related Links Sidebar, 
Actions section. This will open the following blank tag edit screen. 
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3. The next sequential tag number will be defaulted to one number higher than the last tag 
generated. 

4. The name of the person creating the new tag is defaulted. 

5. Enter the Part Number, or use the hyperlink to select one from the Part Master View. 

6. Enter the Department, Location, any SN/Lot Number or Job Number you want to count. 
Duplicate tags can not be generated for existing tags that have not been applied.  

7. The Frozen Quantity will be defaulted to zero and then updated after you enter the part 
number, stockroom and location. You cannot edit this field. 

8. Enter the Count Quantity. 

9. Enter the Employee ID in the Counted By. 

10. When you are finished, click OK to save your entries and exit the form. 

Alliance RDC (Remote Data Collection) 

If you are using the Alliance RDC with Mobile Devices 

If you are using the Alliance RDC with Mobile Devices the count tags will be downloaded to the 
HHD (Hand Held Device) counted and then uploaded to Alliance/MFG via Microsoft ActiveSync 
and the data automatically updated and saved. See the Alliance RDC Users Guide for 
instructions on performing inventory counts with mobile devices.  

NOTE: 

Alliance RDC is not part of Alliance/MFG. It can be purchased separately from Account 
Management. See the Contacting Alliance section of the Alliance/MFG Help 
System. 
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Variance Analysis 

After all counts have been saved you can use the Inventory Tags Editable View to reorganize, 
group, sort and summarize the variance amounts and costs by employee or in total as a 
company. You can reorganize and summarize for the current tags only or use the Drop Down List 
box in the Toolbar to select All Tags. Selecting All Tags will display all tags that have been 
applied since the last time tags were deleted (usually at fiscal year-end).  

Print the Variance Report 

The Variance report is a useful tool to ensure the physical count data is entered correctly before it 
is applied to your database. It displays both value and quantities for each part.  Review the 
Variance Report carefully for any discrepancies.  For example, if you missed entering a quantity 
for a Count Tag, the Inventory Quantity will show the quantity when count tags were generated 
and the Count Quantity will show zero.   If you apply count tags as is, the system will adjust your 
inventory quantity to zero!  To avoid this, be sure to review the Variance Report for such 
discrepancies and edit or recount as required before you apply the counts.   

How Variances are Applied in the System 

The Variance Report may show an inventory quantity of 100, with a physical count of 150.  If you 
have verified that the physical count is correct, the system will reconcile this variance when you 
apply counts.  The resulting transaction would be posted to the Transaction Log as a Physical 
Inventory Positive Adjustment (PIP).  If the report shows the inventory quantity of 100 and the 
physical count is in fact 50, the system would reconcile this variance by posting a Physical 
Inventory Negative Adjustment (PIN) to the Transaction Log. Physical Inventory Adjustment 
Transactions are passed to your financial package if you purchased an Alliance/MFG Accounting 
Link.  

To run a Variance Report: 

Select Inventory>Reports>Physical Inventory>Variance Report>Current Counts.  You can 
preview the report on screen or print a hard copy. 

Apply Counts 

When you are satisfied that the count quantity data in your count tags is correct, you are ready to 
apply the counts to your system inventory. This will update the quantity on hand values in your 
inventory records. 

CAUTION! 

Applying counts will make permanent adjustments to your on-hand inventory. We 
strongly recommend making a backup before applying your counts. 

To Apply Counts 

11. Backup your system using your standard procedures for backing up your Alliance/MFG 
database. 

12. Select Inventory>Physical Inventory>Apply Counts. 

13. Select a Department Code and Account Number to apply to your Variances.  

14. Click Apply Counts.  The system updates all inventory quantities for the count tags 
created.  
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WARNING: 

The Count Quantity on an Inventory Tag overwrites the quantity field in the 
inventory lots table.  Applying Counts with tags that were not counted will 

apply a count of zero.  (The quantity on-hand will be adjusted to zero for that 
tag’s part, stockroom, and location). 

  

TIP: 

ACCOUNTING FOR WIP DURING PHYSICAL INVENTORY 

When you kit a work order, the raw materials (or component) parts are moved from the 
actual stockroom to the WIP account.  You can view which items are in process 

from the Work in Process. View (select Shop>Work in Process, All, By Part 
Number or By Work Order.)  Because “In-Process” parts are not truly their original 
part number, but not yet their finished goods part number, these parts are usually 
handled separately in the Physical Inventory process.  They are valued as a raw 

materials part plus the value of the labor added to date.  The Work in Process 
reports found under the Shop menu will help you determine the value of your WIP 

inventory. 
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ABC Analysis 
You can analyze your entire parts inventory and classify all records in relative order of importance 
according to value definitions you decide.  When you enter parts in the Part Master, you have the 
option to classify them as Highest Relative Value, Medium Relative Value, or Lowest Relative 
Value.  You can also do this by running an ABC Analysis.  You have the option to calculate either 
Year-To-Date Use, QOH Value, QOH Net Value, or Unit Cost. The analysis sorts your parts by 
the parameter (percent of parts) you set, and tells you how many A, B, and C parts make up that 
parameter.   

This tool is useful to establish inventory handling policies based upon ABC analysis, and to help 
you focus action in the areas of highest return. 

For example, an ABC analysis calculated by Unit Cost might show the following: 

20% of the parts represent 80% of the value (A parts). 

30% of the parts represent 15% of the value (B parts). 

50% of the parts represent 5% of the value (C parts). 

How ABC Analysis Calculates Value 

ABC analysis multiplies the quantity by the cost, and sorts the part numbers in descending order 
by the resulting extended value.  

 

In the example, we ran ABC Analysis using the YTD Usage Value. You can see that 20% of the 
parts comprise 77% of the value. 

It is then a simple task to select the items based on value and assign them Highest, Medium, or 
Lowest Relative value. When you click Apply, these value breakdowns (highest, medium, and 
lowest relative value) replace any ABC values assigned in the Part Master.   
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Calculating ABC 

When you calculate ABC, based on QOH Value for example, the ABC Analysis data form shows 
you the Number of parts, the Percent of parts, the Percent dollar usage, the  Minimum dollar 
value; and then the number of A, B, and C parts in each category. 

To calculate ABC parts: 

1. Select Inventory>ABC Analysis.  A blank ABC Analysis form opens. 

2. Set the Percent of parts you want the analysis displayed in (Top right side of window).  In 
the example on the previous page, we set Percent of parts to “5,” which groups parts in 
5% increments.  (See Setting the Percent of Parts Parameter, later in this section for 
more information about how this setting is used.) 

3. Select the value you wish to calculate by: YTD Usage, QOH Value, QOH Net Value, or 
Unit Cost.  The calculation runs, showing progress in the progress bar. 

Applying ABC Values 

You could arbitrarily apply ABC values for each part from the Part Master.  However, you can use 
the ABC Analysis to calculate actual relative values based on YTD Usage, QOH Value, QOH Net 
Value, or Unit Cost.  When you apply the values via the ABC Analysis function, they will override 
any manual ABC entries in the Part Master. 

To apply relative ABC values: 

1. Calculate ABC as described in the previous section. 

2. Select the bottom line you wish to assign to the highest relative value group (A Parts).   

3. Click the A Highest Relative Value button.   

4. Continue to select lines and assign relative values until you have assigned Highest, 
Medium, and Lowest value to all the parts. 
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Click the Save button on the toolbar, the new values will replace any values assigned to parts in 
the Part Master. 

Setting the Percent of Parts Parameter 

If you have a large number of parts, you can summarize your ABC parts list to simplify analysis. 
 For example, if you have 1000 parts in your Part Master and enter 5 in the Percent of parts field, 
you will have 200 lines of data, rather than 1000 lines, each representing 50 of your parts.  If you 
have 10000 parts and enter 5, you will still have 200 lines of data; however, each line will 
represent 500 parts.  How you use this feature is dependent on what works best for your 
company.   
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Inventory Control Reports 
The following reports are available from the Inventory menu.  You can preview or print a report 
from a predefined query, or create a custom query to display specific information in an 
Alliance/MFG standard format.  For more information about Alliance/MFG reports, see the 
Technical Reference. 

Intrastat Reporting 

Part Cost List 

Part Status 

Stockroom on Hand 

Shortage Report 

Stockroom Locations 

Serial Number Locations Report 

Production History Report 

Transaction Reports 

Physical Inventory 
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CRP Menu Functions 
This chapter describes how to create work centers for each production and cost center in your 
operation; how to create labor routers for each production step; and how to calculate CRP, Work 
Center Loads, and Update Labor Standards. 

Capacity Requirements Planning Overview 

Capacity Requirements Planning (CRP) can determine roughly how much time will be required in 
each work center to meet the demands planned by materials requirements planning.  The 
Capacity plan created by a CRP run is “forward loaded”; it uses the start date and start quantity of 
planned orders and work orders, the defined capacities of your work centers, and detailed labor 
routers to calculate load. The CRP calculations results provide the information you need to 
evaluate whether to add personnel, add machines, reschedule customer orders, or let production 
continue according to plan.   

You can set up Work Center capacities to include shifts and downtime; and Labor Routers can 
include individual labor operations such as setup, queue times, and run time The standard hours 
allowed to produce one item on an operation. The actual time taken to produce one piece may 
vary from the standard but the latter is used for loading purposes. The work center efficiency 
factor is a comparison of actual versus standard run time.

Once Work Centers and Labor Routers are set up, you can perform the following calculations: 

Calculate CRP - Runs the calculations for capacity planning on the basis of the last MRP 
calculation (either full or top-level MRP). 

Work Center Loads - Displays the results of the calculation, giving the production capacity and 
projected loads for each work center. 

Update Labor Standards - Updates labor standards on manufactured or subcontracted parts 
that have labor routers established. 
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Successful CRP Planning comprises the following steps: 

1. Review Work Centers and Labor Routers for accuracy. 

2. Run the Calculate MRP function. 

3. Run the Calculate CRP function. 

4. Review Work Center Loads and take appropriate action. 

Tasks described in these sections assume familiarity with the basic use of Alliance/MFG data 
lists, data entry forms, dialog boxes, queries, and finding and sorting features.  If you need more 
information about how to use these features, review System Overview. 
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Work Centers 
Work centers are specific production facilities or cost centers that may consist of one or more 
people and/or machines.  You create a unique work center ID and define the capacity, default 
wage rate, and any burden costs you wish to apply for each work center.  You can also define 
any number of shifts for a work center, and optionally enter a default labor account that will 
appear on all labor routers. 

Entering new Work Center information 

You can schedule work center capacity by shift-by-day, or schedule multiple shifts with different 
capacities. Enter Start and Stop times using a 24 hour clock. For example, two workers 
performing hand assembly from 8 A.M. to 12 noon would have a capacity of 480 minutes (240 
minutes x 2 workers = 480).   

To create a New Work Center: 

Select CRP>Work Centers>New to open a blank Work Centers data entry form.  At a minimum, 
you must enter a Work Center ID and a Capacity to create a valid work center. 

 

From here you can create any number of work centers and work center shifts. 

Enter a Work Center ID, and continue to enter information in the Work Centers and Work Center 
Shifts tabs as described in the following sections. 

Work Centers Tab 

1. Enter a name for the work center.  The Work Center ID and Name will appear on your Labor 
Routers. 

2. Enter the work center capacity in minutes per day. If you don’t’ use shifts, the days of the 
week the work center is open will default to the days your company is open, as specified in 
your company Preferences. If you use shifts, enter the start and stop times and days of the 
week the shifts will operate in the Work Center Shifts tab. 
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3. Enter a default wage rate that applies to this work center. If no wage rate is associated with 
an employee working in this work center, the system will apply this wage rate. If an employee 
working a labor router assigned to this work center is paid a different wage rate, their wage 
rate will override the default specified here.   

4. You can supply a burden cost (information only). 

5. If you plan to use shifts, select the Use Shifts box and define shifts in the Work Center Shifts 
tab (see the following section). 

6. Enter an Account Number to associate costs of operating this work center with an account. 
 This number will print on the Labor Router. 

Work Center Shifts Tab 

Click Work Center Shifts to display a list of all shifts defined for the work center. 

 

From here you can add a new shift or exit an existing one. 

To Add a Work Center Shift: 

Click Add on the left side of the form to open a blank Work Center Shifts data entry form. The 
Work Center ID displays in the header. 
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1. Enter the Capacity in minutes per day. 

2. Enter the Start Time for the shift. 

3. Enter a Stop Time for the shift. 

4. Select the days of the week the shift will operate. 

5. From here you can continue to click Add to define as many shifts as you need for this work 
center. 

6. When you are finished, click Close to save your entries and return to the Work Centers Shifts 
tab.  The new shifts display in the body of the tab. 

7. When all entries are complete, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving. 

To Edit a Work Center Shift: 

1. From the Work Center Shift tab, select a shift and click Edit on the left side of the form.  The 
Work Center Shifts data entry form opens. 

2. Edit the information as required. 

3. Click Close to return to the Work Centers form. 
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4. When all entries are complete, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving. 

Shift Downtime 

You can inform the system when a work center shift will be down.  Its available capacity will not 
be considered in a CRP run covering the downtime period. Provide a brief explanation, such as 
machine calibration or maintenance.  You need not schedule downtime for days your company is 
normally closed.  

Defining Work Center Shift Downtime 

Click the Shift Downtime tab on the Work Center Shifts data entry form. The Work Center Shifts 
display in the body of the tab.  From here you can Add or Edit downtime information.   

 

To Add or Edit a Shift Downtime: 

Select a shift and click Add or Edit to open the Shift Downtime data entry form. The Work Center 
and Shift ID's display for the shift selected. 
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1. The Date defaults to “today’s” date; you can use the calendar box to change it, if needed. 

2. Enter the reason the shift will be down. 

3. Click Close to exit the form and return to the Work Center Shifts, Shift Downtime tab. 

4. When all entries are complete, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving. 

To restore the work center from downtime: 

1. From the Work Center Shifts tab, select the Work Center Shift that is down. 

2. Click Edit. 

3. Click the Shift Downtime tab. 

4. Select the line that defines the downtime. 

5. Click Delete. A trash can icon appears next to the line.   

6. Click Close.  

7. When all entries are complete, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving. 

353 



Alliance/MFG User Guide 

Accessing Work Center information 

Once all work centers are created, Alliance/MFG gives you several options for accessing the 
data. 

From the CRP Menu 

Select CRP>Work Centers from the main menu.  From here you can open a blank Work Centers 
data entry form, open the Work Centers View for any or all work centers in the system, or use a 
predefined query to access a specific record. 

From the Work Center View  

The records displayed in the Work Centers View depend on the query you select. 

 

From here you can Add, Edit, or Delete a record; or via the sidebar or Links button you can drill 
down or access related data; preview or print a report.  
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Labor Routers 
The labor routers describe each operation performed on your company’s manufactured parts. 
 These operations may include kitting parts, inspections, testing, assembling, drilling, polishing—
whatever processes are performed in the work center. You can include notes that describe tools 
that may be required, special operating instructions, machining tolerances, JSA's, and so on. 
 Notes can be added to operations as work instructions. They will not print on the Labor Router, 
but will print on the WO Traveler. 

The Labor Router contains information about the per-piece time to perform each operation, such 
as fixed Queue Time, Setup Time, and Run Time.  CRP considers these times to determine 
capacity requirements.  

NOTE: 

You must create work centers and operations codes before you can create labor routers. 
 Work centers were discussed in the preceding section.  Operations codes are set 
up in your company codes tables (see Chapter 2: System Overview for more 
information). 

Creating Labor Routers 

Labor routers define each sequence in an operation to manufacture a part.  Here you assign an 
operation code and the work center where the operation is performed; and specify the queue 
time, setup time, and run time it takes to perform the operation.  CRP calculates the time for each 
sequence in the operation to create the Work Center Load report.  

To Create a New Labor Router: 

Select CRP>Labor Routers>New to open a blank Routers data entry form. 
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1. Enter a part number or use the hyperlink to select one from the Part Master View. 

2. Enter a unique Sequence ID for this step to indicate its order in the process.   

3. Specify an Alternate sequence number, if applicable.  This can represent a back-up machine 
or process used in case of a breakdown or overload (see Chapter 5: Supply, Work Order for 
more information). 

Routers Tab: 

1. Enter a Work Center ID or use the hyperlink to select one from the Work Centers View.  The 
account number assigned to the work center displays to the right of the Work Center field, 
and its description displays below the field. 

2. Enter an Operation Code. This is a code defining the a step in the manufacturing process. 
 Enter an operation code or use the hyperlink to select one from the Operation Codes View 

3. Enter a Queue Time in minutes-per-run to represent the total time a lot waits at this labor 
operation. Queue time is non-costed; however, it is used by CRP to help in determining when 
an operation actually begins.  Some examples of queue time are cooling, paint drying, transit, 
and to allow for backlog.  Queue time does not consume capacity in CRP. 

4. Enter a Setup Time in minutes-per-run to represent the amount of time it takes to set up a lot 
at this operation.  Setup Time is used to calculate the setup cost in the inventory master. 
 Setup time consumes capacity in CRP. 

5. Enter a Run time in minutes-per-unit to represent the amount of time it takes to produce one 
part at this operation.  Run Time is used by the Update Standards calculation to calculate the 
labor cost for this part. 

6. When all entries are complete, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. 

Click OK to save your entries and exit the form. 

Click Close to exit the form without saving. 

NOTE:  

Only primary sequence ID's are used for costing and by the CRP calculation.  Alternates 
are for information only and are bypassed. 

Copying Labor Routers 

Often labor routers for different part numbers will be nearly identical.  You can save time by 
copying a set of labor operations from one part to another. If you copy a router to a part that 
already has a router it will append the new operations. 

To Copy a Labor Router: 

1. From the CRP menu, select Labor Routers>Copy Router.  The Copy Router dialog box 
opens.  

2. Enter a part number or click the From hyperlink to display the Part Master View for all parts 
with labor routers defined.   

3. Select a part.  At this point you could click Labor Router From in the Related Views section of 
the sidebar to review the Labor Router for this part. 
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4. Enter a part number or click the To hyperlink to select a part from the Part Master View to 
copy the Labor Router to. 

5. Click Copy.  

6. Click View to review your new labor router.  You can add, edit, or delete operations codes as 
needed to complete the router. 

7. Click Close to exit the form. 

Accessing Labor Routers Data  

Once Labor Routers are added to the system, Alliance/MFG gives you several options for 
accessing data.  

From the Labor Routers Submenus 

Select CRP>Labor Routers from the main menu.  From here you can open a blank Labor Routers 
data entry form or use a predefined query to access a specific record. 

From the Labor Routers View 

The records displayed in the Labor Routers View depend on the query selected. 

 

From here you can Add, Edit or Delete a record; or via the sidebar or Links button you can drill 
down or access related data; preview or print a report. 

 

357 



Alliance/MFG User Guide 

Calculate CRP 
CALCULATING CRP 
Capacity Requirements Planning is a rough-cut planning tool. It analyzes the capacity for each 
work center versus the planned work load. The resulting calculation determines the production 
load in each work center as a percentage of its total capacity.  

CRP uses the output from the most recent MRP Run as the basis for calculation.  If MRP was run 
for Top Level only, CRP will calculate top level only.  To calculate CRP for all levels, run MRP for 
all levels before calculating CRP. To get a true picture of your capacity requirements, it is 
important to run MRP before running CRP. 

How CRP Calculates Capacity  

CRP considers the release date of a work order, the start date of MRP planned orders, and the 
Labor Router for the part. Beginning with the first labor operation to be defined, it posts it at the 
beginning of the first available shift on that day for that work center. It posts the queue time and 
setup time. It then multiplies the start quantity on the order by the runtime per unit, and posts the 
run time for this operation. If it reaches the end of a shift, it rolls to the next shift. If the labor 
operation is complete before the shift is over, it uses the remaining time on the next labor 
operation in that work center. 

When an operation is complete, CRP moves to the next operation. If it’s in the same work center, 
it uses up the remaining shift before rolling into the next shift. 

CRP assumes infinite capacity.  If multiple work orders are scheduled to enter a work center on 
the same day, CRP does not post the orders separately.  They all move through the work center 
beginning at the first shift.  It then considers the total minutes used compared to the capacity 
defined in the Work Center data entry form to calculate the percentage load. 
To Run CRP 

1. Ensure that your Work Center and Labor Routers are accurate. 

2. Run MRP to ensure all transactions are up to date and work orders are scheduled. 

3. Select CRP>Calculate CRP.  The Calculate CRP dialog box is a simple message box that will 
report when the operation is complete. 

4. Click Calculate CRP. 

 

Review the Work Center Loads (see Work Center Loads). 

Keep in mind that CRP is not finite scheduling. It does not reschedule work center loads for you; it 
simply shows you the percentage of capacity in a work center on a given day. It’s up to you to 
decide whether to add shifts, personnel, or to reschedule work orders to level the loads. 
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Work Center Loads 
CRP calculates a load for each work center defined, considering existing shop orders and 
planned orders.  The Work Center Loads View is a display only list that shows the results of the 
latest CRP calculation for each work center; whether labor is scheduled for that work center; and 
if the work center is over capacity.  From here, you can select a work center and review the Load 
Date, Load %, and Capacity for that work center.  Some days may show significantly more than 
100% load, while others may show well under capacity.  With this information, you can decide 
whether to reschedule work orders to “level” the load.   

Viewing Work Center Loads 

After running the CRP calculation, select CRP>Work Center Loads to open the CRP Header 
View, which lists all work centers defined in the system, whether or not labor is scheduled for a 
work center, and if the work center is over capacity. 

 

To View the Work Center Load Summary: 

From the CRP Header View, select a work center and double click to display the work CRP 
Summary By Work center ID for that work center. This View breaks down the work center load by 
day so you can easily see which day the work center is over capacity and by what percent. 
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From here you can drill down to additional details of the work order and operations responsible 
for creating the load. 
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Update Labor Standards 
The Update Labor Standards calculation multiplies the labor time from each labor router by the 
wage rate from each work center to determine the standard hours and labor cost to produce a 
single unit of each part.  It also computes the setup cost by lot for each part.  This information is 
updated in the Part Master Part Costs tab.   

Cost Roll up and Updating Labor Standards 

Because updating labor standards changes standard hours and affects the basis by which setup 
and labor costs are calculated, it is important to update labor standards before performing a cost 
roll up.  See Chapter 8: Inventory Control, Cost Roll Up for more information. 

To Update Labor Standards: 

1. Select CRP>Update Labor Standards to open the Update Labor Standards dialog box. 

2. Select which standards you wish to update; you can select one, two, or all types.   

3. The message box displays progress and reports any failures, along with the steps to correct 
it. 

 

When finished, the message box reports “calculation completed successfully.”   
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CRP Reports 
The following reports are available from the CRP menu.  You can preview or print a report from a 
predefined query, or create a custom query to display specific information in an Alliance/MFG 
standard format.  For more information about Alliance/MFG reports, see the Technical Reference. 

Labor Router 

Work Center Listing 

Work Center Loads 
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Shop Floor Menu Functions 
Shop Floor Control is a system for utilizing data from the shop floor as well as data processing 
files to maintain and communicate status information on work orders and work centers. This 
information facilitates the calculation of job costing and accounting information. It gives you 
constant feedback on your labor distribution and work-in-process so you can adjust your plan to 
meet your needs. Labor reports provide data such as hours by work order and employee, and 
labor and scrap costs. Once labor routers have been defined and work orders entered, you can 
track and generate reports for labor distribution and work in process. Enter actual labor and 
operations completed on each work order; or actual labor and operations completed by each 
employee. 

You can review work-in-process by part number or by work order; including the cost of materials 
and scrap applied to each work order. 

Shop related reports include labor distribution, labor utilization, production backlog, and work in 
process. 

Tasks described in this section assume familiarity with the basic use of Alliance/MFG data lists, 
data entry forms, dialog boxes, queries, and finding and sorting features.  If you need more 
information about how to use these features, review System Overview. 
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Labor Distribution 
Alliance/MFG uses labor router information entered for each part, employee hours, and wage 
rates  to create labor distribution. Labor Distribution reports each employee’s labor contribution to 
a work order—the actual number of hours worked on a particular job and quantity completed—to 
provide a calculation of actual direct labor. 

Each labor entry will be assigned a unique Labor ID. 

Detailed labor transactions are retained in the system until the work order is deleted.  When you 
delete a work order, all labor data for that work order is deleted.  When you close a work order, 
the Labor Distribution View no longer displays the data; however, you can still access it through 
the reports.  (See Shop Reports at the end of this chapter for more information about shop 
reports.) 

Reporting Labor 

To report labor against a work order: 

Select Shop>Labor Distribution>New to open a blank Labor Distribution data entry form. 

 

1. At a minimum, you must enter a work order number, Employee ID and Sequence ID for each 
labor distribution.   

2. Enter a Work Order number.  The Part Number and description display to the right of the 
field. 

3. The system generates a new Labor ID for each unique entry against this work order.  Each 
Labor ID will present a separate line item in the Labor Distribution View. 

4. Enter an Employee ID. 
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5. The Start Date defaults to the current date and time; however, you can use the calendar box 
to enter a different date.  For example, you may enter labor from labor routers or time sheets 
that indicate different start times. 

6. If the work order is linked to a job number, the job number will display next to the Start Date 
field. 

7. Enter the Sequence ID this employee performed, or use the hyperlink to select one from the 
Labor Router View. The description displays to the right of the field. 

8. Enter the quantity completed at this labor operation.  This number must be less than or equal 
to the quantity released. 

9. The quantity released from the work order into manufacturing displays to the right of the 
Quantity Completed field. 

10. Enter the actual stop date and time the employee finished applying labor.  Use the calendar 
box to select the date and time. 

11. The Employee Wage Rate displays from the Employee record.  Enter a different wage rate if 
this is nonstandard, such as overtime. 

12. The Total Time (number of hours worked) to date displays to the right of the Wage/Rate field. 

13. The quantity of items remaining to be built at this labor operation displays to the right of the 
Stop Date field. 

14. The default account number assigned to the part on this Work Order will display.  If this is a 
nonstandard work order, or if you wish to charge labor to an account other than the account 
displayed, you can enter a different account number. 

15. When you have completed all entries, do one of the following: 

Click Save on the toolbar to save your entries and leave the form open. 

Click OK to save your entries and exit the Labor Distribution form. 

Click Close to exit the form without saving. 

To edit labor on an existing Labor Distribution form: 

1. Select Shop>Labor Distribution>Edit and enter the WO Number and Labor ID for the record 
you wish to edit; or open the Labor Distribution View, select the appropriate line item, and 
click Edit. The Labor Distribution form for the item selected opens. 

2. The WO Number and Labor ID display at the top of the form, along with the Part Number and 
description for the part. 

3. The employee ID and Start Date will display as selected.  You can edit these as required. 

4. When you are finished, click OK, Close, or Save, as appropriate. 

Accessing Labor Distribution Data  

From the Labor Distribution Submenus 

Once labor is entered against a work order, you can access the data from the Shop>Labor 
Distribution submenus.   
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From the Labor Distribution View 

Records displayed in the Labor Distribution view depend on the query selected. 

 

From here you can Add, Edit, or Delete a record; or via the sidebar or Links button you can drill 
down or access related data; preview or print a report. 
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Work In Process 
Work In Process is a view only feature that shows you the status of work for all open work orders 
in the system.  From here you can quickly review the part numbers, date and quantity released to 
a work order; the quantity completed to date for any open work order, along with a summary of 
material, labor, and scrap costs; and the total WO cost to date.   

Viewing Work-In-Process 

Once you begin entering labor operations in Alliance/MFG, you have several options for 
accessing the data. 
From the Work-in-Process Submenus 

Once labor is entered against a work order, you can access WIP data from the Shop>Work In 
Process submenus.  Select Work In Process>All to view all records; or use a predefined query to 
locate specific records. 
From the Shop Floor Work In Process View 

The records displayed in the Work in Process View depend on the query selected. 

 
From here via the sidebar or Links button you can drill down or access related data such as 
applied labor and shortages; preview or print a report. 

Work-In-Process Columns Field Definitions 

Work Order Number – The work order number for this record. 

Part Number – The part number for this work order. 

Released  - The date the work order was actually released. 

Quantity Released - The quantity released to production. 

Quantity Completed - The quantity completed to date for this work order. 

Last Labor Sequence – The last labor sequence recorded for this work order. 

Total Work Order Cost  -  The accumulated work order cost to date, material, labor, 
and scrap. 

Material Cost - The total material cost to date for the work order. 

Labor Cost - The total labor costs applied to the work order. 

Scrap Cost - The total cost of components dekitted to scrap. 

Job Number  - The Job Number associated with the work order, if applicable. 
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Shop Floor Reports 
The following reports are available from the Shop menu.  You can preview or print a report from a 
predefined query, or create a custom query to display specific information in an Alliance/MFG 
standard format.  For more information about Alliance/MFG reports, see the Technical Reference. 

Labor Distribution 

Labor Utilization 

Production Backlog 

Work in Process 
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